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 WARNING
This device is not intended for or rated 
for use in hazardous locations.

Do not attempt to select, install, use or maintain 
this product until you have read and fully 
understood the Safety, Installation & Operations 
Precautions section of this manual.
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TESCOM ELECTRONIC CONTROLLERS

 WARNING

DO NOT ATTEMPT TO SELECT, INSTALL, USE, OR MAINTAIN THIS 
CONTROLLER, OR ACCESSORY UNTIL YOU HAVE READ AND FULLY 
UNDERSTOOD THESE INSTRUCTIONS.

BE SURE THIS INFORMATION REACHES THE OPERATOR AND STAYS WITH THE 
PRODUCT AFTER INSTALLATION.

DO NOT PERMIT UNTRAINED PERSONS TO INSTALL, USE, OR MAINTAIN THIS 
CONTROLLER, OR ACCESSORY.

IMPROPER SELECTION, IMPROPER INSTALLATION, IMPROPER MAINTENANCE, 
MISUSE, OR ABUSE OF THIS CONTROLLER, OR RELATED ACCESSORIES CAN 
CAUSE DEATH, SERIOUS INJURY, AND/OR PROPERTY DAMAGE.

OXYGEN SERVICE REQUIRES SPECIAL EXPERTISE AND KNOWLEDGE OF SYSTEM 
DESIGN AND MATERIAL COMPATIBILITY IN ORDER TO MINIMIZE THE POTENTIAL 
FOR DEATH, SERIOUS INJURY, AND/OR PROPERTY DAMAGE. 

Possible consequences include but are not limited to:

• High velocity fluid (gas or liquid) discharge

• Electrocution

• Parts ejected at high speed

• Contact with fluids that may be hot, cold, toxic, or otherwise injurious

• Explosion or burning of the fluid

• Lines/hoses whipping dangerously

• Damage or destruction to other components or equipment in the system

 CAUTION

SAFETY PRECAUTIONS

1.  Read and understand the user’s manual before operating the controller.

2. Inspect the controller, and accessories before each use.

3. Operate the unit only under specified environmental conditions.

4. Follow instructions in the manuals for proper wiring.

5. Never connect the controller, or accessories to a supply source having 
a voltage greater than the maximum rated voltage of this controller, or 
accessory.

6. Never connect the controller, or accessories to a supply source having a 
pressure greater than the maximum rated pressure of this controller, or 
accessory.

7. Never use anything but clean dry inert gases or air into the electropneumatic 
controller.

8. Start up sequence for electropneumatic controllers is:

a. Feedback loop must be installed and operational.

b. Electrical power should be applied and system setpoint reduced to its 
lowest pressure output before turning on the pneumatic supply to the 
controller.

9. Refer to product label (modification specific) for maximum inlet pressures. 
If this rated pressure cannot be found, contact your local TESCOM 
representative for the rated pressure prior to installation and use. Verify 
the designed pressure rating of all equipment (e.g., supply lines, fittings, 
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connections, filters, valves, gauges, etc.) in your system. All must be capable 
of handling the supply and operating pressure.

10. Clearly establish flow direction of the fluid before installation of controllers, 
regulators, valves, and accessories. It is the responsibility of the user to install 
the equipment in the correct direction.

 11. Remove pressure from the system before tightening fittings, gauges or 
components.

12. Never turn controller, regulator or valve body. Instead, hold the controller 
body and turn fitting nut.

13. If a controller, regulator or valve leaks or malfunctions, take it out of service 
immediately.

14. Do not modify equipment or add attachments not approved by the 
manufacturer.

15. Apply pressure to the system gradually, avoiding a sudden surge of fluid or 
pressure shock to the equipment in the system.

16. Regulators are not shut-off valves. Install a pressure relief device downstream 
of the regulator to protect the process equipment from operating pressure 
increases. Shut off the supply pressure when the regulator is not in use.

17. Periodic inspection and scheduled maintenance of your equipment is 
required for continued safe operation.

18. The frequency of servicing is the responsibility of the user based on the 
application. Never allow problems or lack of maintenance to go unreported.

19. Read and follow precautions on compressed gas cylinder labels.

20. It is important that you analyze all aspects of your application and review all 
available information concerning the product or system. Obtain, read, and 
understand the Material Safety Data Sheet (MSDS) for each fluid used in your 
system.

21. Never use materials for controllers, regulators, valves, or accessories that are 
not compatible with the fluids being used. 

22. Users must test under normal operating conditions to determine suitability 
of materials in an application.

23. Vent fluids to a safe environment, and in an area away from employees. 
Be sure that venting and disposal methods are in accordance with 
Federal, State, and Local requirements. Locate and construct vent lines to 
prevent condensation or gas accumulation. Make sure the vent outlet is 
not obstructed by rain, snow, ice, vegetation, insects, birds, etc. Do not 
interconnect vent lines; use separate lines if more than one vent is needed.

24. Do not locate controllers, regulators, valves, or accessories using flammable 
fluids near open flames or any other source of ignition. Use of Explosion Proof 
controllers may be necessary to be in accordance with local electric codes.

25. Some fluids, when burning, do not exhibit a visible flame. Use extreme 
caution when inspecting and/or servicing systems using flammable fluids 
to avoid death or serious injury to employees. Provide a device to warn 
employees of these dangerous conditions.

26. Many gases can cause suffocation. Make certain the area is well ventilated. 
Provide a device to warn employees of lack of Oxygen.

27. Never use oil or grease on these controllers, regulators, valves, or 
accessories. Oil and grease are easily ignited and may combine violently with 
some fluids under pressure.

28. Have emergency equipment in the area if toxic or flammable fluids are used.

29. Upstream filters are recommended for use with all fluids.

30. Do not bleed system by loosening fittings.

31. Prevent icing of the equipment by removing excess moisture from the gas.

32. Always use proper thread lubricants and sealants on tapered pipe threads.
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INSTALLATION

Inspect the controller, and accessories for physical damage and contamination. 
Do not connect the controller, or accessory if you detect oil, grease, or damaged 
parts. If the controller, or accessory is damaged, contact your local TESCOM 
representative to have the controller cleaned or repaired.

 WARNING

Make sure that the components and materials used in the fluid handling 
system are compatible with the fluid and have the proper pressure rating. 

Make sure that the components used in the electronic system are 
compatible with and have the proper voltage rating.

REPAIR SERVICE

If a controller leaks or malfunctions, take it out of service immediately. You must 
have instructions before doing any maintenance. Do not make any repairs you do 
not understand. Have qualified personnel make repairs. Return any equipment 
in need of service to your equipment supplier for evaluation and prompt service. 
Equipment is restored to the original factory performance specifications, if 
repairable. There are flat fee repair charges for each standard model. The original 
equipment warranty applies after a complete overhaul.

 WARNING

SAFE COMPONENT SELECTION

1. Consider the total system design when selecting a component to ensure safe, 
trouble-free performance.

2. The user is responsible for assuring all safety and warning requirements of 
the application are met through his/her own analysis and testing.

3. TESCOM may suggest material for use with specific media upon request. 
Suggestions are based on technical compatibility resources through 
associations and manufacturers. TESCOM does NOT guarantee materials to be 
compatible with specific media — THIS IS THE RESPONSIBILITY OF THE USER!

4. Component function, adequate ratings, proper installation, operation, and 
maintenance are the responsibilities of the system user.

5. The user is responsible to be in accordance with all the necessary mechanical 
and electrical codes required for installation and operation of the system. 
These requirements include but are not limited to all explosion proof 
controllers.

6. The user is responsible for the selection of the proper model number of the 
controller that would meet the application’s possible hazardous environment 
or conditions.

 WARNING

Do not modify equipment or add attachments not approved by the 
manufacturer.
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TESCOM REGULATORS

 WARNING

DO NOT ATTEMPT TO SELECT, INSTALL, USE, OR MAINTAIN THIS 
REGULATOR, VALVE, OR ACCESSORY UNTIL YOU HAVE READ AND FULLY 
UNDERSTAND THESE INSTRUCTIONS.

BE SURE THIS INFORMATION REACHES THE OPERATOR AND STAYS WITH THE 
PRODUCT AFTER INSTALLATION.

DO NOT PERMIT UNTRAINED PERSONS TO INSTALL, USE, OR MAINTAIN THIS 
REGULATOR, VALVE, OR ACCESSORY.

IMPROPER SELECTION, IMPROPER INSTALLATION, IMPROPER MAINTENANCE, 
MISUSE, OR ABUSE OF REGULATORS, VALVES, OR RELATED ACCESSORIES CAN 
CAUSE DEATH, SERIOUS INJURY, AND/OR PROPERTY DAMAGE.

OXYGEN SERVICE REQUIRES SPECIAL EXPERTISE AND KNOWLEDGE OF SYSTEM 
DESIGN AND MATERIAL COMPATIBILITY IN ORDER TO MINIMIZE THE POTENTIAL 
FOR DEATH, SERIOUS INJURY, AND/OR PROPERTY DAMAGE.

Possible consequences include but are not limited to:

• High velocity fluid (gas or liquid) discharge

• Parts ejected at high speed

• Contact with fluids that may be hot, cold, toxic, or otherwise injurious

• Explosion or burning of the fluid

• Lines/hoses whipping dangerously

• Damage or destruction to other components or equipment in the system.

 CAUTION

SAFETY PRECAUTIONS

1.  Inspect the regulator, valve, and accessories before each use.

2. Never connect regulators, valves, or accessories to a supply source having a 
pressure greater than the maximum rated pressure of the regulator, valve, or 
accessory.

3. Refer to product label (model specific) for maximum inlet pressures. If this 
rated pressure cannot be found, contact your local TESCOM representative 
for the rated pressure prior to installation and use. Verify the designed 
pressure rating of all equipment (e.g., supply lines, fittings, connections, 
filters, valves, gauges, etc.) in your system. All must be capable of handling 
the supply and operating pressure.

4. Clearly establish flow direction of the fluid before installation of regulators, 
valves, and accessories. It is the responsibility of the user to install the 
equipment in the correct direction.

5. Remove pressure from the system before tightening fittings, gauges or 
components.

6. Never turn regulator or valve body. Instead hold regulator or valve body and 
turn fitting nut.

7. If a regulator or valve leaks or malfunctions, take it out of service 
immediately.

8. Do not modify equipment or add attachments not approved by the 
manufacturer.

9. Apply pressure to the system gradually, avoiding a sudden surge of fluid or 
pressure shock to the equipment in the system.
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10. Regulators are not shut-off devices. Install a pressure relief device 
downstream of the regulator to protect the process equipment from 
overpressure conditions. Shut off the supply pressure when the regulator is 
not in use.

11. Periodic inspection and scheduled maintenance of your equipment is 
required for continued safe operation.

12. The frequency of servicing is the responsibility of the user based on the 
application.

13. Never allow problems or lack of maintenance to go unreported.

14. Read and follow precautions on compressed gas cylinder labels.

15. It is important that you analyze all aspects of your application and review all 
available information concerning the product or system. Obtain, read, and 
understand the Material Safety Data Sheet (MSDS) for each fluid used in your 
system.

16. Never use materials for regulators, valves, or accessories that are not 
compatible with the fluids being used.

17. Users must test components for material compatibility with the system 
operating conditions prior to use in the system.

18. Vent fluids to a safe environment, and in an area away from employees. 
Be sure that venting and disposal methods are in accordance with 
Federal, State, and Local requirements. Locate and construct vent lines to 
prevent condensation or gas accumulation. Make sure the vent outlet is 
not obstructed by rain, snow, ice, vegetation, insects, birds, etc. Do not 
interconnect vent lines; use separate lines if more than one vent is needed.

19. Do not locate regulators, valves, or accessories controlling flammable fluids 
near open flames or any other source of ignition.

20. Some fluids when burning do not exhibit a visible flame. Use extreme caution 
when inspecting and/or servicing systems using flammable fluids to avoid 
death or serious injury to employees. Provide a device to warn employees of 
these dangerous conditions.

21. Many gases can cause suffocation. Make certain the area is well ventilated. 
Provide a device to warn employees of lack of Oxygen.

22. Never use oil or grease on these regulators, valves, or accessories. Oil and 
grease are easily ignited and may combine violently with some fluids under 
pressure.

23. Have emergency equipment in the area if toxic or flammable fluids are used.

24. Upstream filters are recommended for use with all fluids.

25. Do not bleed system by loosening fittings.

26. Prevent icing of the equipment by removing excess moisture from the gas.

27. Always use proper thread lubricants and sealants on tapered pipe threads.
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INSTALLATION

 CAUTION

Do not open packaging until ready for installation or in a clean environment. 
Product is cleaned in accordance with CGA 4.1 and ASTM G93, Verification Type 1, 
Test 1 and Test 2. With periodic verification of cleaning process to MIL-STD-1330D.

 WARNING

Make sure that the components and materials used in the fluid handling 
system are compatible with the fluid and have the proper pressure rating. 
Failure to do so can result in death, serious injury, and/or property damage.

Inspect the regulator, valve, and accessories for physical damage and 
contamination. Do not connect the regulator, valve, or accessory if you detect oil, 
grease, or damaged parts. If the regulator, valve, or accessory is damaged, contact 
your local TESCOM representative to have the regulator cleaned or repaired.

REPAIR SERVICE

If a regulator or valve leaks or malfunctions, take it out of service immediately. 
You must have instructions before doing any maintenance. Do not make any 
repairs you do not understand. Have qualified personnel make repairs. Return 
any equipment in need of service to your equipment supplier for evaluation 
and prompt service. Equipment is restored to the original factory performance 
specifications, if repairable. There are flat fee repair charges for each standard 
model. The original equipment warranty applies after a complete overhaul.

 CAUTION

PROPER COMPONENT SELECTION

1. Consider the total system design when selecting a component for use in a 
system.

2. The user is responsible for assuring all safety and warning requirements of 
the application are met through his/her own analysis and testing.

3. TESCOM may suggest material for use with specific media upon request. 
Suggestions are based on technical compatibility resources through 
associations and manufacturers. TESCOM does NOT guarantee materials 
to be compatible with specific media -- THIS IS THE RESPONSIBILITY OF THE 
USER!

4. Component function, adequate ratings, proper installation, operation, and 
maintenance are the responsibilities of the system user.

 WARNING

Do not modify equipment or add attachments not approved by the 
manufacturer. Failure to do so can result in death, serious injury, and/or 
property damage.
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Conventions of This Manual

refer to 
page 36

Text formatted as gray and italic denotes a clickable cross 
reference. Clicking this text moves you to the referenced 
page in the manual. After reading the referenced material, 
you can return to your original page by clicking the BACK 
button at the bottom of the page.

Cross references link to figures, tables, and section headings. 
Also, words which are described in the Glossary are cross 
referenced to their Glossary description the first time they 
appear in the body text. 

Click the Add 
Variable button

Text formatted as gray and narrow denotes a part of the 
user interface, either of the Windows operating system or 
the ERTune™ program. This includes menu items, buttons, 
windows, screens, commands and onscreen instructions.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Paragraphs highlighted by the NOTE icon contain information 
that should be given particular attention.

IMPORTANT!IMPORTANT!
Paragraphs highlighted by the IMPORTANT! icon contain 
information that references specific requirements of your 
operating system.

Paragraphs highlighted by the CAUTION icon contain 
information that must be followed to maintain a safe and 
successful operating environment. 

Paragraphs highlighted by the WARNING icon contain 
information about practices or circumstances that can lead to 
personal injury or death, property damage or economic loss.

Navigating This Manual

Clicking any item in the Table of Contents moves you to that 
page in the manual.

You can also open the Bookmarks panel at any time to access an 
interactive set of links based on the Table of Contents.

Clicking the PREVIOUS button moves you to the previous 
consecutive page in the manual.

Clicking the NEXT button moves you to the next consecutive page 
in the manual.

BACK Clicking the BACK button moves you to the previously viewed 
page in the manual. This button returns you to your original page 
after you click a cross reference.

 

 WARNING

 CAUTION

Microsoft®, Windows®, Windows XP®, Windows Vista®, Windows 7®, 
Windows 8® and Windows® Explorer® are registered trademarks of 
Microsoft Corporation in the United States and other countries.
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Specifications

Enclosure 
NEMA 4X, IP66.  If the two 1/2-14 NPTF ports are unused, 
properly seal with a plug. 

CE Approved Wiring Instructions 
Use shielded, twisted pair cable (not provided with the ER5000).

Weight 
3.1 lbs / 1.4 kg

Media 
Supply pressure must be clean, dry inert gas or instrument grade 
air that meets the requirements of ISA Standard 7.0.01. Use of 
an in-line filter that meets the requirements of ISA standard 
7.0.01 and is less than 40 microns, and as small as 10 microns, is 
highly recommended to prevent damage to the solenoid valves. 
Moisture should be kept to a minimum. 

Ports 
Conduit: 1/2" NPTF 
Pneumatic: 1/8" NPTF — Inlet, Exhaust and Gauge Ports 

1/2" SAE — Controlled Outlet Port

Power Requirement 
Voltage: 24V DC (22V DC to 28V DC) 
Current: 340 mA max, 180 mA nominal 

Environment 
Temperature: -30°C to 75°C (dry Nitrogen supply gas) 

 5°C to 75°C (shop air)
Pressure: 28" to 32" Hg / 71 mm to 762 mm Hg 
Humidity: To 100% R.H. (non-condensing) @ 0°C to 75°C. 

Inlet Pressure 
Minimum:  Outlet pressure + 1 psig 
Maximum:  120 psig / 8.2 bar
Typical:  110 psig / 7.5 bar

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Response time is affected by input pressure. 

Sensor Update Rate 
25ms (rate of sensor reading and processing task)

USB Communication Interface 
USB:  2.0 
Maximum cable length: 15 ft / 4.5 m 
Connector: Mini-B 

RS485 Communication Interface 
Networking: Up to 32 controllers on one network 
Maximum cable length: 4000 ft / 1219 m 
Baud rate: 9600
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Flow Rate 
Cv:  0.01 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The flow rate can be increased using a booster regulator. 

Accuracy 
Room temp: 0.1% of span maximum 

Response Time 
Rise Time: 257ms — 10 psig to 90 psig / 0.7 bar to 6.2 bar
Fall Time: 552ms — 90 psig to 10 psig / 6.2 bar to 0.7 bar

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Step response into dead-end system (1 cubic inch volume).

External Analog Input Impedance 
4–20 mA: 250Ω
1–5V: 220KΩ — single input pin to ground 

1.7MΩ — differential input
0–10V: 100KΩ 

Digital Inputs 
Voltage Range/Input Impedance: 
4–20 mA: 250Ω
1–5V: 220KΩ — single input pin to ground 

1.7MΩ — differential input 
0–10V: 100KΩ 

Digital Outputs 
Current: 50 mA continuous, 100 mA instantaneous
Voltage: 5V to 28V
Type: Open collector, grounded emitter 

Analog Output 
4–20 mA:  Better than 0.5% accuracy; 
 loads from 50Ω to 1000Ω
0–10V DC:  Better than 0.5% accuracy;  

loads no less than 5000Ω 
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ER5000 Part Numbering System

As Figure 1 indicates, several base styles are available, including 
a compact OEM model for tight spaces where the NEMA 4 
enclosure isn’t needed. Please consult with your TESCOM 
representative for special modifications or requirements.

Figure 1: Breakdown of the ER5000 Part Number

* = Please contact your TESCOM representative for Explosion Proof options.

ER5000 Standard Features

• USB and RS485 communications

• USB cable with integrated strain relief 

• 1/8" NPTF Inlet and Exhaust Ports

• 1/2" SAE controlled Outlet Port

• Adaptor fitting 1/2" SAE x 1/8" NPTF

• Maximum inlet pressure = 120 psig / 8.2 bar

• 0–100 psig / 0–6.9 bar internal sensor

• ERTune™ program for Windows XP, VISTA, Windows 7 and 
Windows 8

IMPORTANT!IMPORTANT! Windows 8 users: In order to maintain compatibility 
with previous Windows operating systems, the ERTune™ program uses 
the .NET Framework 3.5, which is not installed by default in Windows 
8. If you are using Windows 8, you will need to download and install 
.NET Framework 3.5 before installing the ERTune™ program. You may 
also need to disable Driver Signature Enforcement to install the ER5000 
driver. We have provided step-by-step instructions for both these tasks 
in Appendix A: Setting Up The ERTune™ Program On Windows 8 PCs.

Base Style*
00 Standard NEMA 4X
02 Integrated Double Piston
04 OEM Style (No Cover)
10 Integrated with 44-4000
11 Integrated with 44-5200

Features
S Standard Setpoint/Feedback
F 2 Extra Analog Input/Outputs

Analog Signal Type
I 4–20 mA / 1–5V DC
V 0–10V DC

Cv Configuration
1  Standard Valves, Cv = 0.01

Internal Sensor Configuration
0 0–100 psig, 0.1% Accuracy

ER5 XX X X X – X
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ER5000 Accessories

Part # Description

80129 1/8" NPTF male tube connector

82575-25 250 mA / 24V DC power supply — input voltage 120V AC, 60 Hz

82575-50 500 mA / 24V DC power supply — input voltage 120V AC, 60 Hz

82919 Potentiometer with digital display

82948 USB to RS485 converter

85061 RS232 to RS485 converter

85121 12-wire cable assembly — 24" / 61 cm Included with all standard ER5000s

85122 8-wire cable assembly — 24" / 61 cm Included with "F" model ER5000s

85138-X 12-wire cable assembly — 5, 10, 20, 50 and 100 ft / 1.5, 3, 6, 15 and 30 m options

85139-X 8-wire cable assembly — 5, 10 and 20 ft / 1.5, 3 and 6 m options

85145 Filter kit

ERAA03458-02 Adaptor fitting 1/2" SAE x 1/8" NPTF — mates ER5000 to most TESCOM air actuated regulators 
Included with all standard ER5000s

ERAA03458-04 1/2" SAE X 1/4" NPTF

ERAA03409 USB Cable with Mini-B connector Included with all standard ER5000s

ERAA05146 MTA Connector Replacement Kit
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New Features

• Built-in USB connectivity

• Improved resolution for data acquisition with 16-bit A/D 
converter

• Suspend Control, a new operational mode available on 
“F” models, gives you the ability to lock output at a stable 
pressure over an extended period of time for operations, 
such as sensor calibration, where system stability is critical.

• The ERTune™ program has been upgraded to take full 
advantage of the Windows graphic user interface, with a 
single, unified operating environment and quick, tab-based 
access to all functions. Other enhancements include:

 > Setup Wizard and COM Port Search speed up installation.

 > The Tuning Tab now features highly responsive sliders, 
with optimal ranges for all configurable parameters 
clearly displayed in the interface.

 > Data acquisition can now be triggered automatically 
by system events such as digital input detection or a 
monitored variable reaching a target value.

 > Profiles can now include up to 100 command segments. 
Loop counts are now displayed in real time. 

 > For “F” model ER5000s, Profiles can now include these new 
commands:

Soak, which waits until feedback indicates a new setpoint 
has been reached before initiating a Dwell.

If and Goto, which allow you to create complex branching 
command sequences that respond to real-time operating 
conditions and inputs.

 > The Diagnostic Tools Tab now gives you one-click access 
to tuning and troubleshooting recommendations.

 > The Automated Solenoid Leak Test gives you a quick, 
intuitive and accurate assessment of the controller’s 
solenoid valves.

 > Regulator Diaphragm Protection is a new feature that 
gives an added layer of protection for applications where 
rapidly changing flow demands put undue stress on 
the sensing element of diaphragm sensed regulators, 
particularly those with metal diaphragms.
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Replacing an ER3000 with an ER5000

Wiring for the 12-pin MTA Connector
The wiring for the 12-pin MTA connector is the same for the 
ER5000SI-1 as it was for the ER3000SI-1. An MTA connector 
replacement kit is available to allow use of the existing 
installation cable with the new ER5000.

Wiring for the 8-pin Auxiliary MTA Connector
For “F” model ER5000s, there have been changes made to the 
wiring for the 8-pin auxiliary MTA connector. Pin 5 (green wire), 
which was previously the Analog Signal Ground, now activates 
the Suspend Control function, which closes both valves and 
locks the controller at the current pressure. If your current 
application makes use of this wire, refer to the Installation 
Variations section for recommended wiring configurations. 

For the ER5000, there are three wires which act as signal/board 
grounds:

• The black wire (Pin 10) and tan wire (Pin 12) of the 
12-pin MTA connector;

• The black wire (Pin 6) of the 8-pin auxiliary MTA connector.

Using the ER5000 with ER3000 software
If you wish to continue using the Windows Tune or other software 
that controlled your ER3000, you must install Jumper J9 to put 
the ER5000 into ER3000 Mode (refer to Figure 18). The ER5000 
uses a 16-bit A/D converter to translate analog input signals 
into the digital language the microprocessor understands, while 
the ER3000 uses a 12-bit converter. In order for the ER5000 to 
correctly interpret the signals generated by a program written 
for the ER3000, it must use a 12-bit scale.  

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Installing the ER3000 Mode Jumper will also turn off the new 
Suspend Control feature, as well as the new Profile commands.

UI3000 or UI4000

The ER5000 is NOT compatible with either the UI3000 or the 
UI4000.
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The ER5000: How It Works

The ER5000 (Electronic Regulator 5000) is a microprocessor-based 
PID (Proportional, Integral, Derivative) controller that brings precise 
algorithmic pressure control to a wide range of applications. 

It can be used as a standalone unit to control the pressure of clean, 
dry inert gases from 0–100 psig / 0–6.9 bar, or be connected to 
any pneumatically actuated regulator or valve. Used with TESCOM 
regulators, the ER5000 provides distributed pressure control of 
gases and liquids from vacuum to 30,000 psig / 2,068 bar, with a 
Cv of up to 12.

The ER5000 can be controlled from any PC via a direct USB or 
RS485 connection. The ER5000 also accepts analog setpoint 
signals from 4–20 mA, 1–5V or 0–10V analog sources, such as 
from a PC or PLC D/A card. The ER5000 can be wired to allow for 
multiple input/output configurations and daisychaining of up to 
32 controllers within the same RS485 network.

The ER5000 senses pressure using either its internal sensor or an 
external transducer (4–20 mA, 1–5V or 0–10V) placed within the 
actual process line. You can operate the ER5000 in one of three 
control modes: 

• Internal Feedback, which uses only the internal sensor;

• External Feedback, which uses only the external source;

• Cascade, which uses both internal and external sources in a 
“loop within a loop” configuration.

During setup, you can download PID settings that have been 
programmed by TESCOM to meet the needs of most commercial 
applications. The included ERTune™ program provides an intuitive 
interface to customize the performance parameters of the ER5000 
by directly tuning the Proportional, Integral and Derivative values.

Using the ERTune™ program, you can create Profiles, which guide 
the ER5000 through command sequences that may include 
multiple setpoint changes, precisely timed digital inputs and 
outputs, and modification of response characteristics and other 
internal variables based on real-time operational conditions.

The ER5000 installs in just minutes, yet provides the precision, 
dependability and flexibility to meet the needs of the most 
demanding user.
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Understanding PID Controllers

PID Controllers allow mechanical systems to operate at a high 
level of precision and dependability with only occasional 
oversight by human operators. They can control virtually any 
measurable physical property within the system, including 
pressure, flow, temperature, position, speed, force, consistency, 
torque, and acceleration. 

PID controllers operate in a continuous loop of monitoring and 
response. The ER5000 performs one loop every 25 ms (milliseconds). 

At the start of each loop, the controller reads the input from a 
sensor within the system to find the current level of a measured 
property such as system pressure (the Feedback), and compares it 
to a preset target value (the Setpoint). 

If the two values match, a Zero Error is generated and no action is 
taken. If the two values do not match, a positive or negative Error 
is generated and the controller activates to correct the error.

When the error is the result of an unintended change in the 
operating environment, the controller works to return the 
system to its previous level. When the error is the result of a 

scheduled change in the setpoint, the controller works to raise 
or lower the system to the new target level. 

In either case, the controller continues to act until setpoint and 
feedback are equal. The controller then generates a zero error 
and returns to its monitoring function. At this point, the system 
is said to be in a Stable State. 

The response of the PID controller, from error generation 
to stable state, is shaped by a complex algorithm that 
incorporates three independent but interrelated values (also 
referred to as Terms).

• The Proportional (P) term is a function of the value of the 
error generated during the current loop. With each loop, 
the P value changes in direct proportion to the amount of 
error. Proportional is largest when the error is first detected, 
and grows progressively smaller as the controller brings the 
system closer to setpoint. 

• The Integral (I) term is a function of the combined values 
of all errors generated while the system is in operation. 
The I value continues to increase as long as the system is in 
error, and will only decrease when an error is recorded in the 
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opposite direction. Significantly, Integral retains its value after 
the error has been corrected. This is known as Integral Windup.

• The Derivative (D) term is a function of the current rate of 
change. The D value decreases, then begins to dampen the other 
values, as the controller brings the system closer to setpoint.

PID Controllers: Three Components Are Better Than One

Why three independent values? Consider this scenario: 

• You are behind the wheel of a car that needs to turn 
through a curve in the road.

• As the car enters the turn, you simply steer to match the 
curve. At this point, you are a Proportional controller.

• As the car continues through the turn, however, peripheral 
force pushes it outward. Matching the curve (Proportional 
only) is no longer sufficient. You now find it necessary to 
oversteer (add Integral) to stay in the curve. Then a gust 
of wind hits the side of the car; now you need to oversteer 
more to compensate for both the wind and the peripheral 
force (accumulated Integral).

• As the car passes the midpoint of the curve, the peripheral 
force decreases and the wind dies down. Now the oversteer 
(Proportional and accumulated Integral) threatens to put 
the car into a skid. You respond by understeering (adding 
Derivative) through the rest of the curve until you are back 
on straight road.

• As you drive on, you remember the wind that hit at the 
most inopportune moment, so you keep a close hand on 
the wheel in case there is another gust (Integral windup).

Like the driver who knows when to follow the road, when 
to oversteer and when to understeer, controllers that can 
combine the effects of Proportional, Integral and Derivative 
have the flexibility to respond effectively to the widest range of 
application requirements and environmental conditions.

Now consider the same curve with three different drivers.

• The first driver spots a police car in the next lane. This 
driver’s primary goal will be to stay squarely within the 
lane through the whole length of the turn. This controller 
carefully balances Proportional, Integral and Derivative.
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• The second driver notices that there is a full cup of hot 
coffee in the cup holder. This driver will take the curve as 
widely, and as slowly, as possible, because this driver’s 
primary goal is to make sure the hot liquid does not spill. 
This controller has lowered the Proportional and Integral, 
and increased the Derivative, to make the response as 
stable as possible, at the expense of some speed and 
precision.

• The third driver is participating in a road race. This driver 
will take the curve as tight and fast as possible, pushing 
the limits right up to the point of spinning the car out of 
control. This controller has maxed out the Proportional 
and Integral to get the fastest response possible, then set 
Derivative just enough to reestablish control at the end.

Three controllers, three different goals, three different 
responses to the same change. By raising and lowering the 
relative amounts of Proportional, Integral and Derivative (a 
process called Tuning the controller) you can set up your ER5000 
to meet the specific response characteristics, and work within 
the specific limitations, of any system. 

A Typical PID Control System

Figure 2 shows a simplified diagram of a typical PID control 
system.

In this drawing, the dashed line represents the controller. 
The setpoint (r) is sent from the internal board or an external 
source. The feedback (y) is sent from internal or external 
sensors that monitor the current state of the system. The 
controller reads both values and subtracts the feedback signal 
from the setpoint.

+ -

Setpoint = r

Controller

Error = e Output

Feedback = y

System
Under
Control

 

Figure 2:  Simplified PID Control System
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If setpoint and feedback match, the controller generates a zero 
error and does not activate.

If setpoint and feedback do not match, the controller generates 
an error value (e), activates, and sends an output to the system 
to correct the error. For example, in the ER5000 the output is 
directed to Solenoid Valves within the controller. 

A positive error is generated when feedback is lower than setpoint. 
The ER5000 responds to positive error by activating to increase 
system pressure.

A negative error is generated when feedback is higher than 
setpoint. The ER5000 responds to negative error by activating 
to decrease system pressure.

The controller determines how much output to send by 
summing two values: 

• The Proportional term, which is the product of the generated 
error and the constant Kp (the Proportional Constant).

• The Integral term, which is the product of the integral of all 
accumulated errors and the constant Ki (the Integral Constant). 

Control systems based on just the Proportional term, or 
just the Proportional and Integral terms, are known as a P 
and PI configurations. The ER5000 can operate in a P or PI 
configuration if this is appropriate for the application. The PID 
configuration, which includes the Derivative term, offers the 
greatest level of precision and flexibility.

The Derivative term is often used to attenuate the feedback 
before it is compared to setpoint. It is shown this way in Figure 2. 
The Derivative of the feedback is multiplied by the constant Kd 
(the Derivative Constant), and the resulting value is summed 
with the feedback. 

Because the Derivative is a function of the rate of change, its 
primary function is to act as a damper and suppress oscillations 
as the system approaches setpoint. 
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Tuning a PID Controller

Tuning a controller is the process of selecting the optimal 
Kp, Ki, and Kd settings to yield the best response. The 
“best” response depends on what is most important for the 
application, and usually entails a compromise between speed 
of response and stability. 

Your ER5000 is pre-tuned at the factory, and a default PID 
setting configured by TESCOM to match your TESCOM 
regulator can be downloaded to the controller during setup. 
For many users, the default tuning will provide effective system 
control right out of the box. Others will find that the specific 
requirements of their application or operating environment call 
for some additional manual tuning, using the ERTune™ program, 
to achieve optimal performance. 

The mathematics of PID algorithms are complex and beyond the 
scope of this manual. Understanding the response characteristics 
of your system will inevitably involve trial and error. 

Nonetheless, PID tuning can also be understood in basic 
functional terms. There are predictable effects, both positive and 
negative, to watch for as settings are increased or decreased. 

If necessary, default settings can be restored with the click of a 
button (see To reset the ER5000 to its default PID settings). 

Using a few rules of thumb and the real-time visual feedback 
provided by the ERTune™ program, all operators, regardless of 
experience, can achieve positive results through manual tuning 
of their controllers.

Rules of Thumb for PID Tuning

• The Proportional setting controls the overall response curve 
of the controller. It is set first. Integral and Derivative are 
added to fine tune the response.

• The Integral setting accelerates the response, particularly 
as the system approaches setpoint and the Proportional 
decreases. It is primarily used to minimize a condition 
known as Steady State Error, or Offset, where the system 
settles into a stable state without reaching the targeted 
setpoint. The Integral also remains “charged up” with 
Integral windup after an error has been corrected.

• The Derivative setting dampens the response and is used to 
prevent the system from overcorrecting. Generally set next 
after Proportional.
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Figure 3 shows four typical response curves to a step 
(instantaneous) change in setpoint.

A

B

D

C

Overshoot

Ringing

Offset

Settling Time

Rise Time (10%–90%)

Figure 3: Typical Response Curves to Programmed Setpoint Change

The controller in Curve A responds with a Rise Time that is 
short and sharp. It also overcorrects (Overshoots) the error, and 
oscillates around the new setpoint, a condition known as Ringing. 
There is a prolonged Settling Time before the system reaches its 
new stable state. The overall response is quick but unstable.

The controller in Curve D has a long, gradual rise time, and ends 
up in Steady State Error, settling into a stable state that is slightly 
below the new setpoint.

Curve A demonstrates the unwanted effects of a fast, but also 
unstable, response. Tuning this controller will entail lowering 
the Proportional setting, and perhaps the Integral setting as 
well. Alternatively, increasing the Derivative will help to stabilize 
the response. Curve D demonstrates the unwanted effects of 
a stable, but overly slow, response. Tuning this controller will 
entail increasing Proportional. Integral also should be increased 
to eliminate the offset. Derivative should be checked to see if it 
is overdamping the response.

The controllers in Curves B and C have been tuned to achieve 
a balance between speed and stability. Curve B allows a small 
amount of overshoot and ringing in exchange for the fastest 
rise time possible, with a settling time that is short and stable. 
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Curve C is “critically damped,” with just enough Derivative added 
to eliminate overshoot completely. Both tunings have no offset. 
Curve B would be an optimal tuning for an application which can 
tolerate overshoot, Curve C for one which cannot.

To restate the rules of thumb for each component:

Proportional (P): 

• Higher settings result in shorter rise times and faster response. 

• Higher settings also make the response less stable, with 
overshoot and ringing. Overshoot may tax the physical 
limitations of the system.

• Lower settings result in slower response.

Integral (I):

• Higher settings accelerate the response. 

• Higher settings also increase instability. 

• Lower settings result in a less responsive controller. 

• Because Integral windup continues to push the response 
even after the system has reached stable state, higher 
Integral settings can eliminate offset. 

• Windup can delay the controller’s response to new errors, as 
accumulated errors must “spool out” before new errors can 
begin “charging up” Integral. The ER5000 features exclusive 
Integral Limits to control positive and negative windup, allowing 
you to use higher Integral settings.

• The Integral of small errors can, over time, accumulate to 
the point of causing unwanted activation of the controller. 
The ER5000 features an exclusive filter called Integral 
Deadband to mitigate this effect. 

Derivative (D):

• Higher settings correct overshoot and ringing.

• Higher settings also decrease settling time and increase 
system stability.

• Higher settings may overdamp the system, causing a slow 
rise time. 

• Paradoxically, higher Derivative settings can make some 
systems unstable by increasing sensitivity to transient 
changes (noise) in the operating environment. This 
sensitivity can decrease the operational lifespan of the 
ER5000’s solenoid valves due to frequent activation.
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Table 1 gives a summary of the rules of thumb for Proportional, 
Integral and Derivative.

Table 1: Effect of P, I and D Increases on Response Curve of Controller

Increased 
P Value

Increased 
I Value

Increased 
D Value

Rise Time Faster Faster Slower

Instability 
(Overshoot/Ringing)

More More Less*

Settling Time Varies Longer Shorter

Offset Less Eliminate Varies

* Excess D Value can, however, result in more instability rather than less. Refer to 
the restatement of the rules of thumb for Derivative on page 32.

The ERTune™ program gives you a rich visual environment and 
precise, intuitive controls for tuning the ER5000. Refer to The 
Tuning Tab: Controls and Functions for Tuning the ER5000 for a 
detailed explanation of the program’s capabilities and features, 
as well as tips and techniques to achieve optimal system 
performance. 

Every system has unique characteristics, every operational 
environment presents unique challenges, and every application 
has unique requirements. Optimal tuning will invariably involve 
both trial and error and compromise. Fast rise time usually 
comes at the expense of increased instability. Minimizing 
overshoot may result in response lag or offset. Eliminating 
offset may introduce unwanted windup. It is important to know 
your priorities and understand the trade-offs.
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The ER5000: Typical Application

Controlling System Pressure

In a typical application, the Outlet Port of the ER5000 connects 
to the top of a Dome Loaded or air Air Actuated pressure reducing 
Regulator, usually through the included 1/2" SAE x 1/8" NPTF 
adaptor. This is shown in Figure 4.

Supply Pressure of up to 120 psig / 8.2 bar, with 110 psig / 7.5 bar 
being typical, is provided to the ER5000 by an external source. 
The ER5000 increases Pilot Pressure to the air actuator of the 
regulator by opening the Pulse Width Modulation (PWM) solenoid 
valve at the Inlet Port, and reduces pilot pressure by opening 
the PWM solenoid valve at the Exhaust Port. Normally, the 
exhaust vents to atmosphere.

The controller, configured in External Feedback mode, senses 
System Pressure through input from a transducer mounted 
downstream in the Process Line.

Every 25 milliseconds, the controller reads the feedback and 
compares it to the setpoint, which it receives from an external 
source or from a Profile in its onboard memory. 

Figure 4: Typical ER5000 Application.
Controller, with adaptor, is mounted to an air actuated regulator. Feedback is from the external 

transducer. Setpoint is from a Profile downloaded from the PC through the USB connection.

ER5000 Supply
Pressure 
110 psig / 7.5 bar

Adaptor

External 
Transducer

USB
Connection

PC

Inlet Pressure
Outlet Pressure  
To Process 

Regulator
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If feedback is lower than setpoint, the ER5000 activates the inlet 
valve, allowing Pilot Pressure to flow into the actuator of the 
regulator. This causes the main valve of the regulator to open 
up, resulting in an increase in downstream System Pressure. The 
ER5000 will continue to send pilot pressure into the air actuator of 
the regulator until feedback and setpoint are equal. At that point, 
the inlet valve closes, stabilizing the system at that pressure.

If feedback is higher than setpoint, the ER5000 activates the 
exhaust valve, releasing pilot pressure from the regulator. 
The decrease in pilot pressure causes the main valve of the 
regulator to close up, and also causes the regulator vent to 
open, exhausting excess system pressure (if your application 
uses a non-venting regulator, refer to page 36). The result is 
a decrease in downstream system pressure. The ER5000 will 
continue to exhaust pilot pressure until the feedback signal is 
equal to the setpoint. At that point, the exhaust valve closes, 
stabilizing the system at that pressure.

The air actuator, also known as the Ratio Actuator, amplifies the 
force generated by the ER5000, allowing the pilot pressure to 
modulate system pressure that may be many times greater, up to 
30,000 psig / 2,068 bar.  

ER5000 
Inlet Port

Supply 
Pressure
110 psig / 
7.5 bar

Pressure Vents 
to Atmosphere

Pilot 
Pressure To 
Air Actuator

Pilot 
Pressure From 
Air Actuator

Inlet 
Valve

ER5000 
Exhaust Port

Air Actuator

Vent Valve
Main Valve

Regulator 
Outlet  
Pressure

Regulator 
Inlet  
Pressure

Captured Vent exhausts excess pressure

ER5000 Outlet Port 
and Adaptor

Setpoint
Source can be either a digital 
 signal provided over USB or 
RS485, an  analog signal or 
a Profile  stored in onboard 
memory.

Feedback
For optimal system 
 performance, an accuracy 
of 0.1% or better  is required. 
A less accurate  transducer 
can be used, but  doing so 
will degrade the  accuracy of 
the overall system. 

USB Connection

PC

Exhaust 
Valve

Figure 5: Internal Operation of the ER5000 Controller
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A Note Concerning Non-Venting Regulators in Closed 
Loop Applications

Non-venting regulators, which do not feature a regulator vent to 
exhaust excess system pressure, pose a particular challenge in 
closed loop applications when the downstream flow is blocked.

When downstream flow stops suddenly, for example when 
a downstream valve is closed, feedback rises rapidly. The 
regulator responds by closing its main valve. However, due 
to Lock-up in the regulator, a small amount of excess pressure 
escapes through the main valve before it achieves a completely 
tight seal. 

In venting regulators, this excess downstream pressure is 
exhausted by the regulator vent, allowing the system to return 
to stable state. In non-venting regulators, this excess pressure is 
trapped in the downstream pipe.

The PID controller senses the rise in feedback and activates to 
lower system pressure. But the regulator cannot respond, since it 
cannot vent. Because the excess system pressure is trapped, the 
error will not change. The controller could continue to respond 
until the pilot pressure is completely vented through the exhaust 
valve. This can create two different undesirable conditions:

• If the regulator is a metal diaphragm sensed regulator, the 
differential between the high downstream pressure beneath 
the diaphragm and the low (or even zero) pilot pressure 
above the diaphragm can critically stress the diaphragm.

• Regardless of regulator type, if the downstream flow 
suddenly restarts, the PID controller's response will be 
delayed, because it will need to completely refill the 
regulator's dome or air actuator cavity.

When the Diaphragm Protection feature of the ER5000 is 
activated, the controller responds to error only up to a set 
percentage of the original pilot pressure, then stops. This allows 
the controller and regulator to be reset quickly once system 
flow has been restored, and minimizes pressure differentials 
that can effect regulator components. 

The Regulator Diaphragm Protection feature is strongly 
recommended for applications using metal diaphragm sensed 
regulators. It provides a control benefit for applications using 
non-venting regulators. It is not required for applications using 
venting regulators or piston sensed regulators. 

Refer to The Diaphragm Protection Panel to learn more about this 
feature.
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Monitoring System Control Limits

The ER5000 also can be configured to monitor the system and 
respond if user-specified limits are exceeded. This function is 
deactivated by default, and can be activated using controls in 
the ERTune™ program. Refer to The Control Limits Panel section 
for more information.

This feature provides added security in the event of a system 
failure such as broken transducer wiring, lack of supply pressure 
or pipe ruptures. 

 CAUTION
The Control Limits feature provides an additional level of system 
monitoring. Activation indicates a potential problem, but will 
not, by itself, prevent problems from occurring. It should not be 
considered to be a safety mechanism, nor is it intended to be a 
safety feature or pressure limiting device.

When an ER5000 configured to monitor Control Limits detects 
a signal indicating that a limit has been exceeded, it activates its 
solenoid valves to reach one of three Control Limit Conditions:

• Inlet Closed/Exhaust Closed

• Inlet Closed/Exhaust Open

• Inlet Open/Exhaust Closed.

The default Condition is Inlet Closed/Exhaust Open, which 
ensures that a pressure reducing system will be vented if a limit 
is exceeded. If your application uses a non-venting regulator, 
refer to A Note Concerning Non-Venting Regulators in Closed Loop 
Applications if you intend to use the ER5000 in this condition.

Minimum and maximum limits can be monitored for any or all 
of these variables: 

• Analog Setpoint

• Internal Sensor

• External Sensor

• Inner Error

• Outer Error.
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The ER5000: Control Modes

Internal Feedback Mode

Internal Feedback Mode uses the ER5000’s internal  
sensor to monitor the pressure within the controller’s 
0–100 psig / 0–6.9 bar internal pressure range. This mode is 
typically used when the ER5000 is used as a standalone unit, or 
when open-loop control of a regulator is desired.

External Feedback Mode

External Feedback Mode uses a user-supplied external transducer 
to monitor the system pressure. The transducer is installed in the 
process line and provides direct feedback to the ER5000. This 
mode is typically used when the ER5000 acts as the pilot regulator 
for a regulator or valve. 

An external transducer may also be installed in the ER5000’s 
pressure line when the ER5000 is used as a standalone unit. 
This may be preferable to Internal Feedback mode when:

• The application requires precise control within a small 
pressure range. For example, the ER5000 will respond more 
efficiently to a 5% change in a 0–10 psig / 0–0.7 bar range 
than to a 0.5% change in its full 0–100 psig / 0–6.9 bar range.

• There is a need to monitor downstream pressure. For example, 
if the output passes through a length of pipe to a vessel and 
it is expected that there will be pressure drops in the pipe, 
an external sensor installed at the vessel will provide a more 
responsive feedback signal than the controller’s internal sensor.

Cascade Mode

Cascade Mode implements one PID loop within another PID loop. 
The inner loop uses the controller’s internal sensor and the outer 
loop uses an external sensor. This mode of operation creates 
more stability, but slows down the response of the system.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

For proper operation in Cascade Mode, the following 
recommended defaults for the Integral Limits of the external feedback 
loop (also known as the outer loop) are downloaded into the controller 
during setup: Maximum: 32767;  Minimum: 0. These settings are optimal 
for most applications.

Refer to The Cascade Tuning Tips and The Integral Limits 
Controllers for more information on these settings.
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D/A Cards 
Acronym for Digital To Analog Card. Used in PCs and PLCs to 
generate analog signals.

Daisychain
Multiple ER5000s wired together in sequence that communicate 
with a single, central PC on the same RS485 network. Each 
controller within the chain must be given a unique Node Address, 
which is done using the ERTune™ program. 

Deadband
See Integral Deadband and Pulse Deadband.

Derivative
The component of a controller’s response that is based on the rate 
of change within the system. Generally acts to dampen the effect 
of Proportional and Integral and to increase system stability.

Error
The result that is generated when Feedback is subtracted from 
Setpoint. A zero error results in no activation. A non-zero error 

causes the ER5000 to activate until the error is corrected. A 
positive error causes the ER5000 to increase system pressure, and 
a negative error causes the ER5000 to decrease system pressure.

Feedback
The input sent from an internal or external sensor that indicates 
the current level of the process a PID controller manages. The 
controller subtracts feedback from Setpoint, generating an Error, 
and any non-zero error activates the controller.

Integral
The component of a controller’s response that is based on 
accumulated error within the system. Continues to accumulate 
as long as there is a non-zero Error, and retains its value until 
errors are generated in the opposite direction. Accelerates the 
effect of Proportional. Often referred to as “reset,” because its 
continually increasing value effectively “resets” the value of 
Setpoint within the controller’s computations above or below its 
actual level. This allows PID controllers to eliminate Offset. The 
retained Integral value, also known as Integral Windup, must be 
carefully controlled to prevent response lag.

Terms Relating to PID Controllers and Controller Tuning
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Integral Deadband
Stop-band filter that deactivates Integral within a set percentage 
range around Setpoint. Prevents small, transient errors from 
accumulating to a level that activates the controller. Accessed 
through the Tuning Tab in the ERTune™ program.

Integral Windup
Amount of accumulated value that is retained by Integral after error 
has been corrected. Excess windup can cause the controller to lag 
in response to new Errors. Proper Tuning prevents windup by setting 
limits on accumulated value through the Integral Limits.

Integral Limits
Pair of filters which limit the amount of Integral Windup that can 
accumulate during Error correction. Maximum limit is set for 
positive errors (Setpoint minus Feedback is positive). Minimum 
limit is set for negative errors (setpoint minus feedback is 
negative). Accessed through the Tuning Tab in the ERTune™ 
program. Allow for high Integral settings without unwanted 
effects. Generally set to the smallest value necessary to 
eliminate Offset. 

Node Address
Virtual address of the ER5000 within a network. Each controller 
is assigned a default address of 250 at the factory. When 
multiple ER5000s are in a Daisychain within the same RS485 
network, each controller must be assigned a unique address so 
that the PC can locate and communicate independently with 
each controller. The Node Address can be changed using the 
Configure Tab in the ERTune™ program.

Noise
Short, transient changes to the system that are generally too 
small to require activation of the PID Controller. A Derivative 
setting that is too high may make the controller overly reactive 
to noise, at the expense of system stability and cycle life of the 
ER5000’s solenoid valves.

Offset
Also known as Steady State Error: a condition of Proportional-
only response where the system reaches a stable state that is 
slightly above or below the targeted Setpoint. Two aspects of 
Proportional contribute to this effect: the inevitable mechanical 
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lag between generation of Error and the physical response of the 
valves to the controller output, and the fact that a response that 
is a direct multiple of error will always fall short of 100% error 
correction. Proper Tuning generally aims to eliminate offset by 
adding Integral.

Open Collector
A common type of output for integrated circuits, where the 
emitter of the transistor is connected to ground and the 
collector of the transistor is connected to the output. Instead of 
outputting a signal of a specific voltage or current, the output 
acts as either an open circuit or a connection to ground. Open 
collector circuits are used in many systems, such as to interface 
devices that have different operating voltage levels or to 
connect multiple open collector devices to a single line.

Overshoot
Overcorrection due to a Proportional or Integral setting that 
is too high. Must be carefully controlled to keep response 
within the operational parameters of the system. Proper Tuning 
generally aims to minimize overshoot.

PC
Acronym for Personal Computer.

PID Controller
An automated control device that monitors a property of a 
mechanical system in a continual loop and uses an algorithm 
incorporating a Proportional, Integral and Derivative component 
to correct Error and maintain system stability. 

Pilot Pressure 
The pressure applied to the top of a Dome Loaded or Air Actuated 
Regulator that controls the Control Pressure of that regulator. The 
ER5000 is most commonly used to control pilot pressure to a 
dome loaded or air actuated regulator.

PLC 
Acronym for Programmable Logic Controller.

Pressure Reducing Regulator
Regulator that reduces high-pressure supplies of gas or liquid to 
a safe or usable level for an application.

Process Line
Area within a system where the activity takes place that is 
controlled by the PID controller, such as the pressure within 
a pipeline or vessel. External sensors send Feedback from the 
process line to the controller.
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Profile
Command sequence, created using the The Profile Builder 
Panel in the ERTune™ program, which can be downloaded to 
the control board of the ER5000. Guides the ER5000 through 
a set of actions that may include multiple Setpoint changes, 
modification of response characteristics and other internal 
Variables based on real-time operational conditions, and, 
in “F” model controllers, precisely timed digital inputs and 
outputs. Profiles may also be saved to a PC for future use.

Proportional
The component of a controller’s response that is a direct 
function of the Error generated by the current level of Feedback 
from the system.

Pulse Deadband
Stop-band filter that deactivates Pulse Mode within a set 
percentage range around Setpoint. 

Pulse Mode
Refer to The Pulse Mode Panel for a complete description of this 
feature.

Pulse Width Modulation (PWM)
Method of controlling a device such as a mechanical valve using 
the control signal from a digital microprocessor (which can only 
be ON or OFF) by varying the amount of time during a given 
cycle when the ON signal is being sent. 

The proportion of time that the signal is ON, from 0% to 100% of 
the cycle, is known as the “duty cycle”. Because of mechanical 
lag (the amount of time it takes for the valve to physically 
respond to the instantaneous change in signal), the valve is 
constantly “catching up” with the ON/OFF control signal in 
direct proportion to the duty cycle. For example, a duty cycle of 
75% results in a valve that is approximately three-quarters open 
during that cycle. 

The inlet and exhaust valves in the ER5000 are both PWM 
driven, with a cycle time of 25 milliseconds.

Regulator
Mechanical valve that dynamically controls the pressure of 
liquid or gas in a process line by opening or closing in response 
to activation of an internal control element. Works to ensure 
that the supplied pressure matches the demand of the system.
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Ringing
Oscillation around a Setpoint, due to a Proportional or Integral 
setting that is too high or a Derivative setting that is too low. 
Proper Tuning generally aims to minimize ringing.

Rise Time
Time required for feedback to reach a new Setpoint, or a certain 
percentage of that setpoint, following a Step Change. TESCOM 
uses the ISA standard, which specifies rise time as the time it takes 
to travel from 10% to 90% of the new setpoint. Proper Tuning aims 
to minimize rise time without inducing Overshoot or Ringing. 

Segment
One command line within a Profile.

Setpoint
The value that a PID Controller works to maintain within the system 
it controls. The setpoint may remain at one level or change over 
time, depending on the requirements of the system. A well tuned 
controller will maintain a Stable State at setpoint and implement 
setpoint changes quickly and accurately. The ER5000 requires a 
setpoint signal in order to function. This signal can come from an 
external source such as a PC or PLC, or from a Profile.

Settling Time
Time required for a system to reach a stable state once it 
has reached a new setpoint. Proper Tuning generally aims to 
minimize Settling Time.

Solenoid Valve
An electromechanical valve controlled by electrical current 
through a coil. The ER5000 valves are Pulse Width Modulation 
(PWM) driven mechanical valves that open and close in 
direct proportion to the output signal from the controller’s 
microprocessor. Positive output activates the inlet valve, 
increasing pressure, and negative output activates the exhaust 
valve, decreasing pressure. 

Stable State
Any time that a PID Controller generates a zero Error for more 
than one loop of monitoring and response. Proper Tuning 
aims to find a correct balance between stability and speed of 
response.

Steady State Error
See Offset.
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Step Change
Change in Setpoint that occurs within a single loop of 
monitoring and response for a PID controller.

Supply Pressure
Pressure applied to the inlet of the ER5000 from an external 
source. Sent by the ER5000 as Pilot Pressure to pilot a Dome 
Loaded or Air Actuated Regulator.

System Pressure
The pressure of the gas or liquid in a Process Line that is 
controlled by the Regulator, which is controlled in turn by the Pilot 
Pressure from the PID Controller. There are two components to 
system pressure: the inlet pressure (upstream pressure), which 
is the pressure level of the gas or liquid in the process line at 
the point where it enters the regulator, and the outlet pressure 
(downstream pressure), which is the pressure level of the gas or 
liquid as it exits the regulator. For a Pressure Reducing Regulator, 
the inlet pressure must be higher than the outlet pressure. 

Term
Used alternatively with value when referring to Proportional, 
Integral and Derivative.

Transducer
Commonly used term for an external sensing device that 
provides a feedback signal.

Tuning
The process of setting values for the Proportional, Integral and 
Derivative constants within the PID Controller to achieve optimal 
performance.

Variable
Any configuration setting for the ER5000, such as the 
Proportional, Integral and Derivative constants, the setpoint 
value, the Control Mode, or the Node Address. Refer to the 
Internal Variables section for a complete list. Variable values 
can be included in data collection, and certain variables can be 
tracked using the Plot Screen of the ERTune™ program.
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Accuracy
The acceptable level of pressure variation for a Regulator under 
steady state conditions within its control range. All physical and 
mechanical processes have some level of variation.

Air Actuated
Also known as Air Loaded: one type of loading element for 
a pressure Regulator. Utilizes low pressure gas as the Loading 
Element (Loading Force), typically 0–80 psig / 0–5.5 bar. This 
is a form of ratio loading: the regulator uses low Pilot Pressure 
to regulate a Control Pressure that may be much higher (see 
Ratio Actuator). The most common type of regulator used with 
the ER5000, as it is the only type that can be used for control 
pressures greater than 100 psig / 6.9 bar. 

Captured Venting
Feature incorporated in some venting Regulators which provides an 
additional port that can be connected to piping in order to safely 
dispose of excess liquid or gas expelled by the regulator's vent valve. 
The vent port should never be plugged. Not all venting regulators 
have this feature. Refer to Venting Regulator.

Control Element
One of the three basic elements of a Regulator. Acts to reduce high 
Inlet Pressure to a lower working pressure (Outlet Pressure). The 
control element is sometimes called the main valve, valve stem, or 
poppet.

Control Pressure
The component of System Pressure that is the result of the 
regulating action of the Regulator. Can be either the Outlet Pressure 
or the Inlet Pressure, depending on the type of regulator. For a 
pressure reducing regulator, the control pressure is the Outlet 
pressure. For a back pressure regulator, the control pressure is the 
Inlet pressure.

Creep
An increase in the Outlet Pressure following Lock-up. Usually seen 
as a slow, gradual pressure increase. Indicates a regulator leak and 
calls for the immediate removal of the regulator for service.

Terms Relating to Regulators



ER5000 — 

47

ER5000 — Glossary of Terms

Cv
The flow coefficient: equal to the number of U.S. Gallons of 
water at 60°F / 16°C that will flow through a valve, regulator 
or restriction in one minute when the pressure differential 
between inlet and outlet is one pound per square inch (1 psi). 
When gas is used instead of liquid, the equation is modified to 
account for the use of a compressible fluid. For a regulator, Cv is 
determined when the regulator is wide open and not regulating. 
When determining actual performance during regulating 
conditions, use flow curves.

Decaying Inlet Characteristic
Also known as Supply Pressure Effect. The effect on the set 
pressure of a regulator as a result of an Inlet Pressure change; 
usually an increase in Outlet Pressure due to a decrease in inlet 
pressure. 

In pressure reducing regulators, outlet pressure is set when 
force from the load element, which opens the main valve, is 
matched by inlet pressure moving through the valve. If inlet 

pressure decreases, for example when a supply cylinder starts to 
empty and the inlet pressure it supplies starts to decrease, this 
tips the balance in favor of the load element and opens the valve 
wider. This allows more flow, which results in a higher output 
pressure, and the seemingly paradoxical fact that a decrease in 
inlet pressure results in an increase in outlet pressure. 

Two-stage regulator design, or the use of PID controllers, can 
prevent this characteristic.

Diaphragm
One of several types of Sensing Element. A diaphragm is sensitive in 
reacting to pressure changes. Common diaphragm materials are 
Buna-N, Viton, Ethylene Propylene, 316 Stainless Steel, and Elgiloy.

Dome Loaded
One type of Loading Element. Pilot Pressure enters the dome at a 
pressure equal to the Outlet Pressure desired. Generally requires 
some additional pressure to activate: refer to Negative Bias. Can be 
used with the ER5000 for low Control Pressure applications.
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Droop
The Outlet Pressure change(offset) which occurs as flow rate 
increases, and which causes outlet pressure to stabilize at a rate 
that is slightly offset from the expected Set Pressure under flowing 
conditions. Caused by variations in the response characteristics of 
the mechanical components of regulators at different flow rates. 
PID Controllers are often used to eliminate droop.

Flow Capacity (Cv)
Refer to Cv.

Flow Rate (Q)
The quantity of fluid being passed through a Regulator or 
valve during a specified time period. Units of measure include 
Standard Cubic Feet per Minute (SCFM), Pounds per minute 
(lbs/min), Liters per Minute (L/Mn), Gallons Per Minute (GPM), 
Grams per Second (g/sec) and Kilograms per Hour (Kg/hr).

Loading Element (Loading Force)
One of the three basic elements of a Regulator. The external 
force, such as the Pilot Pressure from a PID Controller or the 
downward pressure of a knob-activated spring, that acts on 

the Sensing Element and causes the Control Element to respond 
by opening or closing the main valve. The three common types 
of loading elements are Spring Loaded, Dome Loaded and Air 
Actuated. The ER5000 can be used with either dome loaded or 
air actuated regulators.

Lock-up
The Outlet Pressure rise above setpoint pressure as the flow is 
decreased to zero. 

Regulators respond to a sudden increase in downstream 
pressure by closing the main valve. There is, however, a slight 
lag in achieving a completely tight seal of the valve. This can 
be caused by the mechanical response time of the valve, or 
because some extra pressure is required to force the seat into 
the sealing surface enough to make the seal 100% tight. Good 
regulator design aims to minimize lock-up. 

In most applications, a PID Controller will automatically correct 
the small pressure rise that is due to lock-up.
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Pilot Regulator
Device that controls pressure to the actuation port of a dome 
loaded or air actuated Regulator. In its simplest form, the 
ER5000 is a pilot regulator.

Negative Bias
For Dome Loaded Regulators, the amount of Loading Force 
beyond the desired setpoint that is necessary to overcome the 
physical resistance of the Sensing Element (such as a diaphragm 
or piston o-ring) and initiate a dynamic response from the 
regulator. For example, to initiate a 1 psig / 0.07 bar setpoint, it 
may initially require 26 psig / 1.8 bar of Pilot Pressure to open the 
regulator valve and allow flow. Once dynamic response has been 
initiated, the dome loaded regulator tracks at a 1:1 relationship 
between pilot pressure and Control Pressure, so an additional 
25 psig / 1.7 bar of pilot pressure will result in a jump from 
1 psig to 26 psig / 0.07 bar to 1.8 bar in control pressure. 

Please discuss with your TESCOM representative if you are 
using a dome loaded regulator with the ER5000, as the 
amount of negative bias varies among different dome loaded 
regulator models.

Piston
One type of Sensing Element. Used for high pressure 
applications, up to 30,000 psig / 2,068 bar.

psia (absolute pressure)
A measure of pressure in pounds per square inch (psi) that is 
referenced to zero absolute pressure.

psig (gauge pressure)
A measure of pressure in pounds per square inch (psi) that is 
referenced to atmospheric pressure.

Ratio Actuator
Device that amplifies the force generated by the Loading Element 
(Loading Force) in air actuated Regulators. Allows a relatively 
small Pilot Pressure to regulate a Control Pressure that is many 
times greater. TESCOM air actuated regulators are available with 
ratios from 2:1 to 375:1.

Repeatability
The ability of a Regulator to return to the same Set Pressure after 
being subjected to various flow demands.
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Sensing Element
One of three basic elements of a pressure Regulator. Senses the 
changes in the control pressure (or process line) which allows 
the regulator to react and attempt to return to the original set 
pressure. Diaphragm and Piston are the two most commonly 
used sensing elements.

Set Pressure
The desired operational control pressure for a Regulator, 
normally stated at FIRST FLOW conditions.

Venting Regulator
A pressure reducing Regulator that can vent the Outlet Pressure 
(downstream pressure) when the loading/actuation force is 
decreased. A decrease in Pilot Pressure causes the regulator to vent.
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Before you begin

 WARNING

This device is not intended for or rated for use in hazardous locations.

Please contact your TESCOM representative for Explosion Proof options.

 WARNING

Avoid personal injury or property damage from sudden release of pressure or bursting parts. Before proceeding with any installation 
procedures:

• Always wear protective clothing, gloves, and eyewear to prevent personal injury or property damage.

• Do not remove the ER5000 or any other component of the system while the system is pressurized.

• Disconnect any operating lines providing air pressure, electric power, or a control signal to the ER5000 prior to installation or 
maintenance.

• Use bypass valves or completely shut off the process to isolate the ER5000 and associated equipment from process pressure 
prior to installation or maintenance. Relieve process pressure on both sides of the controller and associated equipment.

• Use lock-out procedures to be sure that the above measures stay in effect while you work on the equipment.

• Check with your process or safety engineer for any additional measures that must be taken to protect against process media dangers.

Do not install, operate, or maintain an ER5000 controller, or any associated equipment, without reading and fully understanding 
the installation guidelines and operating instructions for every component of your application. To avoid personal injury or 
property damage, it is important to carefully read, understand, and follow all contents of this manual, including all safety 
cautions and warnings in the Safety, Installation & Operations Precautions section. If you have any questions about these 
instructions, contact your TESCOM sales office before proceeding.
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 1 Verify your shipment

 CAUTION
If you are replacing an ER3000 in an existing 
application, be sure that you have read the Replacing 
an ER3000 with an ER5000 section before you begin. 

The ER5000 ships with the following included 
items. Verify that all of them are in the box.

1. ER5000 Electronic Pressure Controller

2. 1/2" SAE x 1/8" NPTF adaptor

3. Wiring connectors, pre-installed with strain relief

a. 12-pin MTA connector with 18" / 45.7 cm cable

b. Auxiliary 8-pin MTA connector with  
18" / 45.7 cm cable (“F” models only)

4. USB cable with integrated strain relief

5. CD containing ERTune™ program, device drivers 
and TESCOM’s ER5000 User Manual 

6. Quick Start guide       (continued next page)

  

1 2

3a 3b

4

Figure 6: What’s In The Box

6

5
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Verify your shipment (cont.)

Additional items not included: 

• 24V DC power supply* 

• Setpoint signal source such as an analog output device*, 
PC, or PLC 

• Dome loaded or air actuated pressure regulator*

• Transducer for external feedback*

• 1/8" NPTF fitting for ER5000 Inlet Port

• Instrument grade air or Nitrogen supply — 
120 psig / 8.2 bar maximum

• Computer for setup and tuning

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Items with an asterisk (*) are available from TESCOM.

Tools you will need for the installation:

• Adjustable wrench

• Teflon tape

• Wire strippers

• Wiring connectors such as a terminal strip or wiring nuts

IMPORTANT!IMPORTANT! ERTuneTM software is compatible with the following 
operating systems: Windows XP, Windows Vista, Windows 7, and 
Windows 8.

IMPORTANT!IMPORTANT! Windows 8 users: In order to maintain compatibility 
with previous Windows operating systems, the ERTune™ program uses 
the .NET Framework 3.5, which is not installed by default in Windows 8. 
If you are using Windows 8, you will need to download and install 
.NET Framework 3.5 before installing the ERTune™ program. You may 
also need to disable Driver Signature Enforcement to install the ER5000 
driver. We have provided step-by-step instructions for both these tasks in 
Appendix A: Setting Up The ERTune™ Program On Windows 8 PCs.
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2 Verify the configuration of your application

 WARNING

Improper selection of controllers, regulators, valves or accessories 
can cause death, serious injury and/or property damage.

This section assumes you will be installing the ER5000 
in a typical configuration, which is shown in Figure 7 and 
includes the following components and connections:

• ER5000SI-1 

• Controller is mounted on top of an air actuated 
pressure reducing regulator

• 1/2" SAE x 1/8" NPTF adaptor is used to connect 
controller to regulator   

• External Feedback control mode

• Feedback source is a two-wire 4–20 mA transducer

• Controller is connected to a PC which is running the 
ERTune™ program, connected via USB using the Mini-B 
USB port on the ER5000’s control board

For information on other applications and alternative wiring 
configurations, refer to the Installation Variations section.

ER5000 Supply 
Pressure 
110 psig / 7.5 bar

Transducer

USB Connection

Power 
Supply +24V DC VIOLET

YELLOW ORANGE

+ SUPPLY

+ 
SU

PP
LY

+ 
O

U
TP

U
T

GRAY
TAN

PC

Supply Pressure To Process 

Regulator

GROUND

Adaptor

Figure 7: Typical Application Setup of the ER5000
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3 Verify that all operational requirements 
have been met

• Supply pressure must be clean, dry inert gas or 
instrument grade air that meets the requirements 
of ISA Standard 7.0.01.

• Install filters upstream of the mechanical 
regulator, as well as the ER5000, to prevent 
contamination and excess moisture from entering 
either device.

• Check that all supply lines, fittings, connections, 
filters, valves and gauges have adequate pressure 
ratings for the operating conditions.

• Check that the mechanical regulator’s dome port 
mates correctly with the 1/2" SAE x 1/8" NPTF 
adaptor. Additional fittings may be required.

• Follow the appropriate industrial standards for the 
intended function.

Verify that all safety requirements have been met

Read, and be sure you understand, all warnings and cautions 
in the Safety, Installation & Operations Precautions section.

 WARNING

• Improper selection, improper installation, improper maintenance, 
misuse or abuse of this controller or related accessories can cause 
property damage, serious injury or death.

• Supply pressure must be clean, dry inert gas or air that meets 
the requirements of ISA Standard 7.0.01.

• Severe personal injury or property damage may occur from 
an uncontrolled process if the instrument supply medium is 
not clean, dry, oil free, nonflammable and noncorrosive. While 
use and regular maintenance of a filter that removes particles 
larger than 40 micrometers in diameter will suffice in most 
applications, further filtration down to 10 micrometer particle 
size is recommended. Moisture should be kept to a minimum.
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4 Mount the ER5000 on the regulator 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Your application may require additional fittings. 

Figure 8: Mount the ER5000 on the Regulator
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5 Connect and verify the power supply

The ER5000 requires a 24V DC power supply, such 
as the TESCOM 82575-25 or 82575-50 power supply 
unit.

1. Refer to Table 2 below and Figure 10 on the next 
page to verify correct wiring.

Table 2: Main Cable Wiring for Power Supply 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power Standard 

Installation8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

2. The 12-pin MTA connector comes pre-installed to 
the J3 terminal block. In “F” models, the auxiliary 
8-pin MTA is also pre-installed to the J4 block. 

3. Connect the violet wire (Pin 7) to the +24V DC 
wire from the power supply. 

4. Connect the gray wire (Pin 8) to the ground wire from the 
power supply. 

5. Plug in the power supply.

6. Unscrew and remove the cover of the ER5000 to view the 
control board. Refer to Figure 9.

7. Check that the Power Indicator LED (LED1) is lit, which 
indicates power is being supplied.        (continued next page)

 WARNING

• Select wiring and/or cable glands that are rated for the environment 
of use. Failure to use properly rated wiring and/or cable glands can 
result in personal injury or property damage.

• Wiring connections must be in accordance with local, regional, 
and national codes for any given area. Failure to follow the local, 
regional and national codes could result in personal injury or 
property damage.

• To avoid personal injury resulting from electrical shock, never 
connect the controller or associated equipment to a supply 
source having a voltage greater than the maximum rated 
voltage of this controller or the associated equipment. Make 
sure that the components used in the electronic system are 
compatible with and have the proper voltage rating.
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Connect and verify the power supply (cont.)

8. Check that the “Heartbeat” LED (LED4) blinks, which indicates that the 
embedded controller software is running.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

LED2 (green) and LED3 (amber) respond to data transmission when 
the ER5000 communicates using RS485. These LEDs do not respond to data 
transmission when the ER5000 communicates using USB, and may be on or off 
depending on the specific configuration of your application. They do not need 
to be checked during installation or operation when USB is used.

9. Unplug the power supply.

LED4
“Heartbeat”

(red)
should blink 

on and off at a 
steady rate

LED1
Power Indicator
(red)
should be on 
continuously

Power 
Supply +24V DC VIOLET

GRAY

Controller

Supply Pressure To Process 

Regulator

GROUND

Adaptor

Figure 9: These LEDs Indicate That the ER5000 Has Been 
Successfully Connected to the Power Supply Figure 10: Connect the ER5000 to the Power Supply 
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6 Verify the Jumper J6 configuration

 WARNING

The controller must be disconnected from the 
power supply before any additional wiring or 
change to jumper configuration is performed. 
Do not reconnect the power supply until all 
additional wiring connections have been made 
and are properly installed.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If you are replacing an ER3000 in an existing 
application and wish to continue using your current 
software such as the Windows Tune program, you will 
need to install Jumper J9. The default configuration for 
Jumper J9 is NOT installed. 

With the cover still removed, inspect Jumper J6. 
Refer to Figure 11. 

• For connection to a 4–20 mA transducer, the 
jumper should be installed. 

• For connection to a 1–5V transducer, the jumper 
should NOT be installed.

 

Jumper J9

ER3000 / ER5000 
Mode Select
Configure to ON if you are 
replacing an ER3000 and you 
wish to continue using your 
current software. Jumper is 
OFF by default.

Jumper J6

External Feedback
ON = 4–20 mA
OFF = 1–5V
Jumper shown installed 
for 4–20 mA 
feedback source.

Figure 11: Inspect Configuration of J6 Jumper
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7 Connect the transducer wiring to provide 
a feedback signal

 WARNING

The controller must be disconnected from the 
power supply before any additional wiring or 
change to jumper configuration is performed. 
Do not reconnect the power supply until all 
additional wiring connections have been made 
and are properly installed.

1. Refer to Table 3 below to verify correct wiring.
Table 3: Main Cable Wiring for Power Supply 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power Standard 

Installation8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

2. Connect the orange feedback input wire (Pin 3) to 
the signal output of the transducer, which is Pin 2 
or B on TESCOM transducers.            (continued next page) Figure 12: Connect the ER5000 to External Transducer

Transducer

Power 
Supply +24V DC VIOLET

YELLOW ORANGE

+ SUPPLY

+ 
SU

PP
LY

+ 
O

U
TP

U
T

GRAY
TAN

Supply Pressure To Process 

Regulator

GROUND

Adaptor
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Connect the transducer wiring to provide a 
feedback signal (cont.)

3. Connect the positive wire from the 24V DC power supply 
to the power input of the transducer, which is Pin 1 or A on 
TESCOM transducers.

4. Connect the yellow feedback return wire (Pin 4) to the tan 
analog ground wire (Pin 12). 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

This is necessary to complete the ground circuit for the 
signal from the transducer.

For other applications and wiring configurations, refer to the 
Installation Variations section.
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8 Connect the USB cable

 WARNING

The controller must be disconnected from the 
power supply before any additional wiring or 
change to jumper configuration is performed. 
Do not reconnect the power supply until all 
additional wiring connections have been made 
and are properly installed.

The cable that is included with the ER5000 has a 
standard USB A connector on one end and a 90° 
Mini-B connector on the other. 

1. Slide the Mini-B connector into the left conduit 
port in the base of the ER5000 as shown in 
Figure 13.

2. Thread the cable over the control board and 
plug it into the Mini-B USB port.

3. Remove any excess slack in the cable and secure 
the integrated strain relief into the conduit port.

4. Plug the cable’s USB A connector into the 
computer that will run the ERTune™ program. 

5. Screw the cover back onto the ER5000 until you 
have a tight fit and plug in the power supply.

Integrated USB 
Strain Relief

90° Mini-B Connector

Mini-B Port

Figure 13: Connect the USB Cable
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9 Install the ERTune™ program

IMPORTANT!IMPORTANT! If you are using Windows 8, be sure you 
have read the note at the end of Step 1.

1. You will need to have the following information on 
hand when you start the program for the first time:

• The model number of your ER5000, which is 
located on the label of the controller.

• The series number, part number and serial 
number of the regulator you are using.

• The range of your external feedback transducer.

2. Insert the ER5000 User Support Software 
and Manual CD. The CD menu should open 
automatically. If it does not, navigate to the CD in 
Windows Explorer and click on the .exe file.

3. In the menu, click Install ERTune. When installation 
is complete, click Close.

4. Locate the ERTune program listing in the Start 
menu and open it. 

5. The ER5000 Setup Wizard screens are shown in 
Figure 14. Use the information from Step 1 to 
complete setup. For most screens, the default 
values will be correct for your application.

6. Tune the ER5000 according to the instructions in the The 
ERTune™ Program: Basic Features section.

7. 

1

2

3

4

5

6

Figure 14: Setup Sequence for ERTune™ Software

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If you see the 
Communication Error Window, 
as shown in Figure 15, click 
the Search Ports button. If the 
program does not start, refer to 
the Troubleshooting section.

Figure 15: The Comm Error 
(Communication Error) Window
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10 Connect pressure to the system

 WARNING

•  Never connect the controller or any associated 
equipment to a supply source having a pressure 
greater than the maximum rated pressure of this 
controller or the associated equipment.

• Supply pressure must be clean, dry inert gas or air that 
meets the requirements of ISA Standard 7.0.01.

• The ER5000 exhausts pilot pressure to the surrounding 
atmosphere. When installing this unit in a confined 
area, the exhaust port should be remotely vented to 
a safe location to prevent asphyxiation due to lack of 
Oxygen in the surrounding atmosphere.

Connect the inlet pressure source to the Inlet Port, 
marked IN on the base of the ER5000. Refer to Figure 16.

a. The Exhaust Port vents to atmosphere.

b. The output pressure is the regulated pressure that 
passes through the Outlet Port on the bottom 
of the controller into the dome of the regulator. 
Refer to Dimensions – Top and Bottom View.

(continued next page)

TM

ER5000

TM

ER5000

Pressure Gauge 
Attached to 
Gauge Port

Inlet Pressure 
Connected to 
Inlet Port

Exhaust Port Vents 
to Atmosphere

Figure 16: Pressure Connections
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Connect pressure to the system (cont.)

c. Leave the Gauge Port plugged to prevent leakage, or 
attach a pressure gauge, as shown in Figure 16 on the 
previous page. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

For side-mounted applications, the Gauge Port 
can be used as the outlet. Plug the Outlet Port at the 
bottom of the controller for these applications. 
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11 Start up and tune the system
 WARNING

• Start up sequence for electropneumatic controllers is:
a. Feedback loop must be installed and operational.
b. Electrical power should be applied and system setpoint reduced to 

its lowest pressure output before turning on the pneumatic supply to 
the controller.

c. Apply pressure to the system gradually, avoiding a sudden surge 
of fluid or pressure shock to the equipment in the system.

• To avoid personal injury and property damage, keep hands, tools and 
other objects away when applying power to the controller.

• Changes to the instrument setup may cause changes in the output 
pressure. Depending on the application, these changes may upset process 
control, which may result in personal injury or property damage.

• Most controls in the ERTune™ program operate in real time, and have 
an immediate effect on system performance. Be aware of system 
limitations before you change the settings of a control. Depending on 
the application, these changes may upset the process control, which 
may result in personal injury or property damage.

The ER5000 is now fully installed. Connect the regulator supply 
pressure to the Inlet Port of the regulator.

The system performance can be checked and, if desired, optimized 
further using the ERTune™ program. 

Refer to the The ERTune™ Program: Basic Features section for further 
details and recommendations on tuning the pressure control system.

ER5000 Supply 
Pressure 
110 psig / 7.5 bar

Transducer

USB Connection

Power 
Supply +24V DC VIOLET

YELLOW ORANGE

+ SUPPLY

+ 
SU

PP
LY

+ 
O

U
TP

U
T

GRAY
TAN

PC

Supply Pressure To Process 

Regulator

GROUND

Adaptor

Figure 17: The Completed ER5000 Installation
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Before you begin

 WARNING

This device is not intended for or rated for use in hazardous locations.

Please contact your TESCOM representative for Explosion Proof options.

 WARNING

Avoid personal injury or property damage from sudden release of pressure or bursting parts. Before proceeding with any installation 
procedures:

• Always wear protective clothing, gloves, and eyewear to prevent personal injury or property damage.

• Do not remove the ER5000 or any other component of the system while the system is pressurized.

• Disconnect any operating lines providing air pressure, electric power, or a control signal to the ER5000 prior to installation or 
maintenance.

• Use bypass valves or completely shut off the process to isolate the ER5000 and associated equipment from process pressure 
prior to installation or maintenance. Relieve process pressure on both sides of the controller and associated equipment.

• Use lock-out procedures to be sure that the above measures stay in effect while you work on the equipment.

• Check with your process or safety engineer for any additional measures that must be taken to protect against process media dangers.

Do not install, operate, or maintain an ER5000 controller, or any associated equipment, without reading and fully understanding 
the installation guidelines and operating instructions for every component of your application. To avoid personal injury or 
property damage, it is important to carefully read, understand, and follow all contents of this manual, including all safety 
cautions and warnings in the Safety, Installation & Operations Precautions section. If you have any questions about these 
instructions, contact your TESCOM sales office before proceeding.
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ER5000 Installation Variations — Wiring Diagrams
The ER5000 has a wide range of wiring options, allowing it to be configured for virtually any application requirement. If your 
application calls for a variation on the standard installation, use the diagrams on the following pages to build a complete configuration. 
Note that in your actual application, multiple wires may terminate at the same connection: for example, the violet wire (Pin 7), which is 
the (+) connection to the power source, may also connect directly to the transducer or other external devices.

 

 

 
 

Step 1: Connect the ER5000 to a 
24V DC Power Supply

All wiring configurations begin by 
connecting the ER5000 to a 24V DC 
power supply. The external power 
supply is necessary for the controller to 
operate, and is part of all applications.

Power Supply page 73

 

Step 2: Connect the Setpoint and Feedback Source

Setpoint and feedback sources vary with application. Use the links below to match the setpoint 
and feedback sources for your application to specific wiring diagrams and descriptions in this 
section. Click a page number to go to that diagram; click the BACK button to return to this page.

Setpoint Source

Profile None

Analog (Potentiometer) page 74

Analog (Current/Voltage) page 75

Analog 
(Passive PC or PLC D/A Card)

page 76

Analog 
(Active PC or PLC D/A Card)

page 77

Profile with External Control page 78

Digital (RS232 to RS485 Converter) page 80 

Digital (USB to RS485 Converter) page 81

Digital (RS232 to RS485 Network) page 82

Digital (USB to RS485 Network) page 84

Digital (USB) USB cable

Feedback Source

Internal None

Two Wire Transducer page 86

Three Wire Transducer page 87

Four Wire Transducer page 88 

4–20 mA External Feedback, Floating Input, 
Feedback Signal Monitored by PC or PLC A/D Card page 89

4–20 mA External Feedback, Ground 
Referenced Input, Feedback Signal Monitored 
by PC or PLC A/D Card 

page 90

Two Wire Transducer, PC/PLC Used to Monitor 
Voltage Through ER5000 Internal Resistor page 91

Three Wire Transducer, PC/PLC Used to Monitor 
Voltage Through ER5000 Internal Resistor page 92

Four Wire Transducer, PC/PLC Used to Monitor 
Voltage Through ER5000 Internal Resistor page 93

Switch Feedback Control to a Second 
Feedback Source page 94

Step 3: If Applicable, Connect 
Wiring for Additional Functions

Some applications call for 
monitoring and control 
connections in addition to the 
standard trio of power, setpoint 
and feedback.

Monitoring Additional 
Analog Inputs page 95

Monitoring the Internal 
Sensor, 4–20 mA Output page 96

Monitoring the Internal 
Sensor, 0–10V Output page 97

Digital Outputs page 98

Suspend Mode page 100

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

This section shows variations to the 
typical ER5000 configuration described in the 
Getting Started section.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The (+) and the (-) in the tables and 
figures of this section refer to the differential 
inputs. Both must be connected for the system 
to work properly. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Setpoint is set digitally by writing to 
variable #37 (ID_SETPOINT), using the ERTune™ 
program or your own coding. Refer to the Internal 
Variables and the ER5000 Software Development 
Support sections for more information.
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Voltage/Current Select Jumpers

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If you are replacing an ER3000 in an existing application and 
wish to continue using your current software such as the Windows Tune 
program, you will need to install Jumper J9. The default configuration 
for Jumper J9 is NOT installed. 

Figure 18 shows the voltage/current select jumpers on the 
ER5000. 

Jumpers J5, J6, J14 and J15 are used to select between 4–20 mA 
and 1–5V sources for setpoint, external feedback, auxiliary 
input #1 and auxiliary input #2 respectively. For these jumpers, 
having the jumper installed (ON) configures the controller 
for 4–20 mA input, and having the jumper not installed (OFF) 
configures the controller for 1–5V input.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

0–10V models of the ER5000 do not have these jumpers.

(continued next page)

Figure 18: Jumpers 

Jumper J5

Setpoint

ON = 4–20 mA
OFF = 1–5V

Jumper J1

Ground Filter
Bypass

ON = Signal ground 
connected to power 
ground
OFF = Normal mode, 
no connection 
(recommended)

Jumper J1

Ground Filter
Bypass

ON = Signal ground 
connected to power 
ground
OFF = Normal mode, 
no connection 
(recommended)

Jumper J6

External Feedback

ON = 4–20 mA
OFF = 1–5V

4–20 mA / 1–5V Models

0–10V Models

Jumper J14
Auxiliary Input #1

ON = 4–20 mA
OFF = 1–5V

Jumper J15

Auxiliary Input #2

ON = 4–20 mA
OFF = 1–5V

Jumper J9

ER3000 / ER5000 
Mode Select
ON = ER3000

OFF = ER5000

Jumper J9

ER3000 / ER5000 
Mode Select
ON = ER3000

OFF = ER5000
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The recommended configuration for the Ground Filter Bypass 
jumper (J1) is not installed (OFF). Installing this jumper connects 
signal ground directly to the power supply ground. This 
configuration is rarely used, and should only be considered 
when there is an extreme level of operational noise. Refer to the 
Troubleshooting section before installing this jumper.

LED Indicators

Figure 19 shows the position of the four LED indicators on the 
circuit board of the ER5000. The LED indicators give you a quick 
visual reference to evaluate the status of the controller.

During installation, use LED1 (red) and LED4 (red) to verify that 
you have correctly wired the ER5000 to its power supply. 

If you are communicating via RS485, for example as part of a 
daisychain on a network, LED2 (green) and LED3 (amber) verify 
that the ER5000 is sending and receiving data. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Refer to page 80 through page 84 for correct wiring to 
connect the ER5000 to an RS485 converter.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

LED2 and LED3 respond to data transmission when the 
ER5000 communicates using RS485. These LEDs do not respond to data 
transmission when the ER5000 communicates using USB, and may be on 
or off depending on the specific configuration of your application. They do 
not need to be checked during installation or operation when USB is used.

The LEDs can help you troubleshoot controllers that are not 
functioning properly. For further information, refer to the 
Troubleshooting section.

LED4
“Heartbeat”

(red)
should blink on and off 

at a steady rate

LED1
Power Indicator
(red)
should be on 
continuously

LED3
Receiving Data
(amber)
blinks when ER5000 
is receiving data in 
via RS485

LED2
Sending Data

(green)
blinks when ER5000 

 is sending data 
out via RS485

Figure 19: LED Indicators
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Power Supply Wiring — All Applications 

All ER5000s, regardless of configuration or application, must 
first be wired to a 24V DC power supply, as shown in Figure 20. 

               
POWER
SUPPLY

+24V DC VIOLET

GROUND GRAY

Figure 20: Wiring to 24V DC Power Supply

Refer to Table 4 to verify correct wiring.
Table 4: Wiring to 24V DC Power Supply 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

 WARNING

• Select wiring and/or cable glands that are rated for the environment 
of use. Failure to use properly rated wiring and/or cable glands can 
result in personal injury or property damage.

• Wiring connections must be in accordance with local, regional, 
and national codes for any given area. Failure to follow the local, 
regional and national codes could result in personal injury or 
property damage.

• To avoid personal injury resulting from electrical shock, never 
connect the controller or associated equipment to a supply 
source having a voltage greater than the maximum rated 
voltage of this controller or the associated equipment. Make 
sure that the components used in the electronic system are 
compatible with and have the proper voltage rating.
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Setpoint Wiring Variations

Analog Setpoint Source — Potentiometer

Figure 21 shows correct wiring to provide a 0–5V signal to the 
analog setpoint from a potentiometer. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The 0–1V range can be programmed as a Control Limit for 
1–5V ER5000s. Refer to The Control Limits Panel for more information on 
this feature. 

BLACK

RED

WHITE +5 +10 POWER SUPPLY

10V DC

120V AC

BROWN

TAN

10K

HIGH

WIPER

LOW

Figure 21: Potentiometer Analog Setpoint

 

 WARNING

The controller must be disconnected from the power 
supply before any additional wiring or change to 
jumper configuration is performed. Do not reconnect 
the power supply until all additional wiring connections 
have been made and are properly installed.

Refer to Table 5 to verify correct wiring.

Table 5: Wiring for Potentiometer Analog Setpoint 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The ER5000 cannot directly provide a 0-10V signal. 
An external 10V supply must be used. 
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Setpoint Wiring Variations

Analog Setpoint Source — Current/Voltage

Figure 22 shows how to provide the analog setpoint from an 
active variable current or voltage supply. 

The negative (-) lead of your source connects to the red wire and 
the positive (+) lead connects to the brown wire. 

RED

SIGNAL SOURCE
4–20 mA or 1–5V or 0–10V

BROWN

- OUTPUT

+ OUTPUT

Figure 22: Current/Voltage Analog Setpoint 

 WARNING

The controller must be disconnected from the power 
supply before any additional wiring or change to jumper 
configuration is performed. Do not reconnect the power 
supply until all additional wiring connections have been 
made and are properly installed.

Refer to Table 6 to verify correct wiring.

Table 6: Wiring for Current/Voltage Analog Setpoint 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground
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Setpoint Wiring Variations

Analog Setpoint Source  — Passive PC or PLC D/A Card

Figure 23 shows correct wiring to provide an analog setpoint 
from a PC or PLC D/A card. In this configuration, the ER5000's 
24V DC power supply supplies power to the passive D/A card.

RED OUTPUT

VIOLET

BLACK COMMON

BROWN

PC

Figure 23: Passive PC or PLC D/A Card Analog Setpoint

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 7 to verify correct wiring.

Table 7: Wiring for Passive PC or PLC D/A Card Analog Setpoint 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Check that Jumper J6 (refer to Figure 18) is installed for 
4–20 mA operation, and removed for 1–5V operation. There is no jumper 
on the 0–10V ER5000 models.
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Setpoint Wiring Variations

Analog Setpoint Source  — Active PC or PLC D/A Card

Figure 24 shows correct wiring to provide an analog setpoint 
from a PC or PLC D/A card. In this configuration, the power is 
supplied by the active D/A card.

RED

BROWN

PC

+ OUTPUT

- OUTPUT

Figure 24: Active PC or PLC D/A Card Analog Setpoint

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 8 to verify correct wiring.

Table 8: Wiring for Active PC or PLC D/A Card Analog Setpoint 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Check that Jumper J6 (refer to Figure 18) is installed for 
4–20 mA operation, and removed for 1–5V operation. There is no jumper 
on the 0-10 Volt ER5000 models. 
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Setpoint Wiring Variations

Profile with External Control/Digital Inputs 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

This feature is only available on “F” models of the ER5000.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Jumpers J4 and J5 must be removed for this application. Refer 
to Figure 18. 

Figure 25 shows the wiring configuration for controlling a Profile 
without using a PC. The Profile that has been downloaded into 
the ER5000 in this application can be started or stopped with a 
toggle switch.

WHITE

ORANGE
PROFILE

START/STOP

DIGITAL
INPUT

BROWN

RED
YELLOW

BLACK

AUXILIARY
8-PIN MTA

CONNECTOR

MAIN
12-PIN MTA

CONNECTOR

Figure 25: External Profile Control 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 9 to verify correct wiring.

Table 9: Wiring for Profile Control Using Auxiliary Inputs

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

J4 Pins Wire Color Function

1 brown +aux input #1
2 red -aux input #1
3 orange +aux input #2
4 yellow -aux input #2
5 green suspend control
6 black digital output/board ground
7 blue digital output #1
8 white digital output #2

(continued next page)
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Profile with External Control/Digital Inputs (cont.)

Alternatively, the Digital Input push button can be used if the 
“Digital Input” function has been used within the Profile. This 
allows an operator the flexibility to wait until an event has 
occurred, such as changing to the next device. 

When Analog Input #1 (brown wire, J4 Pin 1) is used as the 
Profile Start/Stop signal, and Analog Input #2 (orange wire, 
J4 Pin 3) is used as the Digital Input signal, the ER5000 allows 
you to adjust the toggle level (also referred to as the trip point) 
of the input. This is the level where the analog input switches 
between a logical 0 and a logical 1.

For example, when a pressure transducer is connected to the 
Digital Input, this feature allows the ER5000 to wait for a specific 
pressure before continuing on in the Profile. 

The ER5000 toggle variables enable this feature. Refer to the 
ER5000 Analog Input Variables section for more information.
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Setpoint Wiring Variations
Digital Setpoint Source  — RS485 Connection, 
RS232 to RS485 Converter (TESCOM Model #85061)

For most applications, the supplied USB cable provides the most 
efficient connection to the PC. The controller can also be wired 
to connect through an RS485 converter, as shown in Figure 26.

VIOLET

- RS485

+24 V DC

+ RS485

GROUND

GREEN

GRAY

BLUE

Figure 26: RS485 Connection (RS232 to RS485 Converter) 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 10 to verify correct wiring.

Table 10: Wiring for RS485 Connection (RS232 to RS485 Converter) 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

The RS232 to RS485 converter requires direct wiring to an 
external power supply, so it must be connected to the ER5000’s 
power supply wiring. The violet wire (Pin 7) connects to the 
+24V DC terminal, and the gray wire (Pin 8) connects to the 
ground terminal.
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Setpoint Wiring Variations
Digital Setpoint Source  — RS485 Connection, 
USB to RS485 Converter (TESCOM Model #82948)

For most applications, the supplied USB cable provides the most 
efficient connection to the PC. The controller can also be wired 
to connect through an RS485 converter, as shown in Figure 27.

TDB(+)
TDA(-)

GREEN

BLUE

Figure 27: RS485 Connection (USB to RS485 Converter) 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 11 to verify correct wiring.

Table 11: Wiring for RS485 Connection (USB to RS485 Converter)

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

The USB to RS485 converter is powered through its USB 
connection, so it does not require direct wiring to a power supply.
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Setpoint Wiring Variations
Digital Setpoint Source  — RS485 Network, 
RS232 to RS485 Converter (TESCOM Model #85061)

The USB protocol isn't networkable, so applications requiring 
multiple controllers must use RS485. RS485, wired through a 
converter as shown in Figure 28, allows for up to 32 ER5000s to 
be daisychained in a network. 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

(continued next page)

GRAY GRAY GRAY

- RS485

+24 V DC

+ RS485

GROUND

GREEN GREEN GREEN

VIOLET VIOLET VIOLET

BLUE BLUE BLUE

Figure 28: Multiple Controllers in an RS485 Network (RS232 to RS485 Converter)
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Digital Setpoint Source  — RS485 Network, 
RS232 to RS485 Converter (TESCOM Model #85061) (cont.)

Each ER5000 in the network must be assigned a unique Node 
Address. All ER5000s are assigned a default Node Address of 250; 
therefore, the addresses must be changed to allow them to all 
communicate on the network. 

The Node Address can be changed as part of the setup 
procedure, or at any time afterwards using the The Configure Tab.

Refer to To set up the ERTune™ program to work with the ER5000 
and The Configure Tab for more information on how to modify 
the Node Address of the ER5000 using the ERTune™ program. 

Repeat this process for each ER5000 in the network. Be sure to 
give each controller a unique Node Address within the network. 
You may leave one ER5000 at the default value. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The number you assign should be lower than 250. Numbers 
higher than 250 will be truncated to the first two digits.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The power supply for your network must be able to provide 
300 mA to each ER5000 in the daisychain.

 

Refer to Table 12 to verify correct wiring.

Table 12: Wiring for Networked Connection (RS232 to RS485 Converter) 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

The RS232 to RS485 converter requires direct wiring to an 
external power supply, so it must be connected to the ER5000’s 
power supply wiring. The violet wire (Pin 7) connects to the 
+24V DC terminal, and the gray wire (Pin 8) connects to the 
ground terminal.
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Setpoint Wiring Variations
Digital Setpoint Source  — RS485 Network, 
USB to RS485 Converter (TESCOM Model #82948) 

The USB protocol isn’t networkable, so applications requiring 
multiple controllers must use RS485. RS485, wired through a 
converter as shown in Figure 29, allows for up to 32 ER5000s to 
be daisychained in a network. 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

(continued next page)

TDB(+)
TDA(-)

GREEN GREEN GREEN

BLUE BLUE BLUE

Figure 29: Multiple Controllers in an RS485 Network (USB to RS485 Converter)
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Digital Setpoint Source  — RS485 Network,
USB to RS485 Converter (TESCOM Model #82948) (cont.)

Each ER5000 in the network must be assigned a unique Node 
Address. All ER5000s are assigned a default Node Address of 250; 
therefore, the addresses must be changed to allow them to all 
communicate on the network. 

The Node Address can be changed as part of the setup 
procedure, or at any time afterwards using the The Configure Tab.

Refer to To set up the ERTune™ program to work with the ER5000 
and The Configure Tab for more information on how to modify 
the Node Address of the ER5000 using the ERTune™ program. 

Repeat this process for each ER5000 in the network. Be sure to 
give each controller a unique Node Address within the network. 
You may leave one ER5000 at the default value. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The number you assign should be lower than 250. Numbers 
higher than 250 will be truncated to the first two digits.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The power supply for your network must be able to provide 
300 mA to each ER5000 in the daisychain.

 

Refer to Table 13 to verify correct wiring.

Table 13: Wiring for Networked Connection (USB to RS485 Converter) 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

The USB to RS485 converter is powered through its USB 
connection, so it does not require direct wiring to a power supply.
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Feedback Wiring Variations

Two Wire Transducer 

The correct wiring for two wire transducers is shown in Figure 30. 

TRANSDUCER

VIOLET

YELLOW

+ SUPPLY

ORANGE

TAN

Figure 30: Two Wire Transducer Wiring

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 14 to verify correct wiring.

Table 14: Wiring for Two Wire Transducer 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Check that Jumper J6 (refer to Figure 18) is installed for 
4–20 mA operation. 

+ OUTPUT
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Feedback Wiring Variations

Three Wire Transducer 

The correct wiring for three wire transducers is shown in Figure 31. 

TRANSDUCER

VIOLET

BLACK

YELLOW

ORANGE

TAN

+ SUPPLY

+ OUTPUT

COMMON

Figure 31: Three Wire Transducer Wiring

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 15 to verify correct wiring.

Table 15: Wiring for Three Wire Transducer 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Check that Jumper J6 (refer to Figure 18) is installed for 
4–20 mA operation, and removed for 1–5V operation. There is no jumper 
on the 0–10V ER5000 models. 
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Feedback Wiring Variations

Four Wire Transducer

The correct wiring for four wire transducers is shown in Figure 32. 

     
+ SUPPLY

GROUND

+ OUTPUT

COMMON

TRANSDUCER

VIOLET

BLACK

YELLOW

ORANGE

Figure 32: Four Wire Transducer Wiring

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 16 to verify correct wiring.

Table 16: Wiring for Four Wire Transducer 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Check that Jumper J6 (refer to Figure 18) is installed for 
4–20 mA operation, and removed for 1–5V operation. There is no jumper 
on the 0–10 Volt ER5000 models. 
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Feedback Wiring Variations

4–20 mA External Feedback, Floating Input, Feedback 
Signal Monitored by PC or PLC A/D Card

Figure 33 shows how the feedback signal can be monitored using 
an A/D card in the PC or a PLC. The feedback signal can, 
alternatively, be monitored through the USB connection between 
the ER5000 and the PC by reading variable #44 (ID_FEEDBACK).

TRANSDUCER
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PC

+ 
O

U
TP

U
T

+ 
SU

PP
LY

Figure 33: Monitor 4–20 mA External Feedback (Floating Input) 

  WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper 
configuration is performed. Do not reconnect the power 
supply until all additional wiring connections have been 
made and are properly installed.

Refer to Table 17 to verify correct wiring.

Table 17: Wiring for Monitoring 4–20 mA External Feedback (Floating Input) 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Check that Jumper J6 (refer to Figure 18) is installed for 
4–20 mA operation. 
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Feedback Wiring Variations

4–20 mA External Feedback, Ground Referenced Input, 
Feedback Signal Monitored by PC or PLC A/D Card 

Figure 34 show how the feedback signal can be monitored 
using an A/D card in the PC or a PLC. The feedback signal can, 
alternatively, be monitored through the USB connection between 
the ER5000 and the PC by reading variable #44 (ID_FEEDBACK).

TRANSDUCER

YELLOW

ORANGE

+ I IN

- I INBLACK

VIOLET

PC

+ SUPPLY

+ OUTPUT

Figure 34: Monitor 4–20 mA External Feedback (Ground Referenced Input) 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 18 to verify correct wiring.

Table 18: Wiring for Monitoring 4–20 mA External Feedback (Ground Referenced Input) 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The wiring shown in Figure 34 is for a two wire 
transducer. Refer to Figure 31 and Figure 32, respectively, for 
correct wiring of three wire and four wire transducers.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Check that Jumper J6 (refer to Figure 18) is installed for 
4–20 mA operation. 
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Feedback Wiring Variations

Two Wire Transducer, PC or PLC A/D Card Used to Monitor 
Voltage Produced by the 4–20 mA External Feedback

Figure 35 shows correct wiring for applications where it is 
necessary to monitor the voltage produced across the ER5000’s 
internal 250Ω resistor, rather than breaking into the 4–20 mA 
loop, to avoid producing ground loops. 

TRANSDUCER

YELLOW

ORANGE

- V IN

+V IN

TAN

VIOLET

PC

+ 
SU

PP
LY

+ 
O

U
TP

U
T

Figure 35: Two Wire Transducer, Monitor Voltage Produced by 4–20 mA Feedback 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

The feedback signal can, alternatively, be monitored 
through the USB connection between the ER5000 and the 
PC by reading variable #44 (ID_FEEDBACK).

Refer to Table 19 for correct wiring.

Table 19: Wiring for Monitoring Voltage from 4–20 mA External Feedback, 
Two Wire Transducer 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Check that Jumper J6 (refer to Figure 18) is installed for 
4–20 mA operation.



ER5000 — 

92

ER5000 — Installation Variations

Feedback Wiring Variations

Three Wire Transducer, PC or PLC A/D Card Used to Monitor 
Voltage Produced by the 4–20 mA External Feedback

Figure 36 shows correct wiring for applications where it is 
necessary to monitor the voltage produced across the ER5000’s 
internal 250Ω resistor, rather than breaking into the 4–20 mA 
loop, to avoid producing ground loops. 
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Figure 36: Three Wire Transducer, Monitor Voltage Produced by 4–20 mA Feedback 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

The feedback signal can, alternatively, be monitored 
through the USB connection between the ER5000 and the 
PC by reading variable #44 (ID_FEEDBACK).

Refer to Table 20 for correct wiring.
Table 20: Wiring for Monitoring Voltage from 4–20 mA External Feedback, 
Three Wire Transducer 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Check that Jumper J6 (refer to Figure 18) is installed for 
4–20 mA operation, and removed for 1–5V operation. There is no 
jumper on the 0–10V ER5000 models. 
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Feedback Wiring Variations

Four Wire Transducer, PC or PLC A/D Card Used to Monitor 
Voltage Produced by the 4–20 mA External Feedback

Figure 37 shows correct wiring for applications where it is 
necessary to monitor the voltage produced across the ER5000’s 
internal 250Ω resistor, rather than breaking into the 4–20 mA 
loop, to avoid producing ground loops. 
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Figure 37: Four Wire Transducer, Monitor Voltage Produced by 4–20 mA Feedback

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

The feedback signal can, alternatively, be monitored 
through the USB connection between the ER5000 and the 
PC by reading variable #44 (ID_FEEDBACK).

Refer to Table 21 for correct wiring.
Table 21: Wiring for Monitoring Voltage from 4–20 mA External Feedback, 
Four Wire Transducer 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Check that Jumper J6 (refer to Figure 18) is installed for 
4–20 mA operation, and removed for 1–5V operation. There is no 
jumper on the 0–10V ER5000 models. 
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Feedback Wiring Variations

Switch Feedback Control to a Second Feedback Source

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

This feature is only available on “F” models of the ER5000.

In “F” model ER5000s, the feedback source can easily be switched 
between two feedback sources. Refer to Table 22 for correct wiring.

Table 22: Wiring For Two Feedback Sources (Two Wire Transducer) 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

J4 Pins Wire Color Function

1 brown +aux input #1
2 red -aux input #1
3 orange +aux input #2
4 yellow -aux input #2
5 green suspend control
6 black digital output/board ground
7 blue digital output #1
8 white digital output #2

(continued next page)
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Figure 38: Switch Between Two External Feedback Sources



ER5000 — 

95

ER5000 — Installation Variations

Switch Feedback Control to a Second Feedback Source (cont.)

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

This feature is part of the The Power User Tab, and is accessed 
in the The Additional ER Settings Panel. It allows the ER5000 to 
maintain optimal control over different pressure ranges.

Transducers recommended for use with the ER5000 have an 
accuracy of 0.1% of their full range, so transducers with a smaller 
range have greater accuracy within that range. 

In an application where the full range is 2,000 psig / 138 bar, but 
where the 0 –500 psig / 0– 35 bar range is critical, a  
single 2,000 psig / 138 bar transducer has an accuracy of  
+/- 2 psig / 0.14 bar across the entire range of the application. 

Switching the feedback between a 500 psig / 35 bar transducer 
for the critical range, and the 2,000 psig / 138 bar transducer for 
the rest of the range, improves the accuracy within the critical 
range to +/- 0.5 psig / 0.03 bar.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The wiring shown in Figure 38 on the previous page is for 
two wire transducers. Refer to Figure 31 and Figure 32, respectively, for 
correct wiring of three wire and four wire transducers.

Wiring Variations for Additional Functions

Monitoring Additional Analog Inputs 

The ER5000 can monitor signals from a number of analog 
sources, as well as monitoring the state of internal variables, 
during normal system operation. This is useful for data 
acquisition to perform trend analysis on the system. The two 
transducers (e.g., with outputs P1 and P2) shown in Figure 38 
on the previous page can be continuously monitored by a PC 
program such as the ERTune™ program.

All ER5000 models can monitor two analog signals: the analog 
setpoint and external feedback. “F” model ER5000s can monitor 
two additional analog signals: the Auxiliary Input #1 and 
Auxiliary Input #2. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Auxiliary Input #2 doubles as the Profile Start/Stop input. If 
you are monitoring this input, you should change its toggle level from 
the default value of 2050 to the maximum value of 4095. This will 
prevent the Profile from running. The toggle level is set by adjusting 
variable #86 (ID_AD_EXTRA2_TOGGLE). Refer to Internal Variables for 
more information.



ER5000 — 

96

ER5000 — Installation Variations

Wiring Variations for Additional Functions

Monitoring the ER5000's Internal Sensor Using the 
Analog Output, 4–20 mA Wiring

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

This feature is only available on “F” models of the ER5000.

The ER5000 provides the capability of monitoring the 
internal sensor through direct wiring to the PC. The internal 
sensor can, alternatively, be monitored through the USB 
or RS485 connection between the ER5000 and the PC by 
reading variable #6 (ID_COMPENSATED_INTERNAL_SENSOR).

PC

PINK

+ I IN

- I IN

VIOLET

Figure 39: Monitor Internal Sensor (4–20 mA Wiring) 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 23 to verify correct wiring.

Table 23: Wiring for Monitoring Internal Sensor (4–20 mA) 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input

4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground
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Wiring Variations for Additional Functions

Monitoring the ER5000's Internal Sensor Using the 
Analog Output, 0–10V Wiring

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

This feature is only available on “F” models of the ER5000.

The ER5000 provides the capability of monitoring the 
internal sensor through direct wiring to the PC. The internal 
sensor can, alternatively, be monitored through the USB 
or RS485 connection between the ER5000 and the PC by 
reading variable #6 (ID_COMPENSATED_INTERNAL_SENSOR).

BLACK

PINK

- V IN

+V IN

PC

Figure 40: Monitor Internal Sensor (0–10V Wiring) 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 24 to verify correct wiring.

Table 24: Wiring for Monitoring Internal Sensor (0–10V) 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground
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Wiring Variations for Additional Functions

Digital Outputs 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

This feature is only available on “F” models of the ER5000.

The ER5000 can provide digital outputs to the rest of the 
system. Refer to Table 25 for correct wiring.

Table 25: Wiring for Digital Outputs 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

J4 Pins Wire Color Function

1 brown +aux input #1
2 red -aux input #1
3 orange +aux input #2
4 yellow -aux input #2
5 green suspend control
6 black digital output/board ground
7 blue digital output #1
8 white digital output #2

(continued next page)

 WARNING
The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.
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Figure 41: ER5000 Digital Outputs 
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Digital Outputs (cont.)

The outputs can be toggled using a PC computer program, or as 
part of a Profile, and can be used to trigger a process in another 
part of the system, such as to turn on an audio or visual alarm or 
to start a conveyor belt.

As shown in Figure 41:

• Output #1 uses an external power supply to switch a 12V DC 
solid state relay, which controls Load 1. 

• Output #2 uses the ER5000’s power supply to switch a 
24V DC relay, which controls Load 2. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Digital Output #1 and Digital Output #2 are Open Collector 
circuits. Refer to the Glossary of Terms section for more information.
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Wiring Variations for Additional Functions

Suspend Mode

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

This feature is only available on “F” models of the ER5000.

Suspend Mode is a new feature for “F” model ER5000s. When 
Suspend Mode is activated, the Inlet and Exhaust valves remain 
fully closed and the PID algorithm is suspended. This ensures a 
completely stable state, with no unwanted response to system 
noise, until Suspend Mode is deactivated. This feature is useful 
for applications, such as calibrating a sensor or detecting a leak, 
where total stability is required.

GREEN

BLACK

AUXILIARY 
8-PIN MTA

CONNECTOR

START/STOP
SWITCH

Figure 42: Suspend Mode 

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Refer to Table 26 for correct wiring.

Table 26: Wiring for Suspend Mode 

J3 Pins Wire Color Function

1 brown +setpoint input
2 red -setpoint input
3 orange +feedback input
4 yellow -feedback input
5 green -RS485 network connection
6 blue +RS485 network connection
7 violet +24V DC power
8 gray 24V return (power ground)
9 white +5V output (5 mA max.)
10 black analog signal/board ground
11 pink analog signal output
12 tan analog signal/board ground

J4 Pins Wire Color Function

1 brown +aux input #1
2 red -aux input #1
3 orange +aux input #2
4 yellow -aux input #2
5 green suspend control
6 black digital output/board ground
7 blue digital output #1
8 white digital output #2
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Where to Find the ERTune™ Program Files on Your PC
The ERTune™ program creates two folders on your C: drive 
during installation.

On PCs running Windows 7, the program files, including the 
program executables, device drivers, support files and reference 
materials, are located at:

 C: -> Program Files (x86) -> Emerson -> ERTune.

On PCs running previous versions of Windows, this is located at:

C: -> Program Files -> Emerson -> ERTune.

A separate folder is created for data files generated by the 
program. On PCs running Windows 7, this is located at:

C: -> Program Data -> Emerson -> ERTune.

On PCs running previous versions of Windows, this is located at:

C: -> Documents and Settings  -> All Users -> Application Data -> Emerson -> ERTune.

This folder is the default location for configuration files, Profiles, 
and data acquisition files. The Windows Navigator window will 
default to this folder. You may save the data files generated by 
your application in another location, if you prefer.
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Installing the ERTune™ Program
The ERTune™ program provides an intuitive interface to 
customize the performance of the ER5000 to meet the specific 
requirements of your application. Using the controls and 
features of the program, you can:

• Manually tune the PID parameters to optimize the response 
of the ER5000.

• Create and download Profiles that guide the ER5000 
through multi-segment sequences of commands.

• Track, save, and review data acquired during tuning sessions 
and normal system operation.

• Configure basic operating parameters and set up the 
ER5000 to monitor and respond to system Control Limits.

• Perform basic troubleshooting.

To install the ERTune™ program

1. Locate the ER5000 User Support Software and Manual CD that 
came with your controller and insert it into your PC. 

2. The CD Menu should open automatically. If it does not, 
navigate to the CD folder in Windows Explorer and click on the 
.exe file.

3. The CD Menu gives you access to the programs and reference 
material on the CD. Click the Install ERTune button. 

4. Follow the steps in the ERTune™ Setup Wizard. When 
Installation is complete, click Close.
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The ER5000 device driver

The ER5000DR device driver is automatically installed in your 
computer during the ERTune program installation.

To install the ER5000 device driver manually 

Some operating system configurations require that device 
drivers be installed manually. If the ER5000DR driver does not 
install automatically, refer to the Troubleshooting section.

To open the ERTune™ program

IMPORTANT!IMPORTANT! The ER5000 controller must be powered up and 
connected to the computer for the ERTune™ program to open.

If the program does not open, and instead you see the Comm Error 
window, refer to If the ERTune™ program does not open.

1. Click the ERTune icon in your START menu. 

OR  
Select Start -> All Programs -> ERTune -> ERTune. Click the menu 
item to open the program.

2. The ERTune™ Welcome screen opens.

(continued next page)
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If this is the first time the ER5000 has been connected to the 
computer, you will be taken through the steps to set up the 
ERTune™ program for your controller and application. The 
program runs the setup sequence every time it communicates 
with an ER5000 that has a new serial number.

To set up the ERTune™ program to work with the ER5000

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Be sure you have the following information in hand:

• The model number of your ER5000, which is located on the 
label on the side of the controller.

• If you are using a TESCOM regulator, the series number, model 
number and serial number of the regulator you are using.

• The range of your external feedback transducer.

1. Click the Next > button. The Node and Model window opens.

2. The Node Address is set to a default of 250. If you are using 
multiple controllers in a daisychain on the same network, 
you must assign each controller a unique Node Address 
during this step. If you are using a single controller, there is 
no need to change the default value.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The maximum value for the Node Address is the default 
of 250. If you assign a different Node Address, use a number that 
is less than 250. Numbers larger than 250 will be truncated to the 
first two digits.

(continued next page)
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3. In the ER Model # drop-down list, select the ER model 
number that matches the model number of your controller.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

All ER5000 model numbers have a "-1" extension. This 
extension has been truncated from the model numbers displayed 

in the list.

4. Click the Next > button. The Control Mode window opens.

5. The Setup Wizard reads and displays the current Control 
Mode for your controller. External Feedback is default for new 
controllers. The other options are Internal Feedback and Cascade. 

6. Select the Control Mode that is appropriate for your 
application and click the Next > button. The Sensor Range 
window opens.

The fields in this window set the default range and the 
unit of measurement for the Plot Screen in the ERTune™ 
program. The default is percentage; you can change this to 
psig or bar or some other unit of measurement. 

 CAUTION
If you change the unit of measurement from percentage, 
be sure your Min and Max values accurately represent the 
specifications for your feedback source.
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7. The label you see for the field set in this window depends on 
the Control Mode you selected in Step 6. 

• If you selected External Feedback control mode, the 
range is labeled Feedback Transducer. Enter the range 
listed in the specifications for the external transducer 
you will be using for your application.

• If you selected Internal Feedback control mode, the 
range is labeled Internal Feedback. Enter the 0–100 psig / 
0–6.9 bar range for the ER5000’s internal sensor.

• If you selected Cascade control mode, the range is 
labeled Feedback Transducer. Enter the range listed in the 
specifications for the external transducer you will be 
using for your application. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

As a general rule, the Internal Feedback range 
should be left at default for Cascade Control Mode, so only 
the External Feedback range is shown in this window. 

8. Click the Next > button. The Mechanical Regulator Information 
window opens.

9. Enter the information for the regulator you are using.

• If you are using a TESCOM regulator, look for its series 
number in the Mechanical Regulator Series drop-down list. 
Also enter the Model Number and Serial Number from the 
regulator. 

• If you are using a regulator from another manufacturer, 
select Other. Also enter the Model Number and Serial Number 
from the regulator. 

• If the ER5000 will not be connected to a regulator, 
select None. 

(continued next page)
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10. Click the Next > button. The PID Download window opens.

The ER5000 software includes PIDs specifically tuned for 
most TESCOM regulators, as well as default PIDs that are 
used if Other or None has been selected. 

11. Click the Yes button to download the PID settings tuned for 
the regulator, or the No button to use the factory settings. 

12. The ERTune™ program opens.

IMPORTANT!IMPORTANT! If the regulator you selected in Step 9 is a 
diaphragm sensed regulator, the Regulator Diaphragm Protection 
window opens. You can configure the ER5000 for diaphragm protection. 

Non-venting regulators, which do not feature a regulator 
vent to exhaust excess system pressure, pose a 
particular challenge in closed loop applications when the 
downstream flow is blocked.

Regulator Diaphragm Protection is designed for 
applications that use a non-venting regulator in a system 
that does not have continuous flow.  It is most beneficial 
for this type of application when the regulator is a metal 
diaphragm sensed regulator.  For more information on this 
feature, refer to A Note Concerning Non-Venting Regulators 
in Closed Loop Applications. 

(continued next page)
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You should consider using this feature if your application meets 
one or both of these conditions:

• The regulator you will be using is a non-venting, metal 
diaphragm sensed regulator.

• The regulator you will be using is non-venting and the 
application is not continuous flow.

To activate Regulator Diaphragm Protection

1. Click the Enable radio button.

2. Enter a value in the Delta Pressure (%) entry field.

The value you enter in the Delta Pressure (%) entry field sets 
the maximum difference between the setpoint and the 
dome pressure of the regulator to which the ER5000 will 
respond, expressed as a percentage of the Sensor Range 
you set in Step 7. 

When Delta Pressure exceeds the value entered in this field, 
the ER5000 stops responding to error. This prevents the 
high differential pressure situations and delayed response 
described in A Note Concerning Non-Venting Regulators in 
Closed Loop Applications. 

3. Click the Finish Button. The ERTune™ program opens.

 CAUTION

Regulator Diaphragm Protection is not recommended for 
applications which do not meet one or both of these conditions.
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If the ERTune™ program does not open

1. The Comm Error window opens.

2. Click the Search Ports button. The ERTune™ program scans all 
COM ports that are in use.

3. If the program does not open, check that the ER5000 is 
powered up and connected. Refer to the Troubleshooting 
section for further steps.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The Comm Error window may appear briefly when the ERTune™ 
program opens during normal operation. Allow 10-20 seconds before 
taking troubleshooting action.

To open the ERTune™ program without a controller connected

1. Select Start -> All Programs -> ERTune -> ERTune Simulator. 
2. Click the menu item. The ERTune™ program opens in 

Simulation Mode. 

 

Figure 43: The Simulation Warning Above The Plot Screen

IMPORTANT!IMPORTANT! When the ERTune™ program is operating in 
Simulation mode, the right side of the The Plot Screen Menu Bar 
displays a "!!!Simulation!!!" warning. Configuration changes you 
make while in Simulation mode have no effect on the controller.

Simulation Mode allows you to interact with all the screens 
and controls of the ERTune™ program. You can build and 
save Profiles which can be saved to the PC for later use. You 
can also access the reference files from the The Diagnostic 
Tools Tab; the Solenoid Leak Test, however, is not functional.

To uninstall the ERTune™ program

1. Select Start -> All Programs -> ERTune -> Uninstall ERTune.

2. Follow the steps in the Uninstall Wizard.
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The ERTune™ Program User Interface 

The Footer Area

The Tab 
Area

The Menu Bar

The Plot Screen 
Variable Controls

The Plot 
Screen

Click a heading to learn more about the features and functions of that area of the interface
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Navigating the ERTune™ User Interface

The Menu Bar

The menu bar displays three menu items on the left. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If the ER5000 does not detect a feedback signal, a warning will 
display on the right side of the menu bar.

The File Menu

The File menu has three commands.
Save Configuration
This command saves the current tuning configuration to a 
text file. The file can be saved anywhere on your computer or 
network and uses the .tun file extension. 
Change Configuration
This command loads a saved configuration (.tun) file into the 
ERTune™ program, and downloads the tuning configuration to 
the ER5000.
Exit
This command exits the program.

The Node Menu
 

The Node menu has two commands.

Node Select
This command opens the Node Select window, which allows you 
to select between ER5000s when you have multiple controllers 
in the same network.

To switch between controllers based on Node Address

1. Select Node -> Node Select. The Node Select window opens.

2. Enter the Node Address of the controller you wish to access.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Individual controllers connected via USB should be at 
the default Node Address of 250, unless this was changed during 
setup. If you have multiple controllers in an RS485 network and 
are not sure of the Node Address for each controller, refer to the 
Search Node command on the next page.

3. Click Select. The ERTune™ program begins communicating 
with the controller at that Node Address, and displays the 
controller’s configuration information.
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Search Node
This command opens the Search Node window. The ERTune™ 
program searches through all 250 Node Addresses and 
generates a list of active nodes.

To select a controller from the list of active nodes

1. Select Node -> Search Node. The Node Select window opens.

 

Figure 44:  
Search Node 
windows for 
single controller, 
and for multiple 
controllers in an 
RS485 network. 

2. The ERTune™ program searches all Node Addresses and 
returns a list of all Addresses that are active.

3. Double-click a Node Address from the generated list to 
select it. The ERTune™ program will begin communicating 
with the controller at that Node Address, and will display its 
configuration information.

The Help Menu

The Help Menu has three commands.

Power User
This command toggles the display of the The Power User Tab 
on and off. The Power User Tab gives you access to advanced 
configuration options. Most applications of the ER5000 do not 
require access to this tab.

To display the Power User Tab

1. Select Help -> Power User. The Power User Tab appears to the 
right of the Diagnostic Tools Tab.

2. Click the Power Users Tab to make it active.

User Manual
This command opens the onscreen version of the User Manual.

About
This command opens the About ERTune™ window, which 
displays the version number for the software.
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The Tab Area
The five tabs on the left of the screen organize the controls and 
entry fields of the ERTune™ program. 

A brief explanation of each tab is given below. Click the tab title 
for detailed information on the features and function of the tab.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The Power User Tab, which gives you access to advanced 
configuration functions that are not required by most applications, is not 
displayed by default. You access it through a command in the Help menu.

The Tuning Tab

This tab displays the controls for choosing the setpoint source 
and for tuning the PID parameters for the ER5000.

The Profile Tab

This tab displays the controls for creating, editing, saving and 
opening Profiles. Profiles are multi-step command sequences for 
the ER5000. 

The Data Tab

This tab displays the controls for collecting, exporting and 
retrieving data generated during tuning or operation of the 
ER5000, using text files with the .dat file extension which can be 
stored on your computer or network.

The Configure Tab

This tab displays the controls for setting and changing basic 
configuration options for the ER5000, including regulator 
information, control mode, calibration, control limits and 
diaphragm protection. 

The Diagnostic Tools Tab

This tab gives you access to the automated Solenoid Valve Leak 
Test and reference materials to help you optimize performance 
and troubleshoot your system.

The Power User Tab

This tab displays the controls for setting and changing advanced 
configuration options for the ER5000. It is not displayed by 
default.

To display the Power User Tab

1. Select Help -> Power User. The Power User Tab appears to the 
right of the Diagnostic Tools Tab.

2. Click the Power Users Tab to make it active.
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The Plot Screen
The Plot Screen gives you a precise visual display of the 
moment-by-moment interaction between setpoint changes and 
the ER5000’s response. Watching changes to PID parameters 
play out in real time makes tuning a more intuitive process.

The main (left) vertical axis of the Plot Screen defaults to the 
feedback range you set during Step 7 of the Setup Process. 

If you add additional variables to the display using The Plot 
Screen Variable Controls, a secondary (right) vertical axis appears 
on the right side of the Plot Screen to track these values.

The horizontal axis defaults to a cycle of 10 seconds. 

You can change the cycle time and the range of values shown in 
the Plot Screen displays using commands in the The Plot Screen 
Menu Bar, or by interacting directly with the Plot Screen using 

your mouse.

You can change the actual range  of values 
tracked by the ERTune™ program by 
changing the range of the Feedback (44) 
variable in  The Plot Screen Variable Controls. 
Refer to page 131.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The Plot Screen has two distinct areas: 
the active area, which is the space within the 
horizontal and vertical axes, and the margin, 
which is the space that displays the ranges and 
units of measurement. The margin area has 
been grayed out in Figure 45 and Figure 47. It is 
not grayed out in the actual program. 

Figure 45: The Plot Screen
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Figure 46: The Active Plot Screen Display

Figure 46 shows all the 
elements of the active Plot 
Screen display as the ER5000 
responds to step changes in 
setpoint (red line).

The response is tracked through 
the feedback (blue line). 

The main (left) vertical axis 
and the horizontal axis have 
been customized using the 
commands in The Plot Screen 
Menus — The Main Axis Menu. 

In this application, the 
ER5000's internal sensor is 
also being tracked directly as 
an Added Variable (green line), 
which has been added to the 
Plot Screen using the The Plot 
Screen Variable Controls. 

The Secondary Axis displays 
the range for the internal 
sensor. The green line tracks 
to this range.
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Resizing the Range Displayed by the Plot Screen Using 
the Mouse

IMPORTANT!IMPORTANT! Changes made to the Plot Screen display using the mouse 
or the Plot Screen menu commands only change the display of the Plot 
Screen. The ERTune™ program continues to track the full range of values for 
setpoint and feedback, even if the Plot Screen does not display them.

To change the actual range of feedback values tracked by the ERTune™ 
program, refer to the task To change the range of feedback values tracked by 
the ERTune™ program.

To toggle the display range of the vertical axis

1. Double-click anywhere within the Plot Screen. This toggles 
the display between a 0% to 100% display and a -20% to 
120% display. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If your application makes full use of the display range, 
the -20% to 120% display makes it easier to visually track setpoints 
and responses near the 0% and 100% levels.

To zoom the vertical axis display

1. Click once within the Plot Screen at the level you want to set 
as the new maximum value, then a second time at the level 
you want to set as the new minimum value.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

You may repeat this process to progressively increase 
the zoom level.

To return the vertical axis display to the default setting

1. Double-click anywhere within the Plot Screen. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

You will return to the default display even if you have 
zoomed multiple times.
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To zoom the display of both the vertical and horizontal axes 

1. Drag a rectangular marquee within the active area of the 
Plot Screen. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The marquee selection must begin and end within the 
active area of the Plot Screen.

2. The Plot Screen zooms to display the marqueed area. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

You may repeat this process to progressively increase 
the zoom level.

Figure 47: Marquee select in the Plot Screen

To return both axes to the default display settings

1. Double-click anywhere within the Plot Screen. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If you have zoomed multiple times using a marquee, 
each double-click will zoom out one level. Continue to double-
click until you reach the default settings.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

You can also zoom both axes in and out using the scroll 
wheel on a three-button mouse. 

IMPORTANT!IMPORTANT! The Plot Screen should be stopped before 
resizing using a marquee selection.
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The Plot Screen Menu Bar
The Plot Screen Menu Bar displays two menus and two buttons.

The Plot Screen Menus — The Main Axis Menu
The commands in this menu control the main (left) vertical and 
horizontal axes of the display.

Time
This command allows you to set the number of seconds in one 
cycle of the Plot Screen. The default value is 10 seconds. The 
maximum cycle time is 1,000 seconds.

Minimum Vertical
This command allows you to set the minimum value of the 
main axis. The default value is 0, or the minimum of the current 
feedback range.

Maximum Vertical
This command allows you to set the maximum value of the main 
axis. The default value is 100, or the maximum of the current 
feedback range.

Rescale Vertical
This command resets the main axis to its original minimum and 
maximum values if they have been changed by the Maximum 
Vertical and/or Minimum Vertical commands. 

The Plot Screen Menus — The Secondary Axis Menu
The commands in this menu control the secondary (right) axis 
of the display. This axis tracks the optional additional variables, 
and displays independently from the main axis. It is not affected 
by changes to the main axis.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The secondary axis appears if you add the optional third 
variable (green line) to the Plot Screen using the The Plot Screen Variable 
Controls. The range for this axis is set when you follow the steps To set or 
change the range for an added variable.

The secondary axis does not display the range of the optional fourth 
variable (black line) which can be added using The Plot Screen Variable 
Controls. This variable will be tracked within the scope of the range for 
the third variable.
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Minimum Vertical
This command allows you to set the minimum value of the 
secondary axis. The default value is 0, or the minimum of the 
range set for the third (green line) variable.

Maximum Vertical
This command allows you to set the maximum value of the 
secondary axis. The default value is 0, or the maximum of the 
range set for the third (green line) variable.

Rescale Vertical
This command resets the secondary axis to its original minimum 
and maximum values if they have been changed by the 
Maximum Vertical and/or Minimum Vertical commands.

The Plot Screen Buttons — The Start Plot/Stop Plot Button
This button toggles to start and stop the real-time display of the 
Plot Screen.

The Plot Screen Buttons — The Print Button
This button takes a snapshot of the current display and opens 
a window which displays the snapshot and the current tuning 
settings. You can print the window or save it as an Excel or PDF file.
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To change the horizontal axis using the Main Axis Menu

1. Select Main Axis -> Time. The Enter Time window opens.  

2. Enter the number of seconds for one cycle of the Plot Screen.

3. Click OK. The Plot Screen rescales to the new cycle time.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If you change the cycle time of the horizontal axis, you 
must use the Time command again if you wish to reset the axis to 
its original cycle time. 

To change the main (left) vertical axis using the Main Axis Menu

1. Select Main Axis -> Minimum Vertical to change the minimum 
value for the main axis display. 

Select Main Axis -> Maximum Vertical to change the maximum 
value for the main axis display. 

     

2. Enter a new value.

3.  Click OK. The display rescales using the new value.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Repeat these steps for both menu items if you wish to set 
new values for both the minimum and maximum of the display. 

To reset the main (left) vertical axis to its original values using 
the Main Axis Menu

1. Select Main Axis -> Rescale Vertical.
2. The main vertical axis of the Plot Screen returns to its 

original display range.

IMPORTANT!IMPORTANT! If you double-click in the Plot Screen after 
changing the vertical axis using the menu commands, the display 
will revert to its toggle between the original 0% to 100% range 
and -20% to 120% range, and you will lose the values you set using 
the commands.
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Figure 48: The Controls and Fields of the Plot Screen Variable Control Panel

 

The Plot Screen Variable Controls
By default, the Plot Screen displays the setpoint and feedback 
values for your application. Using the controls in this area, you 
can track up to two additional variables.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

These variables can also be added to data acquisition files 
generated during the session.

Variable Name
Displays the names of all variables that can be tracked in the Plot Screen display. 
Setpoint and feedback are always tracked. Up to two additional variables can be 
added. You select each variable from the drop-down list. You must click the Plot 
check box for a variable to add it to the Plot Screen display.

Plot Check box
Click the box next to a 
variable to add it to the 
Plot Screen display. This 
also adds the variable 
to any data acquisition 
that takes place while it 
is checked. Uncheck the 
box to remove a variable 
from display and data 
acquisition. You can 
continue to monitor its 
value in the Value field.

Value Field
Displays the current value for a variable and updates 
continually when the Plot Screen is active. Shows 
values even when the Plot check box is unchecked.

Add Variable Button
Adds up to two additional variables, after which it is grayed 
out.

Legend
Shows the color of the line that 
represents each variable in the Plot 
Screen. These colors cannot be 
changed.

Setpoint: red line

Feedback: blue line

First Added Variable: green line

Second Added Variable: black line

Range Buttons
Click these buttons to open windows that allow you to set the 
minimum, maximum and unit of measurement for Feedback 
(44) and any additional variables. This range must accurately 
reflect the actual range of the input source. Refer to the 
IMPORTANT! note on the next page.
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To track an additional variable

1. Click the Add Variable button.

2. A new line is added under Variable Name. 

3. Click the Down Arrow (�) to open the drop-down list.

4. Select the input source you wish to track.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Values for the variable begin displaying immediately in the 
Value field to the right of the variable. These values display whether 
or not the variable is added to the Plot Screen display.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

After you add the second additional variable, the 
Add Variable button is grayed out.

To add a variable to the Plot Screen display 

1. Click the Plot check box to the left of drop-down list. 

2. If this is the first added variable, the secondary axis appears 
on the right side of the Plot Screen. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The first added variable controls the range of the 
secondary (right) axis.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The first added variable appears as a green line. The 
second added variable appears as a black line.

3. The variable displays as a new line in the Plot Screen the 
next time the screen is active.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The variable is also added to data acquisition.

To set or change the range for an added variable

IMPORTANT!IMPORTANT! Changes made using the Range buttons in the Plot 
Screen Variable Controls change the actual range of values tracked 
by the ERTune™ program. Be sure the values you enter are correct for 
your application so that the values the program tracks are an accurate 
representation of system conditions.

1. Click the Range button to the right of drop-down list. The 
Define Variable Range window opens.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The window will be labeled as Variable 1 or Variable 2, 
depending on which added variable range is being defined.

2. Enter values for minimum, maximum and/or units of 
measure. 

3. Click Save.
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To optimize the display when both additional variables have 
been added to the Plot Screen

In many applications, the ranges for the first and second 
additional variable will vary widely. For example, it is a common 
practice to use the first additional variable to display feedback 
from the ER5000's 0–100 psig / 0–6.9 bar internal sensor and 
use the second additional variable to display feedback from an 
external sensor that has a range that is considerably larger, such 
as 0–30,000 psig / 0–2,068 bar.

Since the display for the secondary axis is set by the range and 
unit of measurement for the first additional variable, a display 
based on psig / bar can give unsatisfactory results:

• If the secondary axis is set to the smaller range of the 
internal sensor, feedback from the external sensor will often 
be beyond the maximum of the display.

• If the secondary axis is set to the larger range of the 
external sensor, the feedback from the internal sensor will 
be difficult to differentiate.

 
 
 

 

The "best of both worlds" approach in this scenario is to set the 
range for both variables to 0–100%, rather than using a unit of 
measure based on pressure values. At this setting, both variables 
will display meaningful response curves in the Plot Screen despite 
the difference in their ranges.

The one disadvantage to this approach is that actual pressure 
values must be extrapolated from the percentage values 
generated by and displayed by the ERTune™ program. If it is more 
important for you to track pressure values, set both variables ranges 
to the actual pressure ranges of the sensors. You will be able to track 
the values in real time using the Value Field for each variable 
and by reviewing the data files from data acquisition. You will 
also be able to track the sensor selected as the first additional 
variable visually in the Plot Screen display.
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To change which variable is being tracked

1. Click the Down Arrow (�) to open the drop-down list for the 
additional variable you wish to change.

2. Select a different input source.

IMPORTANT!IMPORTANT! Check that the range is correct so the Plot Screen 
display will be accurate.

3. Click the Range button to the right of drop-down list. The 
Define Variable Range window opens.

4. If appropriate, enter new values for minimum, maximum 
and/or units of measure. 

To remove a variable from the Plot Screen display

1. Uncheck the Plot check box to the left of drop-down list.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

This also removes the variable from any data acquisition 
files generated during this session.

To stop tracking a variable

1. Click the Down Arrow (�) to open the drop-down list for the 
variable you wish to remove.

2. Select Remove Variable. 

To change the secondary axis using the Secondary Axis Menu

IMPORTANT!IMPORTANT! Changes made to the Plot Screen display using the 
Plot Screen menu commands only change the display of the Plot 
Screen. The ERTune™ program continues to track the full range of 
values entered for the variable(s) being tracked.

The secondary axis does not respond to interactions with the mouse.

1. Select Secondary Axis -> Minimum Vertical to change the 
minimum value of the secondary axis. 
Select Secondary Axis -> Maximum Vertical to change the 
maximum value. 

     

2. Enter a new value.
3.  Click OK. The display rescales using the new value.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Repeat these steps for both menu items if you wish to set 
new values for both the minimum and maximum of the display. 

To reset the secondary axis to its original values using the 
Secondary Axis Menu

1. Select Secondary Axis -> Rescale Vertical.
2. The secondary axis returns to its original range.



 

ER5000 — 

131

ER5000 — The ERTune™ Program: Basic Features

To change the range of feedback values tracked by the ERTune™ 
program

IMPORTANT!IMPORTANT! Changes made using the Range buttons in the Plot 
Screen Variable Controls change the actual range of values tracked 
by the ERTune™ program. Be sure the values you enter are correct 
for your application so that the values the program tracks are an 
accurate representation of system conditions.

1. Click the Range button to the right of drop-down list for 
Feedback (44). The Define Feedback Transducer Range screen 
opens.

2. Enter values for minimum, maximum and/or units of 
measure. 

3. Click Save.

To change the display of the main (left) axis to the new range

1. Select Main Axis -> Rescale Vertical.
2. The main axis rescales to display the new range.

IMPORTANT!IMPORTANT! If you double-click in the Plot Screen after 
changing the main axis using the Plot Screen Variable Controls, the 
display will toggle between a display of 0% to 100% and a display of 
-20% to 120% of the new minimum and maximum values.
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The Footer Area
The Footer Area at the bottom of the display screen shows the 
following information:

• Model number of the ER5000

• Serial number of the ER5000

• Node Address of the ER5000

• Model Number of the regulator

• Serial Number of the regulator.

If you have multiple controllers daisychained in a network, the 
information in the footer tells you which controller is currently 
communicating with the ERTune™ program. 



 

ER5000 — 

133

ER5000 — The ERTune™ Program: Basic Features

The Tuning Tab: Controls and Functions for Tuning 
the ER5000
The controls in the Tuning Tab allow you to manually tune the 
ER5000 to achieve optimal performance for your application. 
The first time you open the ERTune™ program, the Tuning Tab 
will display the PID values that were set at the factory or that 
were downloaded to the controller during setup. 

 WARNING

Most controls in the ERTune™ program operate in real time, and 
have an immediate effect on system performance. Be aware of 
system limitations before you change the settings of a control. 
Depending on the application, these changes may upset the process 
control, which may result in personal injury or property damage.
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Tuning the ER5000

Before You Begin

If you are new to PID controllers, be sure that you have read the 
How It Works and Glossary of Terms sections of this manual, as well 
as all cautions and warnings in the Safety, Installation & Operations 
Precautions section, before you begin. 

 WARNING

Most controls in the ERTune™ program operate in real time, and 
have an immediate effect on system performance. Be aware of 
system limitations before you change the settings of a control. 
Depending on the application, these changes may upset the process 
control, which may result in personal injury or property damage.

Tuning inevitably involves some trial and error, and undesired 
effects of the tuning process, such as overshoot, may tax the 
limitations of the system.

You will achieve the best result if you tune the ER5000 at a 
number of different pressure ranges, from maximum system 
limits to minimum anticipated step change. Tuning the ER5000 
at a number of intermediate ranges will give you a fuller picture 

of the controller’s response characteristics. Your final tuning 
should be done using a range that approximates typical 
operating conditions.

Understand the characteristics of your application. This will 
help you select the correct setpoint source for tuning the 
ER5000. Tuning is most commonly performed using a toggled 
step change. You may find that a ramp configuration gives a 
more accurate representation of your system. You can also use 
the Profile Builder to create a more complex series of setpoint 
changes to mimic typical operational conditions.

Understand what your primary goals are for the ER5000’s 
response. Tuning inevitably involves a trade-off between speed 
and stability of response. Typical goals include:

• Fastest response

• Minimizing overshoot

• Minimizing offset

• Minimizing settling time.
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The Setpoint Panel

The fields in this panel allow you to select a setpoint source for 
tuning the ER5000, and set the parameters of the tuning session.

Selecting a Setpoint Source

The top panel of the Tuning Tab allows you to select a setpoint 
source and set the parameters for the tuning.

IMPORTANT!IMPORTANT! The setpoint source you select for tuning is also the 
setpoint source for the controller during standard operation.

To select a setpoint source

1. Click the Down Arrow (�) of the Setpoint Source drop-down list. 
2. Select your setpoint source from the four choices:

Analog Input Setpoint Source
This is the default setting. When this is selected, the ER5000 
accepts setpoint from an analog input (4–20 mA or 1–5V analog 
signal). The ER5000XV-1 model accepts a 0–10V analog signal.

ERTune Program
When this is selected, the ERTune™ program generates setpoints 
based on values you have entered in the program. There are two 
tuning modes: Toggle and Ramp.

Profile
When this is selected, the ER5000 follows the command 
sequence of the Profile that is currently loaded in the ER5000.

External Device Setpoint Source
When this is selected, the ER5000 accepts digital setpoints (USB 
or RS485) from an external device such as a PC. The setpoint 
source must be separate from the PC that is currently running 
the ERTune™ program.

ERTune Program
Toggle Mode Setpoint Source
In Toggle Mode, the ERTune™ program generates step changes 
between two setpoints. Typically, setpoint values are set at 25% 
and 75%. Optimal tuning generally requires multiple sessions at 
different toggle settings.

IMPORTANT!IMPORTANT! Final tuning should always be done at pressures that 
accurately reflect the actual operational conditions of your application.

To set the two setpoint values

1. Enter a minimum and maximum value in the Setpoint 1 and 
Setpoint 2 entry fields. 

You can enter minimum and maximum values in either field.
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To change a setpoint value during tuning

1. Enter a new value in either field. 

This may be done at any time.

The timing of setpoint changes is controlled by the user. 
You may use the radio buttons in the Tuning Tab or the 
Space Bar on your keyboard to activate the toggle function.

To toggle setpoint using the Tuning Tab

1. Click the Start Plot button to activate the Plot Screen.

2. Click the Setpoint 1 or Setpoint 2 radio button.

The Plot Screen steps the setpoint to the value and the 
ER5000 responds to the change.

To toggle setpoint using the Space Bar

1. Click the Start Plot button to activate the Plot Screen.

2. Click in the white space below the Setpoint 1 and Setpoint 2 
entry fields. The words Hit Space Bar to Toggle Appear.

3.  Press the Space Bar. Each press toggles the setpoint value.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If you click outside of the Tuning Tab, for example 
to zoom the Plot Screen, the toggle function is turned off and 
the words “Hit Space Bar to Toggle” disappear. Click below the 
Setpoint fields to restore the setpoint toggle function.

ERTune Program
Ramp Mode Setpoint Source
In Ramp Mode, the ERTune™ program changes the setpoint 
steadily from the current level to a target level over a set period 
of time, generating a gradual rise or fall in the Plot Screen. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The unit of measurement will default to the unit that is 
currently set for the main axis.

To set the target value of a ramp change

1. Enter a value in the Ramp to entry field.

To set the rate of a ramp change

1. Enter a value in the Rate entry field.

To initiate a ramp change

1. Click the Start button.
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Profile Setpoint Source
When this is selected, the ER5000 uses a Profile to control 
setpoint changes. The Profile must be loaded in the controller. 

By default, the Profile that is currently saved on the controller's 
control board is uploaded to the ERTune™ program when the 
program opens. 

• To ensure that the Profile displayed in The Profile Window 
matches the Profile in the controller, click the Upload button 
in The Profile Panel. 

• To load a Profile that was previously saved to the PC, click 
the Open command in The Profile Panel, locate the Profile 
you wish to use, then click the Download button.

• You may also build a Profile using the The Profile Builder 
Panel, then click the Download button.

To tune the ER5000 using a Profile

1. Click the Profile Tab.

2. Load a Profile into the Profile Tab. You may upload it from 
the ER5000, create it using the Profile Builder, or open a 
previously saved Profile.

3. Click the Tuning Tab.

4. Click the Start button.

5. The Profile loads and the Tuning Tab displays the current 
segment, the current state, and the current loop count of 
the Profile as it progresses through the commands. 

The Profile will run until it reaches the End command.

You can view the entire Profile in The Profile Window.

To pause the Profile

1. Click the Stop Button.

To resume running the Profile

1. Click the Resume Button. 



 

ER5000 — 

138

ER5000 — The ERTune™ Program: Basic Features

The PID Control Panel

The controllers in the PID Control Panel give you precise, 
intuitive control over the Proportional, Derivative and Integral 
settings for the ER5000. The ER5000 also features exclusive 
Integral Limits controllers which restrict Integral based on 
specific real-time operational conditions. These allow you to use 
high Integral settings without the risk of excessive overshoot, 
ringing, or windup. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The title of the PID Control Panel displays the current Control 
Mode of the ER5000.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If the ER5000 is set to Cascade Mode, the PID Control Panel 
has separate displays for the internal and external PID controllers. Click 
the Cascade Show External?/Cascade Show Internal? button to toggle 
between these two displays within the panel. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The slider ranges shown for each controller do not correspond 
to any actual mechanical setting within the ER5000. They are set to give 
a level of precision that is appropriate for each term: a wide range for 
Proportional, and a more restrictive range for Integral and Derivative. 

The green overlays highlight recommended ranges for each 
controller. Most applications for the ER5000 will fall within these 
ranges. Staying within the recommended ranges minimizes 
tuning effects, such as overshoot and windup, which can prove 
daunting to inexperienced users. However, if your application 
calls for settings that fall outside the highlighted ranges, you 
should not hesitate to use them.

(continued next page)
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The ER5000 can be reset to the default PID settings at any time. 

To reset the ER5000 to its default PID settings

1. Click the Set Defaults button. The Set Defaults window opens.

2. Check or uncheck the boxes to select any or all of the 
control settings to be reset.

3. Click OK. The selected settings will return to their default values.

The ERTune™ program was designed to make the tuning 
process intuitive for all users. If you are new to PID tuning, 
be sure you have read the Tuning a PID Controller section. The 
Rules of Thumb for each component can be applied as specific 
recommendations, or tips, for how to use each controller in the 
PID Control Panel.

The Proportional Controller

This slider sets the Proportional term for the ER5000. 

Proportional Tuning Tips
• In most applications, the first step in tuning is to see how 

high the Proportional term can be increased.

• The primary goal when increasing Proportional is to 
minimize the response time.

• Proportional should be gradually increased until overshoot 
or ringing become too pronounced. Then it should be 
stepped back until they are minimized.

• PID parameters tend to be logarithmic. This means that 
small changes in the slider setting usually result in no 
appreciable change to the response curve. A set of values 
such as 200, 400, 800, 1200, 2000 will allow you to quickly 
find the applicable range for your Proportional term. You 
can fine tune from there.

• For most applications, the Proportional term has the 
greatest effect on performance. 

• Proportional is a direct function of the current error, so its 
value approaches zero as error approaches zero.
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The Derivative Controller

This slider sets the Derivative term for the ER5000.

Derivative Tuning Tips

• In most tuning applications, the Derivative term is first 
zeroed out so the effect of adjustments to the Proportional 
term is not damped. It is then added gradually.

• In most tuning applications, the Derivative term will fall in 
the range of 25–250.

• The Derivative term should be increased to reduce 
instability, such as overshoot or ringing, and to decrease 
settling time.

• If increasing Derivative term slows down rise time without 
diminishing overshoot/ringing, the Proportional term 
should be decreased instead.

• Paradoxically, higher Derivative settings can make some 
systems unstable by increasing sensitivity to transient 
changes (noise) in the operating environment. If you note 
that the controller is not remaining in Stable State after 
setpoint has been reached, try reducing the Derivative term.

The Integral Controller

This slider sets the Integral term for the ER5000.

Integral Tuning Tips
• In most tuning applications, the Integral term is first zeroed 

out so the effect of adjustments to the Proportional term is 
not amplified. It is then added gradually.

• In most tuning applications, the Integral term will fall in the 
range of 50-800.

• PID parameters tend to be logarithmic. This means that 
small changes in the slider setting usually result in no 
appreciable change to the response curve. A set of values 
such as 100, 200, 400, 800, will allow you to quickly find the 
applicable range for your Integral term. You can fine tune 
from there.

• The Integral Limits Controllers allow you to set a higher 
Integral term, then limit undesired effects using these 
additional controls. This allows you to accelerate the 
response while minimizing unwanted side effects.



 

ER5000 — 

141

ER5000 — The ERTune™ Program: Basic Features

The Integral Limits Controllers

These three controllers allow you to set a higher Integral term 
while minimizing detrimental effects such as windup.

Maximum
This controller sets the limit for positive errors (setpoint minus 
feedback is positive) that can accumulate for the Integral term 
during error correction, typically after a change from a low to a 
high setpoint. The Integral will stop adding positive value when 
it reaches the level set by this limit, regardless of feedback.

Minimum
This controller sets the limit for negative errors (setpoint minus 
feedback is negative) that can accumulate for the Integral term 
during error correction, typically after a change from a high 
to a low setpoint. The Integral will stop subtracting negative 
value when it reaches the level set by this limit, regardless of 
feedback.

Deadband
This controller sets a range around the setpoint where the 
Integral term will not respond to error.

The deadband range is measured as a percentage of the full 
range of the feedback. For example, a setting of one percent 
(1%) creates a deadband range from one percent above (+1%) to 
one percent below (-1%) the setpoint.

The Deadband controller prevents system noise, or a series of 
small transient errors, from accumulating in the Integral term 
to the point that the ER5000 is activated. In some applications, 
accumulation of these errors can cause the ER5000 to be in a 
perpetual state of activation.
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A Typical Step Tuning Example
This section is an example of the proper sequence of steps to 
follow, as well as typical settings, for a step tuning session for 
the ER5000.

IMPORTANT!IMPORTANT! The PID settings downloaded during setup provide 
excellent control for most applications. In some cases, minor 
adjustments may be required to optimize performance. Refer to Table 1: 
Effect of P, I and D Increases on Response Curve of Controller in the How It 
Works section for basic tips on adjusting the PID settings.

If, however, you find that these minor adjustments do not give 
satisfactory results,  zero out the controllers, refer to the Rules of Thumb 
for PID Tuning as well as the detailed Tuning Tips beginning on page 139, 
and build your own configuration "from scratch." You can return to the 
default settings at any time by following the steps To reset the ER5000 to 
its default PID settings.

Tuning is a gradual process, with repeated cycles of changing 
settings and monitoring system response. Most of the steps in 
this example will be repeated multiple times until the desired 
response curve is seen in the Plot Screen.

The Initial Settings
• Setpoint Source:  ERTune™ Program
• Type:  Toggle
• Setpoint 1:  25%
• Setpoint 2:  75%
• Proportional:  400
• Derivative:  0
• Integral:  0
• Maximum:  0
• Minimum:  0
• Deadband:  0

To activate the Plot Screen

1. Click the Start Plot Button. 

To toggle the setpoint

1. Click in the white space below the Setpoint 1 and Setpoint 2 
entry fields. The words Hit Space Bar to Toggle appear.

2. Press the Space Bar. Each press toggles the setpoint.

(continued next page)
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To set the Proportional Term

1. Toggle the setpoint. 

2. Note rise time, stability, and settling time of the ER5000. 
The response of the ER5000 should mirror the setpoint step 
change as closely as possible.

Figure 49: Typical Tuning: Initial PID Settings
Response is stable, but rise time and settling time are slow. Increasing Proportional 

will speed up response time.

3. Move the Proportional control slider to the right, or enter 
a higher number in the field next to the slider. Refer to 
Proportional Tuning Tips.

4. Continue to toggle the setpoint. Note the change in the 
response of the ER5000.

5. Continue to move the Proportional control slider right until 
you begin to see excessive overshoot/ringing, or until there 
is no appreciable improvement in rise time.

Figure 50: Typical Tuning: Proportional Increased
Response is faster, but overshoot and ringing are at unacceptable levels.

(continued next page)



 

ER5000 — 

144

ER5000 — The ERTune™ Program: Basic Features

6. Step back the Proportional slider to minimize unwanted 
effects.

Figure 51: Typical Tuning: Proportional Optimized
Overall, the response is quick and stable. Derivative will be used to correct the small 

amount of residual overshoot.

To add the Derivative Term

1. Move the Derivative slider slightly to the right, or enter a 
higher number in the field next to the slider.

2. Toggle the setpoint and note the change to the response 
curve. 

Figure 52: Typical Tuning: Derivative Added
A higher Derivative setting will completely correct the overshoot.

(continued next page)
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3. Continue to increase the Derivative term until you have 
stabilized the response.

Figure 53: Typical Tuning: Critically Damped
Response is now both quick and stable.

4. Repeat the process until you note the effects of overdamping. 

Figure 54: Typical Tuning: Overdamped Response
A Derivative setting that is too high results in a slower rise time. 

5. Step back the Derivative slider, or enter a smaller number in 
the field, until instability reaches unacceptable levels.

(continued next page)
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To add the Integral Term

1. Move the Integral slider to the right, or enter a value of 50.

2. Toggle the setpoint and note the change in system 
response. 

3. Increase Integral until you note the signs of instability. 

4. Step back the Integral and begin using the Integral Limits.

To limit the effect of the Integral Term using the Integral Limits

1. Increase magnification in the Plot Screen to zoom in closely 
at the level of Setpoint 2 (75%). Refer to Resizing the Range 
Displayed by the Plot Screen Using the Mouse.

2. Toggle the setpoint to Setpoint 2. 

3. Wait for the system to reach a stable state. 

4. Look closely for offset between the setpoint and feedback 
level once the system reaches stable state.

Figure 55: Typical Tuning: Offset at Setpoint 2
Stable state is reached slightly below the setpoint.

(continued next page)
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5. If there is offset, move the Maximum slider slightly to the 
right, to increase the level of positive Integral that will be 
allowed to accumulate.  

6. Repeat until the offset is eliminated.

Figure 56: Typical Tuning: Offset Corrected
Even at a high level of magnification, there is now no offset between setpoint and 

feedback.

7. When you are satisfied with the response at Setpoint 2, 
return to default zoom in the Plot Screen. Then zoom in 
closely at the level of Setpoint 1 (25%).

8. Look closely for offset between the setpoint and feedback 
level once the system reaches stable state. If there is offset, 
move the Minimum slider slightly to the left, to increase the 
level of negative Integral that will be allowed to accumulate.  

9. Repeat until the offset is eliminated.

Figure 57: Typical Tuning: Checking for Offset at Setpoint 1
As was true for Setpoint 2, some offset correction will be required at Setpoint 1.

10. When you are satisfied with the response at Setpoint 1, return 
to default zoom in the Plot Screen.  Toggle between the two 
setpoints and note stability, accuracy and response time.  

(continued next page)
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11. If you note a delayed response to a change in setpoint, 
or that the changes to Integral Limits have re-introduced 
overshoot that slowly settles into setpoint, these are signs 
of Integral windup. You will need to decrease the Integral 
Limits to correct this.

Figure 58: Typical Tuning: Integral Windup
Overshoot with a pronounced settling time in a previously stable response is a sign that the 

Integral Limit levels are too high, allowing Integral windup to affect the response.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If you find that you cannot eliminate offset and windup without 
increasing instability, you will need to reduce the Integral Term.

To add Integral Deadband

1. Allow the ER5000 to cycle through the Plot Screen several 
times at the current setpoint. 

2. If the ER5000 activates repeatedly while the setpoint 
remains at the same level, move the Deadband slider to the 
right, or enter a number in the field next to the slider.

3. Increase the value slowly, in one percent increments, until 
the unwanted activation stops.
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Cascade Tuning
Cascade tuning is complex and can prove daunting for the 
inexperienced user, and should only be attempted if the system 
is persistently unstable.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

When the ER5000 is set to Cascade Mode, the PID Control 
Panel has separate displays for the internal and external PID controllers. 
Click the Cascade Show External?/Cascade Show Internal? button to 
toggle between these two displays within the panel.

Cascade Tuning Tips

• Cascade Mode typically only requires tuning for the PID 
settings of the External loop.

• For proper operation in Cascade Mode, the defaults for 
the Integral Limits of the External loop are: Maximum: 
32767; Minimum: 0. These settings are optimal for most 
applications and should not be changed unless you have 
verified that this is required by your application.

• Increasing the Integral Term of the External PID generally 
has a more pronounced effect on rise time than increasing 
the Proportional Term. In some applications, increasing the 
Proportional Term of the External PID in Cascade tuning 
may slow down rise time. 

• Alternate between increasing the Integral Term, then 
increasing the Proportional Term, until you begin to see 
instability in the response of the ER5000. At this point, back 
off the values slightly.

• The Derivative Term should be added gradually to the 
External PID after Integral and Proportional values have 
been set. Unwanted effects from too much Derivative may 
develop quickly, so be prepared to step back the Derivative 
slider as soon as they are noted.
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The Profile Tab: Creating Multi-Step Command 
Sequences
Profiles are multi-step command sequences for the ER5000. 
They require no previous programming experience on the part 
of the user to create, and guide the ER5000 through everything 
from a simple start/stop operation to a sequence of setpoint 
changes that can include up to one hundred command lines and 
control loops that can run indefinitely.

The Profile Builder Panel in the Profile Tab provides a simple, 
intuitive interface for creating and editing Profiles. Profiles 
are built one command line (called a segment) at a time. 
Commands are chosen from a drop-down list; the three most 
commonly-used commands (Ramp, Dwell and Step) can also 
be quickly selected by clicking a button. Parameters for each 
command are set using simple text entry fields and select lists. 

Completed Profiles are downloaded to the control board of the 
ER5000. They can also be saved to external text files for future use. 
Profiles can be uploaded from the ER5000 or opened from the 
PC in the ERTune™ program and used as the setpoint source for 
tuning the controller.
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       The Panels and Windows of the Profile Tab

The Profile Panel has buttons for printing the current Profile, 
uploading from or downloading to the ER5000, and opening 
from or saving to the PC. The Profile Window displays the 
command lines (segments) of the Profile. Selecting a segment 
in the Profile Window opens it for editing in the Profile Builder 
Panel.

The Profile Builder Panel has a drop-down select list of 
commands, as well as three "hot" buttons to quickly select the 
three most commonly-used commands. Parameters for each 
command are displayed and edited in the Segment Types 
Window, and the segment can be inserted into the Profile, 
modified, or deleted using buttons in the Segment Editor 
Window. 

The Profile Comment Block Panel allows you to add a 
comment which is included as part of the Profile when it is 
downloaded or saved.

Profile Builder
Holds "hot buttons" to select 

commands, as well as the 
Segment Types Window.

Profile Panel
Holds buttons for printing, 

uploading and saving, as well as 
the Profile Window.

Profile Window
Displays the command lines 
(segments) of the Profile in 

sequence. Click a command to 
select it for modification. Scroll 

bars appear when a Profile is 
longer than 10 segments.

Segment Types Window
When a command is selected 
from the "hot buttons" or the 

drop-down list, the parameters 
appear here for modification. 
Click the Modify button in the 

Segment Editor to update the 
Profile.

Segment Editor
Holds buttons to insert, 

update or delete segments.

Profile Comment Block
You can add one comment to a 
Profile. Press the Tab key when 
you are done so the comment 

will the saved and downloaded 
with the Profile.
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The Profile Panel

The top panel of the Profile Tab shows the currently loaded 
Profile. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If no Profile has been built for the ER5000, the default Profile 
will show a single END command in the Profile window. Every Profile 
must include the END command as its final segment. 

 CAUTION

A Profile will not run the ER5000 until it has been downloaded to 
the controller’s control board. Unlike most fields and controls in 
the ERTune™ program, the Profile Builder does not have real-time 
control over the ER5000.

A Profile must be downloaded or saved when it is complete! 
Otherwise it will be deleted when you exit the ERTune™ program. 
Profiles are only stored in your computer’s short term memory until 
they are downloaded or saved.

The Profile Window
The Profile Window shows the command lines of the currently 
loaded Profile. Selecting a command in the window opens it for 
editing in the Profile Builder. Scroll bars appear when the line 
count goes beyond the frame of the window.

There are also five buttons in the panel:

Print
Prints the contents of the Profile Window.

Upload
Loads the Profile from the control board of the ER5000 into the 
Profile Window.

Download
Downloads the contents of the Profile Window to the control 
board of the ER5000.

Open
Opens a previously saved Profile. Profiles are saved in a text 
format with the .sav file extension.

Save
Saves the contents of the Profile Window to a text file. Profiles 
are saved to the PC with the .sav file extension.
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The Profile Builder Panel

The middle panel of the Profile Tab holds the tools for adding, 
modifying, and deleting segments of the Profile. 

Figure 59: Drop-down Command Lists for “S” Model and “F” Model ER5000s

The Segment Types Window
The Segment Types Window displays the editing fields for a 
command when it is selected from the drop-down list or by 
clicking one of the three buttons. The Ramp, Dwell and Step 
buttons allow you to quickly select the three most commonly 
used commands.

The Segment Editor Window
There are three buttons in this window.

Insert
This button adds a new segment to the Profile. The new 
segment is added above the segment that is currently selected 
in the Profile Window.

Modify
This button saves the edits made to an existing segment.

IMPORTANT!IMPORTANT! You must click this button to update the Profile.

Delete
This button deletes the currently selected segment in the Profile 
Window.
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 CAUTION

If you are modifying a Profile that has been previously downloaded 
or saved, you must click the Download button to download the updated 
Profile to the ER5000, or the Save button to save the updated Profile 
to the PC, when all modifications have been done. Otherwise, the 
updates will be lost when you close the ERTune™ program. 

A Profile must be downloaded to the ER5000 if you wish to use it to 
run the controller. 

To add a command line (segment) to a Profile

1. Click within the Profile Window to select a segment of the 
current Profile. The new command will be added BEFORE 
the segment you select.

2. Select a command from the drop-down Segment Types list.

OR

Click the Ramp, Dwell or Step button. These three commands, 
which are the most commonly used Profile segments, can 
be accessed directly using these "hot" buttons.

3. The Segment Types Window displays the entry fields to set 
the parameter values for the command.

4. Enter or select the values for the command.

5. Click the Insert Button. The command is added to the Profile 
Window above the selected segment.

To modify a segment in a Profile

1. Click within the Profile Window to select the segment. It 
may be necessary to scroll to locate the segment line. 

2. The parameter entry fields will appear in the Segment Type 
Window with the current values displayed.

3. Enter the new values.

4. Click the Modify Button. The segment will be updated with 
the new values.

To delete a segment from a Profile
1. Click within the Profile Window to select the segment. It 

may be necessary to scroll to locate the segment line.

2. Click the Delete Button. The segment is immediately deleted.

To add comments to a Profile
1. Enter comments in the Profile Comments Block. The 

Comments Block is the bottom panel of the Profile Tab.

2. Press the Tab key when you are done.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Each Profile has a single comment block to hold all comments.

To use a Profile to control the ER5000
1. Check that the Profile has been downloaded to the controller.

2. Select Profile in the Setpoint Source field of the Tuning Tab. 
Refer to Selecting a Setpoint Source.

3. Click the Start button
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The Commands in the Profile Builder

IMPORTANT!IMPORTANT! The unit of measurement for the setpoint value parameter 
in these commands matches the unit of measurement for feedback set 
during Step 7 of the Setup Process, or when you followed the steps To 
change the range of feedback values tracked by the ERTune™ program.

Step
Initiates a step setpoint change to the value entered in the 
Setpoint to Step to entry field. 

Ramp
Initiates a ramp setpoint change to the value entered in the 
Setpoint to Ramp to entry field. The duration, in seconds, of the 
ramp-up or ramp-down is set in the Time to Ramp (sec) entry field.

Dwell
Maintains the current setpoint for the amount of time, in 
seconds, entered in the Time to Dwell (sec) entry field.

Loop
Allows the Profile to loop multiple times through a sequence of 
command segments, beginning with the segment entered in 
the Loop to Segment entry field.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The command sequence will run the number of times entered 
in the Number of Loops entry field. A value of 0 in the Number of Loops 
entry field will cause the loop to run perpetually.
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Delta
Initiates a step setpoint change by the value entered in the Delta 
Amount entry field. The value entered in the Delta Amount entry 
field can be positive or negative.

The Delta command can be used together with the Loop 
command as a programming shortcut to move the setpoint to a 
target level through a series of smaller setpoint step changes.

In the Profile below, segments 3 through 5 combine to increase 
pressure from 50 psig to 70 psig over four loops, and segments 
6 through 8 return the pressure to 50 psig over four loops.

Change Variable
Sets the value of an internal variable of the ER5000, selected 
from the Variable drop-down list, to the value entered in the Value 
entry field.

Refer to the Internal Variables section for a table listing all of 
the ER5000’s internal variables, as well as detailed information 
about the settings for the most commonly used variables.
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Additional Commands Available For “F” Model ER5000s

Soak
Pauses the Profile while the ER5000 responds to a step setpoint 
change, then dwells at that setpoint for a specified amount of 
time. The Error Band (psig) field sets the range (+/-) around the 
setpoint. When feedback falls within this range, the ER5000 
maintains the new setpoint for the amount of time, in seconds, 
entered in the Time to Soak (sec) entry field.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The Dwell command counts off the specified time regardless of 
ER5000 response. The Soak command accounts for rise and settling time 
before counting off the specified time.

If
Allows the Profile to respond to the current state of the system. 
Checks whether a parameter of the current system status matches 
the condition specified in the Condition, Operator and Value fields.

• If the condition is TRUE, the next command in the Profile is 
executed.

• If the condition is FALSE, the next command is skipped.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

To execute a multi-line command sequence based on the same 
condition, use the If command together with the Goto command, which 
is described on the next page.
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Goto
Moves the Profile to the command segment entered in the Go to 
Segment entry field.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

To execute a multi-line command sequence based on the same 
condition, use the Goto command together with the If command, which 
is described on the previous page. 

In the Profile shown to the right, the If and Goto commands are used to 
break the loop and end the session.
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Digital Output (ER Outputs are Ports 3 & 4)
Sends a signal to trigger a process in another part of the system. 
Refer to the Digital Outputs wiring configuration for an example 
of an ER5000 with digital outputs. 

Enter the ER5000 port number for the digital output in the 
Port Number field, and the ER5000 port state (0 => open circuit, 
1=> closed circuit) in the Port State entry field.

Digital Input (ER input is Port 3)
Pauses the Profile until the specified input is set to the specified 
state. Refer to the Profile with External Control/Digital Inputs 
wiring configuration for an example of an ER5000 with digital 
inputs. 

Enter the ER5000 port number for the digital input in the 
Port Number field, and the ER5000 port state (0 => open circuit, 
1=> closed circuit) in the Port State entry field.
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The Data Tab
The ER5000 can save data acquired during tuning sessions, as 
well as during normal operations after a triggering event has 
taken place. Data is written to a delimited text file that is saved 
to your computer and uses the .dat file extension.

You can open previously acquired data files in the Plot 
Screen to review previous tuning sessions or monitor system 
performance. The saved .dat file can also be opened in a text 
editor or imported into a spreadsheet or database.

The ER5000 automatically adds a header to the file that includes 
date, time, sample rate, and collection time.

The default variables that are collected are setpoint and 
feedback. Using controls in the The Plot Screen Variable Controls 
and The Power User Tab, you can add up to four additional 
variables to data acquisition, as described on the next page.
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To add a variable using the The Plot Screen Variable Controls

1. Click the Add Variable button.

2. A new line is added under Variable Name. 

3. Click the Down Arrow (�) to open the drop-down list.

4. Select the input source you wish to track.

5. Click the Plot check box to the left of the drop-down list to 
add the variable to data acquisition.

IMPORTANT!IMPORTANT! Data will not be collected for this variable unless 
the Plot check box is checked.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

This will also add the variable to the Plot Screen display.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

You may repeat this process to add a second additional 
variable.

To set or change the range for an added variable

IMPORTANT!IMPORTANT! Changes made using the Range buttons in the Plot 
Screen Variable Controls change the actual range of values tracked 
by the ERTune™ program. Be sure the values you enter are correct for 
your application so that the values the program tracks are an accurate 
representation of system conditions.

1. Click the Range button to the right of drop-down list. The 
Define Variable Range window opens.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The window will be labeled as Variable 1 or Variable 2, 
depending on which added variable range is being defined.

2. Enter values for minimum, maximum and/or units of measure. 

3. Click Save.

To add a variable using the Power User Tab

1. Select Help -> Power User to display The Power User Tab.

2. Click the tab to make it active.

3. In the The Read/Write Panel, select a variable from the  
Read/Write Variable drop-down list.

4. Click the Add to DAQ check box.
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The Acquisition Panel

The entry fields in this panel allow you to set the sample rate 
and collection time for the data file.

The Sample Rate entry field accepts any multiple of 0.1 seconds. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

While the minimum sample rate the ERTune™ program can 
process is 0.1 seconds, your actual sampling rate may be limited by the 
processing power of the PC that is running the program.

The Collection Time entry field sets the default timeframe for 
data collection. The maximum value you can enter is 31,536,000 
seconds, which is 1 year.

To control data collection manually

1. Enter a value in the Collection Time entry field that is 
considerably higher than your intended collection 
time. This will prevent the program from automatically 
terminating data collection prematurely.

2. Click the Start DAQ button. The button changes to display 
Stop DAQ and data acquisition begins.

3. Click the button again when you wish to end collection. The 
button returns to a display of Start DAQ and the data file is 
saved to the PC.
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The Output Panel

The entry fields in the Output Panel set the parameters of the 
.dat file.

IMPORTANT!IMPORTANT! Enter the file name, data delimiter and comment block 
before you begin data collection. The data file is saved automatically 
when the Collection Time ends.

Output File
The Output File entry fields set the file name of the data file. The 
extension is appended automatically.

Browse Button
The Browse button opens a Windows Explorer window to select 
the folder where the data file will be stored. You can also change 
the file name here.

Delimiter
The Delimiter drop-down list sets the delimiter that separates the 
data columns in the file. Select Space, Comma or Tab.

DAQ Comment Block
Add comments in this entry field. They will be added to the 
header of the data file.

Plot File Button
The Plot File button allows you to retrieve a previously stored 
data file and display it on the Plot Screen, as described in To view 
an acquired data file.

Start DAQ Button
The Start DAQ button starts data acquisition.
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Collecting and Reviewing Data

IMPORTANT!IMPORTANT! Enter the file name, data delimiter and comment block 
before you begin data collection. The data file is saved automatically 
when the Collection Time ends.

 CAUTION
If you have previously saved .dat files and do not wish to overwrite 
them, check that the file name and/or folder location is different 
from the previously saved files. 

If you click the Start DAQ button when the file name and folder 
location matches the name and location of a previously saved file, 
the Overwrite window opens to warn you.

Click the Yes button to proceed with the data acquisition and 
overwrite the previously saved file. 

Click the No button to cancel the acquisition so that you can change 
the file name and/or folder location of the new file. 

To start data collection

1. Click the Start DAQ button. The button changes to display 
Stop DAQ.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The Plot Screen does not have to be active for data to be 
collected.

To stop data collection

1. Allow the specified Collection Time to elapse.

OR

Click the Stop DAQ button at any time.

2. The data file is automatically saved to the folder you have 
specified.
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To view an acquired data file

1. Click the Plot File button. A Windows Explorer window opens.
2. Navigate to the .dat file you wish to view and double-click it, 

or click the OPEN button.
3. The data file opens in the Plot Screen window.

The file opens as a single, static image of the complete data 
set. You can use the mouse techniques described in Resizing 
the Range Displayed by the Plot Screen Using the Mouse to 
view different sections of the data at close range.

Figure 60: An Acquired Data File Opened in the Plot Screen
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The Triggers Panel

Data acquisition can also be triggered automatically by events 
that happen during normal system operation. The fields in this 
panel allow you to select from a number of input sources for the 
ER5000 to monitor, and to set minimum and/or maximum value 
triggers to initiate data acquisition.

 CAUTION

You must enter a value that is within the limits for the input source 
you choose to complete the activation of the trigger. The limits are:

Internal Pressure:    0 – 100 psig

Pressure (FB): -12.12% – 111.97%

Error (SP-FB):   0.00% – 100%

If you enter a value below the Less than (minimum) or above the 
Greater Than (maximum), the trigger will revert to Disabled. 

Be aware that the display will not revert until you leave the Data Tab.

To collect data based on a triggered event

1. In the Triggers Panel, click the check box next to the input 
source or sources you wish to track.

IMPORTANT!IMPORTANT! You must click the check box to activate the 
input source. The entry fields will accept entries when the box is 
unchecked, but will revert to Disabled when you leave the Data Tab.

2. Set a Less than (minimum) value and/or Greater than 
(maximum) value that will trigger an event.

IMPORTANT!IMPORTANT! When you click in an entry field, the limit is 
displayed as the default value. You must change this value, or the 
field will revert to Disabled when you click out of it.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

You may select any or all of the sources, and set 
minimum and/or maximum values for each. Data collection will 
begin when any of the triggering values is reached.

To activate data collection based on a triggered event

1. Check that you have selected all events and set all values 
that you wish to act as triggers for data collection.

2. Enter a value in the Collection Time entry field that is 
considerably higher than your intended collection 
time. This will prevent the program from automatically 
terminating data collection prematurely.

(continued next page)
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3. Click the Start DAQ button. Triggering is activated and the 
button changes to display Stop DAQ.

4. When any of the triggering conditions is met, data acquisition 
will begin. The program alerts you that acquisition has been 
activated with a message in the Menu Bar.

To deactivate data collection based on a triggered event

1. Click the Stop DAQ button.

To remove a triggered event from data collection

1. In the Triggers Panel, uncheck the box next to the input 
source you no longer wish to track.
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The Configure Tab
The entry fields and list fields in this tab allow you to modify the 
system configurations of the ER5000 to match the requirements 
of your application.

 WARNING

Most controls in the ERTune™ program operate in real time, and 
have an immediate effect on system performance. Be aware of 
system limitations before you change the settings of a control. 
Depending on the application, these changes may upset the process 
control, which may result in personal injury or property damage.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Be aware of the operational and mechanical limitations of your 
system when using the fields in this tab. The fields have real-time control 
over the ER5000. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

After you enter a new value in an entry field, press the Tab key 
to download the new value to the controller. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Selections made from drop-down lists become active as soon 
as the mouse button is released.
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The Mechanical Regulator Panel

The fields in this panel display the series number, model number 
and serial number for the regulator that the ER5000 controls. 
You enter this information during setup.

If you change regulators, you can update the information here.

To change the Regulator Series

1. Click the Down Arrow (�) of the Mechanical Regulator Series drop-
down list. 

2. Select a different TESCOM series number, or, if appropriate, 
select Other or None.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The ERTune™ program automatically checks for PIDs 
included with the software that are optimized for the Regulator 
Series you have selected. If you click the Yes button, the new 
settings will be downloaded to the ER5000. If you click the No 
button, the current settings will be used.

To change the regulator model number or serial number

1. Enter a new value in the Model Number or Serial Number entry 
field and press the Tab key.

The ER Settings Panel

The fields in this panel control the basic configuration of the ER5000.

ER Model #
This drop-down list allows you to change the model number of 
the ER5000. 

Control Mode
This drop-down list allows you to change the feedback source 
(Control Mode) for the ER5000. 

To change the Control Mode of the ER5000

1. Click the Down Arrow (�) of the Control Mode drop-down list. 
Select Internal Feedback, External Feedback, or Cascade.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

You may need to tune the ER5000 after changing the 
Control Mode. Refer to The Tuning Tab: Controls and Functions for 
Tuning the ER5000 for procedures and tips for tuning the ER5000.
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ER Node
This entry field allows you to change the Node Address of the 
ER5000.

To change the Node Address of the ER5000

1. Enter a new value in the Address entry field and press the Tab key.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The maximum value that can be used for a Node 
Address is 250. Any value higher than 250 that is entered in this 
field will be truncated to the first two digits.

2. The Comm Error Window opens and the ER5000 scans 
through the Node Addresses until it reaches the new 
address you have entered. The window then closes and the 
new node address is registered.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The Serial Number of the ER Series controller cannot be 
changed from the Configure tab. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The Version Number refers to the current version of the 
ER5000 internal software. It cannot be changed.

Calibration
These entry fields allow for fine adjustment of the ER5000. 
The defaults meet the needs of most applications. However, 
your application may require an adjustment of these values to 
compensate for external transducers which require calibration, 
such as a transducer that has been over pressurized.

To change the calibration of the ER5000

1. Enter a new value in the Zero % and/or Span % entry fields 
and press the Tab key.
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The Control Limits Panel

The entry fields in this panel allow you to set system Control 
Limits which the ER5000 will then monitor.

The ER5000, in addition to its control function, can also be 
configured to monitor when operational or mechanical limits of 
the system have been exceeded. When the controller detects a 
signal that exceeds a set limit, it activates the internal solenoid 
valves to reach one of three Control Limit Conditions:

• Inlet Closed/Exhaust Closed

• Inlet Closed/Exhaust Open

• Inlet Open/Exhaust Closed

The Control Limit Conditions provide added security in the 
event of a system failure such as broken transducer wiring, lack 
of supply pressure, or pipe ruptures. 

The default Condition is Inlet Closed/Exhaust Open, which 
ensures that a pressure reducing system will be vented if a limit 
is exceeded. If your application uses a non-venting regulator, 
refer to A Note Concerning Non-Venting Regulators in Closed Loop 
Applications if you intend to use the ER5000 in this condition.

  CAUTION
The Control Limits feature provides an additional level of system 
monitoring. Activation indicates a potential problem, but will 
not, by itself, prevent problems from occurring. It should not be 
considered to be a safety mechanism, nor is it intended to be a 
safety feature or pressure limiting device.

The entry fields in this panel allow you to monitor any or all of five 
ER5000 internal variables, and to set minimum and/or maximum 
limits to be tracked for each source. If multiple variables are 
selected the ER5000 will respond when any of the assigned 
sources exceeds the set limit.

(continued next page)
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To add a Control Limit for the ER5000 to monitor

1. Enter a value in the Min or Max entry field of the variable that 
you wish to monitor and press the Tab key. 

 CAUTION

You must enter a value that is within the limits for the variable 
you choose in order to activate it as a Control Limit. 

The limits are:

Analog Setpoint:  -12.12% – 111.97%

Internal Sensor: -12.12% – 111.97%

External Sensor: -12.12% – 111.97%

Internal Sensor: -12.12% – 111.97%

Inner Error: -124.08% – 124.08%

Outer Error: -124.08% – 124.08%

If you enter a value below the Min or above the Max limit, the 
filed will immediately revert to the default value, and will 
revert to Disabled when you click out of the field. 

2. To monitor for both minimum and maximum limits, enter 
values in both fields.

IMPORTANT!IMPORTANT! When you click in an entry field, the limit is 
displayed as the default value. You must change this value, or the 
field will revert to Disabled when you click out of it.

To remove a Control Limit

1. Enter a value that is beyond the limit for that field. It will 
revert to Disabled when you click out of the field.

To remove all Control Limits

1. Click the Disable All button.

To change the Control Limit Condition

1. Select a different condition from the drop-down list.
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The Diaphragm Protection Panel

The entry fields in this panel allow you to enable Diaphragm 
Protection for the connected regulator.

Non-venting regulators, which do not feature a regulator vent to 
exhaust excess system pressure, pose a particular challenge in 
closed loop applications when the downstream flow is blocked.

Regulator Diaphragm Protection is designed for applications 
that use a non-venting regulator in a system that does not have 
continuous flow.  It is most beneficial for this type of application 
when the regulator is a metal diaphragm sensed regulator.  For 
more information on this feature, refer to A Note Concerning 
Non-Venting Regulators in Closed Loop Applications. 

You should consider using this feature if your application meets 
one or both of these conditions:

• The regulator you will be using is a non-venting, metal 
diaphragm sensed regulator.

• The regulator you will be using is non-venting and the 
application is not continuous flow.

 CAUTION

Regulator Diaphragm Protection is not recommended for 
applications which do not meet one or both of these conditions.

To activate Regulator Diaphragm Protection

1. Click the Enable radio button.

2. Enter a value in the Delta Pressure (%) entry field.

The value you enter in the Delta Pressure (%) entry field sets 
the maximum difference between the setpoint and the 
dome pressure of the regulator to which the ER5000 will 
respond, expressed as a percentage of the Sensor Range 
you set in Step 7. 

When Delta Pressure exceeds the value entered in this field, 
the ER5000 stops responding to error. This prevents the 
high differential pressure situations and delayed response 
described in A Note Concerning Non-Venting Regulators in 
Closed Loop Applications. 

To deactivate Regulator Diaphragm Protection

1. Click the Disabled radio button.
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The Diagnostic Tools Tab
The buttons on this panel open troubleshooting tools and 
additional reference files for the ER5000.

The System Check Panel
The Open button in this panel opens a presentation that offers 
additional information and tips on checking operational 
parameters for the ER5000.

The ER Solenoid Leak Test Panel
The Start button in this panel initiates a solenoid valve leak test.

 CAUTION
This procedure will hold the ER5000 Inlet Valve open, resulting in full 
inlet pressure at the ER5000 Outlet Port. The test should be performed 
with the Outlet Port plugged and isolated from the regulator. If it is not 
possible to isolate the Outlet Port of the ER5000, take steps to prevent 
system overpressurization.

To perform a solenoid valve leak test

1. Click the Start button. The first screen opens.
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2. To continue to the test, click the YES, CONTINUE TEST 
button. To abort the test so you can institute safety 
procedures, click the NO, ABORT TEST button.

3. The second screen opens. This is an additional caution 
screen.

4. To continue to the test, click the YES, CONTINUE TEST 
button. To abort the test so you can institute safety 
procedures, click the NO, ABORT TEST button.

5. The third screen opens. Verify that the Outlet Port of the 
ER5000 is plugged and a minimum of 100 psig / 6.9 bar inlet 
pressure is being applied to the Inlet Port of the controller.

6. Click the Start button to start the test.

7. The test begins. The program first tests the Inlet Valve.

8. The program then tests the Outlet (Exhaust) Valve.

The Solenoid Leak Test reads variable #44 (ID_FEEDBACK), 
which during the test is the feedback from the ER5000's 
0–100 psig / 0–6.9 bar internal sensor. The feedback is 
measured in "counts", which are units of 0.03 psig / 0.002 bar 
between a minimum value of 400 (0%) and a maximum value 
of 3700 (100%). 

(continued next page)
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For the Inlet Valve test, the controller exhausts all internal 
pressure to start with a reading of 400 (the initial value 
for your controller may vary slightly from 400), and 
monitors feedback for 30 seconds. If the reading rises by 
more than 10 counts from the initial value during the test 
period, that means that the Inlet Valve has allowed in more 
than 0.3 psig / 0.02 bar of pressure, which is considered an 
Inlet Valve failure.

For the Outlet Valve test, the controller opens the Inlet 
Valve and lets in pressure up to the maximum reading of 
3700 counts (again, the initial value for your controller 
may vary slightly from 3700). If the reading falls by more 
than 10 counts over the next 30 seconds, that means more 
than 0.3 psig / 0.02 bar of pressure has escaped, which is 
considered an Outlet Valve failure. 

9. The program returns the results.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If the ER5000 is connected to a regulator when the Solenoid 
Leak Test is run and a failure is recorded, it may indicate a leak in the 
regulator or the adaptor fitting. The test should be re-run with the 
ER5000 isolated from the regulator and the Outlet Port plugged.

The Regulator Leak Check Panel

The Open button in this panel opens a presentation that takes 
you through a step-by-step process to test a typical mechanical 
regulator for pressure leaks.

The Tuning Tips Panel

The Open button in this panel opens a presentation that offers 
additional information and tips for tuning the ER5000.
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The Power User Tab
This tab gives you access to advanced configuration options. 
Most applications of the ER5000 do not require access to this tab.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The entry fields in this tab control the basic operational 
parameters of the ER5000. The default values should not be changed if 
you are not certain how this will effect the performance of the controller.

To display the Power User Tab

1. Select Help -> Power User. The Power User Tab appears to the 
right of the Diagnostic Tools Tab.

2. Click the Power User Tab to make it active.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

On most screens, you will need to scroll to reach all of 
the panels in the Power User Tab.
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The Additional ER Settings Panel

External Feedback Source
This field controls which feedback source displays in the Plot 
Screen when you have wired the ER5000 for multiple feedback 
sources. Refer to Switch Feedback Control to a Second Feedback 
Source for an example of this wiring configuration.

• External Feedback is the transducer connected to the ER5000 
through the orange wire (J3 Pin 3) in the standard 12-pin 
MTA connector. 

• Extra Input #1 is the transducer connected to the ER5000 
through the brown wire (J4 Pin 4) in the auxiliary 8-pin MTA 
connector.

To switch the external feedback source

1. Click the radio button next the source you wish to track.

IMPORTANT!IMPORTANT! Refer to the steps To change the display of the main 
(left) axis to the new range after you change the feedback source, to 
be sure the ERTune™ program is tracking the correct range of values 
for the new source.

Setpoint to 0 on Power Up
The ER5000 stores the last registered setpoint when it powers 
down, and powers up at the setpoint stored in internal memory. 
Some applications may require a zero-pressure startup. This 
field allows you to set that default for the controller.

To enable Setpoint to 0 on Power Up

1. Click the Enable radio button.
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The Read/Write Panel

The entry fields in this panel allow you to monitor and modify 
the internal variables of the ER5000. Refer to the Internal 
Variables section for a complete list of the ER5000’s internal 
variables, as well as descriptions of the most commonly used 
variables.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

There are two read/write windows in the panel. Each includes 
an Add to DAQ check box. When this box is checked, the variable in the 
window is added to data files acquired during this session. This allows 
you to add up to two additional variables to your data acquisition. 

To check the value of an Internal Variable

1. Click the Down Arrow (�) to open the Variable drop-down list.
2. Select from the list of variables. 
3. The Variable ID number displays to the right of the list. The 

variable value displays in the Raw entry field. The list to the 
right indicates whether it is a signed or an unsigned value.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Values are grayed out when Read is checked.

To modify the value of an Internal Variable

1. Click the Write radio button. The entry fields become active.
2. Enter a new value and press the Tab key.
3. To switch between signed and unsigned value, select from 

the Signed drop-down list.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The internal variables control the basic operational 
parameters of the ER5000. The default values should not 
be changed if you are not certain how this will effect the 
performance of the controller. 

Variables listed as READ ONLY cannot be changed from within the 
ERTune™ program.

To add a variable to data acquisition

1. Click the Add to DAQ check box.

To remove a variable from data acquisition

1. Uncheck the Add to DAQ check box.
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The Solenoid Settings Panel

The entry fields in this panel allow you to change the minimum 
pulse width for the inlet and exhaust solenoid valves in the 
ER5000. This setting changes the responsiveness of the controller.

Minimum Pulse Width
These entry fields set the minimum value of the pulse width for the 
Inlet and Exhaust Valves. Factory defaults are displayed to the right. 

Increasing the value in the Minimum Pulse Width field increases the 
baseline (non-activated) pulse width being sent to the valves. 
This results in a lower threshold of activation when an error is 
generated, and an increase in the responsiveness of the ER5000. 

 CAUTION

Setting the minimum pulse width too high can cause the ER5000 
to activate in response to transient errors which do not require 
correction. Setting it too low may delay response to error.

 CAUTION

These settings have an immediate and profound effect on the 
performance of the ER5000. The default settings are optimal for 
most applications, and should not be changed if you are not certain 
how this will effect the performance of the controller.

 CAUTION

It is strongly recommended that changes to the default values 
be made incrementally, by a value of 1, and that performance be 
monitored once the change is in effect.

Normal/Reverse
This field allows you to reverse the normal response of the 
ER5000, with the exhaust opening instead of the inlet and vice 
versa. 

This allows you to configure the ER5000 for use in applications 
such as regulating cooling air for temperature, where increasing 
flow reduces the temperature (feedback).
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The Algorithm Update Rate Panel

This field allows you to change the rate at which the ER5000 
operates. 

By default, the ER5000 monitors feedback and generates a 
response every 25ms. Some applications provide feedback 
at a considerably slower rate, and may see a performance 
improvement if the Algorithm Update Rate is set higher, which 
slows the response of the ER5000.

To change the Algorithm Update Rate

1. Move the slider control to the right, or enter a multiple of 
25ms in the entry field, to increase the rate.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The default rate is 25ms, which is also the minimum 
value the field will accept. Changes to this field must be made in 
increments of 25ms.

 CAUTION

The Algorithm Update Rate controls the speed of response of the 
ER5000. The default values should not be changed if you are not 
certain how this will effect the performance of the controller.
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The Pulse Mode Panel

The fields in this panel give you precise control over how the 
ER5000 responds to errors which fall within the deadband set 
by the Integral Limits - Deadband controller. Refer to The Tuning 
Tab: Controls and Functions for Tuning the ER5000 for more 
information on the PID controllers.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The Integral Deadband must be set to a value greater than zero 
for Pulse Mode to function.

The purpose of Integral Deadband is to prevent small, transient 
errors from “charging up” the Integral term and inducing 
windup or oscillations during steady state.

Pulse mode responds to errors within the Integral Deadband 
range with short, pulsed, activation of the solenoid valves. 
These pulsed responses continue until feedback falls within the 
Pulse Mode Deadband range (in effect, the deadband within the 
deadband). When feedback falls within this inner deadband, the 
solenoid valves remain closed.

To enable Pulse Mode

1. Click the Enable radio button.

To disable Pulse Mode

1. Click the Disable radio button.

There are three parameters you can set for Pulse Mode.

Period
This is the number of times the ER5000 cycles through the 
Algorithm Update before pulsing. The default Algorithm Update 
rate is 25ms.

Width
This field determines how long the solenoid valve remains 
open during a pulse. Increasing the value increases the level of 
response for each pulse.



 

ER5000 — 

184

ER5000 — The ERTune™ Program: Power User

Deadband
This is the Pulse Width Deadband, the “deadband within a 
deadband” of the Integral Deadband. When feedback falls 
within this inner range, Pulse Mode stops responding.

Pulse Width Deadband is set to a much smaller level than 
Integral Deadband, allowing the ER5000 to respond to a very 
small level or error.

• Integral Deadband is generally set within a range of 0–0.5% 
of feedback. 

• Pulse Width Deadband is set by counts of error. Each count 
equates to .03% of feedback. Pulse deadband is generally 
set at 1–3 counts, which equates to .03–.09% of feedback.

To change the Pulse Width settings

1. Enter a new value in the Period, Width, or Deadband field and 
press the Tab key.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The values should be changed incrementally until the 
desired response is achieved.
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The Power User Tab: The Password Panel
The fields in this panel allow you to add password protection to 
the ERTune™ program. When enabled, the ERTune™ program will 
require the user to enter a password before it will open.

 CAUTION

If you forget your password
Contact TESCOM customer support. They will give you a password 
to unlock the program. You should immediately change your 
password, using the supplied password as your current password.

To enable password protection

1. Click the Enable radio button. The Enter Password screen opens.

2. Enter the password and click the Verify button. The Validate 
Password screen opens.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The password can be any combination of alphanumeric 
characters, and can be of any length.

3. Re-enter the password and click the Verify button. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The passwords must match.

4. The password will become effective the next time the 
ERTune™ program is opened. The Enter Password window 
opens instead.

 

5.  Enter the password and click the Verify button.

To disable password protection

1. Click the Disable radio button.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The current password is stored in memory and will 
become active the next time you click the Enable radio button.

To change the current password

1. Click the Change button. The Change Password screen opens.

2. Enter the current password, to verify that you are 
authorized to change it, and click the Verify button.

3. Enter the new password in the Password field.

4. Re-enter the new password in the Verify Password field and 
click the Change button.
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ER5000 Communication Requirements

The ER5000 communicates via USB or RS485.

• USB communication takes place via a direct connection 
between the Mini-B USB port on the ER5000’s control board 
and a USB terminal on the PC. A USB cable with a Mini-B 
plug configured to fit inside the controller is included with 
your purchase. Refer to the Getting Started section for 
proper installation. 

The required USB driver can be found on the ER5000 User 
Support Software and Manual CD or online at the TESCOM 
website. The driver should install during standard setup of 
the ERTune™ program. To install the driver manually, follow 
the steps in To install the ER5000 device driver manually.

USB communication takes place through a USB cable and 
requires no additional wiring.

• RS485 communication requires a converter, which must 
be purchased separately. The ER5000 can communicate 
using a USB to RS485 converter (TESCOM model # 82948) 

or an RS232 to RS485 (TESCOM model # 85061) converter. 
RS485 must be used if your application calls for multiple 
controllers and you wish to daisychain them in the same 
network. You can link up to 32 ER5000s in a single network.

Wiring diagrams for RS485 communication can be found 
in this manual beginning on page 80. There are diagrams 
for both USB to RS485 and RS232 to RS485 converters, as 
well as single and multiple controller applications. Refer to 
the RS485 Communication section for third party converter 
requirements.

ER5000 Software Development Support

The ERTune™ program, which is included with your purchase, is 
designed to provide an effective and intuitive interface for setup 
and tuning of the ER5000. The software can provide setpoints 
during operation, and includes a basic programming language 
for creating multi-step Profiles that guide the controller through 
complex setpoint sequences. Refer to The Profile Panel section 
for more information on this feature.
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You can also develop your own process control software to 
communicate with the ER5000. Typically, programmers use 
the Windows-based DLL to communicate with the ER5000. A 
32-bit version of the dll, along with the source code, can be 
found on the ER5000 User Support Software and Manual CD. 

Windows Programming Examples

Sample programs that illustrate the use of the ER5000 Dynamic 
Link Library (ER5000DLL.dll) are provided in the Resources 
section of the  ER5000 User Support Software and Manual CD in 
the following languages:

• LabVIEW

• VB.NET

• C

• C# 

To view the sample programs

1. Locate the ER5000 User Support Software and Manual CD 
that came with your controller and insert it into your PC. 

2. The CD Menu should open automatically. If it does not, 
navigate to the CD folder in Windows Explorer and click on 
the .exe file.

3. The CD Menu gives you access to the programs and 
reference material on the CD. Click the Resources button.

4. Click the Sample Programs button.

5. Click the button for the language example you wish to view.
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Accessing The Windows DLL File

The TESCOM protocol, ER5000DLL.dll, allows easy access to the 
ER5000 from a PC for Windows based programs.  The protocol 
is available as a 32-bit DLL (Dynamic Link Library). The DLL 
downloads to the PC as part of the ERTune™ program installation, 
and can also be found on the ER5000 User Support Software and 
Manual CD.

To locate and use the Windows DLL file

1. If you have not already installed the ERTune™ program, 
locate the ER5000 User Support Software and Manual CD 
that came with your controller and insert it into your PC. 

2. The CD Menu should open automatically. If it does not, 
navigate to the CD folder in Windows Explorer and click on 
the .exe file.

3. The CD Menu gives you access to the programs and 
reference material on the CD. Click the Resources button.

4. Click the ER5000DLL button. This opens the folder on the 
CD that contains the ER5000DLL.dll file. You can open the 
file, or save it to a location that is accessible to the custom 
program being developed.
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The TESCOM Protocol

Not all systems run on a Windows-compatible platform. 
TESCOM provides two resources for non-typical applications, 
which can be found in the Protocol section of the  ER5000 User 
Support Software and Manual CD: 

• A written description of the software protocol, called 
PROTOCOL.pdf.

• The uncompiled protocol source code. 

Step by step instructions to view the code are on the next page 
of this section. 

Direct access to the uncompiled source code allows 
programmers to alter and recompile the TESCOM Protocol in a 
format suitable for your system. 

The TESCOM protocol software includes the following six functions:

Startup
This function must be called during program initialization 
before any other function to allow PC initialization, including 
the serial port. It does not send any data to the ER5000. This 
function needs to be called only once.

WriteNetVar
This function is used to write to any of the ER5000 internal 
variables.

ReadNetVar
This function is used to read any of the ER5000 internal 
variables.

WriteProfileSegment
This function is used to write to any of the ER5000 Profile 
commands (segments). Refer to The Profile Panel section for 
more information on the Profile commands.

ReadProfileSegment
This function is used to read any of the ER5000 Profile 
commands (segments). Refer to The Profile Panel section for 
more information on the Profile commands.

Shutdown
This function must be called before exiting the program. It 
does not send any data to the ER5000. This function needs to 
be called only once.
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To view the source code of the TESCOM protocol file

1. Locate the ER5000 User Support Software and Manual CD 
that came with your controller and insert it into your PC. 

2. The CD Menu should open automatically. If it does not, 
navigate to the CD folder in Windows Explorer and click on 
the .exe file.

3. The CD Menu gives you access to the programs and 
reference material on the CD. Click the Resources button.

4. Click the Protocol button.

5. Click the Source Code button to directly access the code, or 
the Protocol.pdf button to open the PDF file which describes 
the protocol.
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Installation

Where to Find the ERTune™ Program Files  on Your PC

The ERTune™ program creates two folders on your C: drive 
during installation.

On PCs running Windows 7, the program files, including the 
program executables, device drivers, support files and reference 
materials, are located at:

C: -> Program Files (x86) -> Emerson -> ERTune.

On PCs running previous versions of Windows, this is located at:

C: -> Program Files -> Emerson -> ERTune.

A separate folder is created for data files generated by the 
program. On PCs running Windows 7, this is located at:

C: -> Program Data -> Emerson -> ERTune.

On PCs running previous versions of Windows, this is located at:

C: -> Documents and Settings  -> All Users -> Application Data -> Emerson -> ERTune.

This folder is the default location for configuration files, Profiles, 
and data acquisition files. The Windows Navigator window will 
default to this folder. You may save the data files generated by 
your application in another location, if you prefer.

IMPORTANT!IMPORTANT! Windows 8 users: In order to maintain compatibility 
with previous Windows operating systems, the ERTune™ program uses 
the .NET Framework 3.5, which is not installed by default in Windows 8. 
If you are using Windows 8, you will need to download and install .NET 
Framework 3.5 before installing the ERTune™ program. We have provided 
step-by-step instructions for this task in Appendix A: Setting Up The 
ERTune™ Program On Windows 8 PCs. 

You will also need to install .NET Framework 3.5 on a PC running a 
previous version of Windows if the Framework has been uninstalled. The 
downloadable files, as well as installation instructions, can be found at: 
http://www.microsoft.com/en-us/download/details.aspx?id=21.

http://www.microsoft.com/en-us/download/details.aspx%3Fid%3D21
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Installation

Installing the ER5000 USB Device Driver Manually (Windows 7) 

IMPORTANT!IMPORTANT! Windows 8 users: You may need to disable Driver 
Signature Enforcement to install the ER5000 driver. We have provided 
step-by-step instructions for this task in Appendix A: Setting Up The 
ERTune™ Program On Windows 8 PCs. 

Some operating system configurations require that device 
drivers be installed manually. If the ER5000DR driver does not 
install automatically, follow these steps:

1. Check that the ER5000 is powered up and that both 
ends of the USB cable are connected. Refer to Step 5 
and Step 8 of the Getting Started section for wiring the 
ER5000 and connecting the USB cable. 

2. From the PC desktop, select:  
Start -> Control Panel -> Hardware and Sound -> Device Manager.

3. Locate the ER5000 USB Serial Port in the list of devices. 

4. Double-click the listing. The Properties window opens. 

5. Click the Driver tab.

6. Click the Update Driver button.

7. Click the Browse my computer for driver software button.

8. Enter “C:\Program Files (x86)\Emerson\ERTune” in the  
Search for driver software in this location: field

OR

Click the Browse... button and navigate to the 
C: -> Program Files (x86) -> Emerson -> ERTune 
folder and click OK.

9. Click the Next button.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

If your security settings caution against installing the 
driver, click to allow installation.

10. Installation will begin. When installation is complete, note 
the COM Port number for the ER5000 USB Serial Port. 

11. Open the ERTune™ program. If the Comm Error window 
opens, check that the COM Port matches the listing in the 
Device Manager. If it does not, select the correct port from 
the drop-down list. The program should open. 
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Installation
Installing the ER5000 USB Device Driver Manually 
(Windows XP and earlier) 

IMPORTANT!IMPORTANT! Windows 8 users: You may need to disable Driver 
Signature Enforcement to install the ER5000 driver. We have provided 
step-by-step instructions for this task in Appendix A: Setting Up The 
ERTune™ Program On Windows 8 PCs. 

Some operating system configurations require that device 
drivers be installed manually. If the ER5000DR driver does not 
install automatically, follow these steps:

1. Check that the ER5000 is powered up and that both 
ends of the USB cable are connected. Refer to Step 5 
and Step 8 of the Getting Started section for wiring the 
ER5000 and connecting the USB cable. 

2. If the driver has not been installed, the Found New 
Hardware Wizard window opens.

3. Click the No, not this time radio button, then click Next >.

4. In the next window, click the Install from a list or a specific 
location (Advanced) radio button, then click Next >.

5. In the Installation Options window, click the  
Search for the best driver in these locations radio button, 
check the Include this location in the search: check box, 
and enter “C:\Program Files\Emerson\ERTune” in 
the entry field.  

OR

Click the Browse... button and navigate to the  
C: -> Program Files -> Emerson -> ERTune folder.

Then click the Next > button.

6. The operating system will search for the device driver and 
install it. If the Hardware Installation Warning window 
opens, click the Continue Anyway button.

7. When installation is complete, a window will open 
informing you that the installation was successful. 
Click the Finish button.

8. Open the ERTune™ program. If the Comm Error window 
opens, check that the COM Port matches the listing in the 
Device Manager. If it does not, select the correct port from 
the drop-down list. The program should open. 
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Operation

Checking the Configuration of the Jumpers

 WARNING

The controller must be disconnected from the power supply 
before any additional wiring or change to jumper configuration is 
performed. Do not reconnect the power supply until all additional 
wiring connections have been made and are properly installed.

Figure 61 shows the jumpers on the ER5000. 

The Voltage/Current Select Jumpers
Jumpers J5, J6, J14 and J15 are used to select between 4–20 mA 
and 1–5V sources for setpoint, external feedback, auxiliary 
input #1 and auxiliary input #2 respectively. For these jumpers, 
having the jumper installed (ON) configures the controller 
for 4–20 mA input, and having the jumper not installed (OFF) 
configures the controller for 1–5V input.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

As seen in Figure 61, 0–10V models of the ER5000 do not have 
these jumpers.

The Ground Filter Bypass Jumper
The recommended configuration for the Ground Filter Bypass 
jumper (J1) is not installed (OFF). Installing this jumper connects 
signal ground directly to the power supply ground. 

(continued next page)
Figure 61: Jumpers 

Jumper J5

Setpoint

ON = 4–20 mA
OFF = 1–5V

Jumper J1

Ground Filter
Bypass

ON = Signal ground 
connected to power 
ground
OFF = Normal mode, 
no connection 
(recommended)

Jumper J1

Ground Filter
Bypass

ON = Signal ground 
connected to power 
ground
OFF = Normal mode, 
no connection 
(recommended)

Jumper J6

External Feedback

ON = 4–20 mA
OFF = 1–5V

4–20 mA / 1–5V Models

0–10V Models

Jumper J14
Auxiliary Input #1

ON = 4–20 mA
OFF = 1–5V

Jumper J15

Auxiliary Input #2

ON = 4–20 mA
OFF = 1–5V

Jumper J9

ER3000 / ER5000 
Mode Select
ON = ER3000

OFF = ER5000

Jumper J9

ER3000 / ER5000 
Mode Select
ON = ER3000

OFF = ER5000
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Operation

Checking the Configuration of the Jumpers (cont.)

While it is rare, electrical noise can at times cause a problem 
in an ER5000 control system.  Electrical noise is defined as 
“unwanted, random fluctuations in an electrical signal.” It is 
difficult to identify sources of noise when transferring analog 
signals across a process plant or factory floor, or in the confines 
of a test stand that is densely populated with various electrical, 
mechanical and electromechanical devices.

The ER5000 grounding system was designed to minimize noise 
issues by separating the signal ground from the power/board 
ground with a low-pass filter.  However, if you are having issues 
with noise, installing this jumper may help. 

The ER3000/ER5000 Mode Select Jumper
By default, the ER5000 uses a 16-bit A/D converter to translate 
analog input signals to digital. The previous model, the ER3000, 
used a 12-bit converter. For applications where the ER5000 will 
be controlled by software originally written for the ER3000, 
Jumper J9 allows the ER5000 to switch from 16-bit to 12-bit A/D 
conversion, and the application will integrate the new controller 
without requiring a rewrite of the software.

If Jumper J9 is ON, some of the new features of the ER5000 
will not function, including Suspend Mode and some Profile 
commands (Soak, If, Goto). Also some internal variables 
switch from 16-bit to 12-bit and must be configured to the 
correct scale. Refer to the Internal Variables section for specific 
information on the affected variables. 
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Operation

Checking the LED Indicators

 WARNING

Be aware that the controller is connected to the power supply and 
that critical components of the controller are exposed when the 
cover is removed to inspect the LED indicators. Always use 
extreme caution when the cover is removed.

Figure 62 shows the position of the four LED indicators on the 
circuit board of the ER5000. The LED indicators give you a quick 
visual reference to evaluate the status of the controller.

During installation, use LED1 (red) and LED4 (red) to verify that 
you have correctly wired the ER5000 to its power supply. 

If you are communicating via RS485, for example as part of a 
daisychain on a network, LED2 (green) and LED3 (amber) verify 
that the ER5000 is sending and receiving data. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Refer to page 80 through page 84 for correct wiring to 
connect the ER5000 to an RS485 converter.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

LED2 and LED3 respond to data transmission when the 
ER5000 communicates using RS485. These LEDs do not respond to data 
transmission when the ER5000 communicates using USB, and may be on 
or off depending on the specific configuration of your application. They do 
not need to be checked during installation or operation when USB is used.

The LEDs can help you troubleshoot controllers that are not 
functioning properly.

LED4
“Heartbeat”

(red)
should blink on and off 

at a steady rate

LED1
Power Indicator
(red)
should be on 
continuously

LED3
Receiving Data
(amber)
blinks when ER5000 
is receiving data in 
via RS485

LED2
Sending Data

(green)
blinks when ER5000 

 is sending data 
out via RS485

Figure 62: LED Indicators
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Using the LED Indicators to Verify Power Supply During 
Power-up 

1. Power up the ER5000. 

2. Check the LED indicators on the ER5000. They should 
appear as follows: 

• LED1 = ON

• LED4 = BLINKING 

3. If the LED indicators do not appear this way, refer to Power 
Supply Wiring — All Applications and verify that the ER5000 is 
correctly wired to the power supply.

Using the LED Indicators to Verify RS485 Communication 

1. Power up the ER5000 and verify the power supply, as 
described above.

2. Open the ERTune™ program. 

3. Check the LED indicators on the ER5000. They should 
appear as follows: 

• LED2 = FLASHING ON AND OFF

• LED3 = FLASHING ON AND OFF 

4. If the LED indicators do not appear this way, refer 
to  page 80 through page 84, depending on your 
application, and verify that the ER5000 is correctly wired to 
the RS485 converter.
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Opening the ERTune™ Program

IMPORTANT!IMPORTANT! The ER5000 must be powered up and connected to the 
PC via USB or RS485 in order to open the ERTune™ program.

You should close the ERTune™ program before powering down the 
controller or disconnecting the communication cable. 

The ERTune™ program should open directly when the controller is 
connected and powered up.

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The Comm Error window may appear briefly when the ERTune™ 
program opens during normal operation. Allow 10-20 seconds before 
taking troubleshooting action.

If the Comm Error (Communications Error) window opens and 
remains open for longer than 20 seconds, follow these steps:

1. Check all power and communication wiring per your 
application.

2. Click the Search Ports button. The ERTune™ program scans all 
COM ports that are in use.

3. Click the Search button below the Node Address. The 
ERTune™ program scans all 250 Node Addresses.

4. If the program does not open, close the Comm Error 
window and check that the ER5000 is correctly configured 
to communicate with the PC.

a. If you are communicating via RS485 refer to Using the 
LED Indicators to Verify RS485 Communication.  

b. If you are communicating via USB, follow these steps:

 > If the controller is correctly configured but the 
program still does not open, unplug the USB cable 
from the PC, then plug it back in.  

 > If the program still does not open, power down and 
power up the ER5000.

 > If the program still does not open, follow the steps 
on page 194 or page 195 and re-install the ER5000 
device driver.

5. If the problem persists, contact TESCOM support.
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Checking the ERTune™ Menu Bar for Warnings

The Menu Bar of ERTune™ program displays two 
warnings: No Feedback and Simulation. 

The No Feedback warning indicates that the program is 
communicating with the controller, but  is not receiving 
a feedback signal. 

This warning generally indicates a wiring problem. Refer 
to the Getting Started or the Installation Variations section 
to find the correct wiring for your application, and verify 
that your wiring has been installed correctly. 

• A common error is not connecting the yellow wire 
(pin 4) and the tan wire (pin 12) when using a 
4–20 mA feedback transducer.

• Also check to make sure the voltage/current 
select jumpers are in the proper position for your 
application. Refer to Checking the Configuration of the 
Jumpers earlier in this section.

The Simulation warning indicates that the ERTune™ 
program has been opened in Simulation Mode. 

In Simulation Mode, the program responds 
normally to controls. However, it does not actively 
communicate with a controller, even if the 
controller is powered up and properly connected.

Simulation Mode is useful for training purposes, but 
should be closed when you wish to communicate 
with the ER5000.
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Checking the Pressure Connections if the ER5000 Does Not 
Respond Properly to Setpoint Changes 

 WARNING

• Never connect the controller or any associated equipment to a 
supply source having a pressure greater than the maximum 
rated pressure of this controller or the associated equipment.

• Supply pressure must be clean, dry inert gas or air that meets the 
requirements of ISA Standard 7.0.01.

• The ER5000 exhausts pilot pressure to the surrounding atmosphere. 
When installing this unit in a confined area, the exhaust port should 
be remotely vented to a safe location to prevent asphyxiation due to 
lack of Oxygen in the surrounding atmosphere.

If there is a problem with controlling the pressure: 

1. Check the pneumatic connections. 

• The inlet pressure must go into the Inlet Port, which 
is the left port (as shown in Figure 63). There must be 
a proper air tight seal, using a connector such as the 
TESCOM 80129 1/8” NPTF male tube connector.

(continued next page)

TM

ER5000

TM

ER5000Exhaust Port Vents to Atmosphere

Inlet Pressure Connected to Inlet Port

Figure 63: Proper Installation of Inlet Pressure
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Checking the Pressure Connections if the ER5000 Does Not 
Respond Properly to Setpoint Changes (cont.)

• Inlet pressure should be 110 psig / 7.5 bar, with a 
maximum of 120 psig / 8.2 bar. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Minimum inlet pressure is 1 psi above the required 
output of the ER5000.

• The gauge port must be plugged if a gauge is not 
installed, as shown in Figure 64. If a gauge is installed, 
there must be a proper air tight seal. 

2. Open the ERTune™ program and check the Control Mode, as 
displayed in the The ER Settings Panel, and setpoint source, 
as displayed in the The Setpoint Panel. 

3. If you are using an analog setpoint source, check that the 
Analog setpoint source is selected in the The Setpoint Panel. 
Also check to make sure the voltage/current select jumpers 
are in the proper position for your application. Refer to 
Checking the Configuration of the Jumpers earlier in this section.

4. Check the values of the PID parameters as displayed in the 
The PID Control Panel. 

(continued next page)

Gauge Port Plugged 
(Default Configuration)

Gauge Port With Pressure 
Gauge Installed

TM

ER5000

TM

ER5000

Figure 64: Gauge Port Plugged, and with Pressure Gauge Installed
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Checking the Pressure Connections if the ER5000 Does Not 
Respond Properly to Setpoint Changes (cont.)

5. Make sure that a Control Limit has not been triggered. Refer 
to The Control Limits Panel for more information. 

6. If the problem persists, use The Plot Screen Buttons 
— The Print Button to take a snapshot of your current 
configuration, and gather all tuning parameters, then 
contact your TESCOM representative.
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Checking the Solenoid Valves for Leaks 

The ERTune™ program includes an automated test for the Inlet 
and Exhaust valves of the controller. Refer to The ER Solenoid Leak 
Test Panel section for a step-by-step explanation of the process.

Checking Other Components of the Application for Leaks

TESCOM includes a suite of diagnostic tools and 
reference materials in the The Diagnostic Tools Tab of the 
ERTune™ program. Reference the The System Check Panel 
and the The Regulator Leak Check Panel as a first step 
towards problem solving.
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RS485 Communication

TESCOM Model # 82948 USB to RS485 Converter

Locate the four DIP switches on the back of the converter. The 
switches should be configured as follows:

• RS-485

• Echo OFF

• 2 Wire

• 2 Wire

Third Party RS232 to RS485 Converters 

RS232 to RS485 converters range in modes of operation. If your 
application requires a RS232 to RS485 converter, it must be 
configured as follows: 

• Echo off. 

• Transmitted data, SD, is used for flow control. 

• No handshake control (RTS/CTS, DSR/DTR)

Additionally, for 4-wire RS422 converters (half duplex):

• Connect: +TD to +RD

• Connect: – TD to – RD

Acceptable Resistance Values 

The resistance values must be measured with all external wiring 
disconnected, including the power. Ensure converter screw 
terminals are tight. 

Resistance levels outside the acceptable ranges may indicate 
damaged RS485 components on the ER5000.  Contact your 
TESCOM representative.

ER5000 RS485 Interface 
• +RS485 to GND = 10KΩ to 50KΩ 

• -RS485 to GND = 10KΩ to 50KΩ 

Converter RS485 Interface 
• +RS485 to GND = 3KΩ to 5KΩ 

• -RS485 to GND = 900Ω to 1.2KΩ 
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Using Profiles to Control the ER5000
Profiles are multi-step command sequences for the ER5000. 
They require no previous programming experience on the part 
of the user to create, and guide the ER5000 through everything 
from a simple start/stop operation to a sequence of setpoint 
changes that can include up to one hundred command lines and 
control loops that can run indefinitely.

Problems with Profiles can generally be attributed to 
applications where a Profile includes command segments where 
the controller communicates with an external digital device. 
Troubleshooting these applications generally involves checking 
that all wiring is configured properly and correctly setting the 
internal variables which control how the ER5000 interprets 
digital signals.

Input – If the Profile Stops at a Digital Input Command 
for Digital Input 1

1. Check Jumper J14. It must be OFF to use Input 1 as a digital 
input. Refer to Checking the Configuration of the Jumpers earlier 
in this section.

2. Check variable #77 ( ID_COMPENSATED_EXTRA_AD1). 
The value should read higher when the input is activated 
(Logical 1) than when not activated (Logical 0).

3. Use one of the extra variables on the plot screen to monitor 
Extra Analog Input 1 (77). Follow the steps in To add a variable to 
the Plot Screen display.
OR
Use a Read/Write field in The Read/Write Panel to monitor 
77:COMP_EXTRA–AD1.

(continued next page)



ER5000 — 

208

ER5000 — Troubleshooting

4. If variable #77 isn’t reading properly, check wiring. Refer to the 
Profile with External Control/Digital Inputs wiring configuration.

5. Use a Read/Write field in The Read/Write Panel to monitor and, 
if necessary change, 85:AD_EXTRA1–TOGGLE. Variable #85 (ID_
AD_EXTRA1_TOGGLE ) is used to adjust the level at which the 
ER5000 interprets variable #77 as a Logical 0 or a Logical 1.

To change the level at which the input switches between 
Logical 0 and Logical 1, use the Write feature.

• 85:AD_EXTRA1–TOGGLE is a 12-bit variable with a range 
of 400–3700, where a value of 400 counts is 0% and 
3700 counts is 100%. To convert between counts and 
percent, use the following formulas:

value_percent = (value_counts - 400) * 100 / 3,300               

value_counts = ( value_percent * 3,300 /100) + 400

• The default toggle level is 50% or 2050 counts.

• The ER5000 User Support Software and Manual CD 
includes a Unit Converter program which can assist you 
in conversion calculations. It is accessed by clicking the 
Unit Converter button in the Resources section. Refer to the 
ER5000 Software Development Support section for more 
information on accessing the resources on the CD. 

Input – If the Profile Does Not Start at a Digital Input 
from Digital Input 2

1. Check Jumper J15. It must be OFF to use Input 2 as a digital 
input. Refer to Checking the Configuration of the Jumpers earlier 
in this section.

2. Check variable #78 ( ID_COMPENSATED_EXTRA_AD2). 
The value should read higher when the input is activated 
(Logical 1) than when not activated (Logical 0).

3. Use one of the extra variables on the plot screen to monitor 
Extra Analog Input 1 (78). Follow the steps in To add a variable to 
the Plot Screen display.

OR

Use a Read/Write field in The Read/Write Panel to monitor 
78:COMP_EXTRA–AD1.

4. If variable #78 isn’t reading properly, check wiring. Refer to the 
Profile with External Control/Digital Inputs wiring configuration.

5. Use a Read/Write field in The Read/Write Panel to monitor and, 
if necessary change, 86:AD_EXTRA2–TOGGLE. Variable #86 (ID_
AD_EXTRA2_TOGGLE ) is used to adjust the level at which the 
ER5000 interprets variable #78 as a Logical 0 or a Logical 1.

To change the level at which the input switches between 
Logical 0 and Logical 1, use the Write feature.

(continued next page)
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• 86:AD_EXTRA2–TOGGLE is a 12-bit variable with a range 
of 400–3700, where a value of 400 counts is 0% and 
3700 counts is 100%. To convert between counts and 
percent, use the following formulas:

value_percent = (value_counts - 400) * 100 / 3,300               

value_counts = ( value_percent * 3,300 /100) + 400

• The default toggle level is 50% or 2050 counts.

• The ER5000 User Support Software and Manual CD 
includes a Unit Converter program which can assist you 
in conversion calculations. It is accessed by clicking the 
Unit Converter button in the Resources section. Refer to the 
ER5000 Software Development Support section for more 
information on accessing the resources on the CD. 
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Using Profiles to Control the ER5000

Output – If the Profile Doesn’t Activate Digital Load 1

1. Use a Read/Write field in The Read/Write Panel to monitor 
88:DIGITAL_OUTPUT1 while running the Profile. The value 
should read “1” when the input is activated and should read 
“0” when not activated.

2. If variable #88 (ID_DIGITAL_OUTPUT1) is reading properly, 
follow these steps: 

a. Check the wiring. Refer to the wiring diagram for Digital 
Outputs.

b. Ensure the power being supplied to the load is sufficient 
for the device and the application.

Output – If the Profile Doesn’t Activate Digital Load 2

1. Use a Read/Write field in The Read/Write Panel to monitor 
89:DIGITAL_OUTPUT2 while running the Profile. The value 
should read “1” when the input is activated and should read 
“0” when not activated.

2. If variable #89 (ID_DIGITAL_OUTPUT2) is reading properly, 
follow these steps: 

a. Check the wiring. Refer to the wiring diagram for Digital 
Outputs.

b. Ensure the power being supplied to the load is sufficient 
for the device and the application.
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Variable Index and Name Access Type Range:Decimal Range:Hex

00 - ID_INNER_ACTUAL_ERROR RO Signed -4095 : 4095 -0fff : 0fff

01 - ID_AD_SETPOINT RO Unsigned 0 : 65535 0 : ffff

02 – ID_TEMP_ADJUST RW Unsigned 0 : 65535 0 : ffff

03 - ID_INNER_D_COEF1 RW Signed -32768 : 32767 -8000 : 7fff

04 - ID_INNER_D_COEF2 --- --- --- ---

05 - ID_COMPENSATED_EXTERNAL_SENSOR RO Unsigned 0 : 65535 0 : ffff

06 - ID_COMPENSATED_INTERNAL_SENSOR RO Unsigned 0 : 65535 0 : ffff

07 - ID_RAW_EXTERNAL_SENSOR RO Unsigned 0 : 65535 0 : ffff

08 - ID_RAW_INTERNAL_SENSOR RO Unsigned 0 : 65535 0 : ffff

09 - ID_CONTROL_MODE RW Signed 0 : 3 0 : 3

10 - ID_INNER_DERIVATIVE RO Signed -32768 : 32767 -8000 : 7fff

11 - ID_INNER_EFFECTIVE_ERROR RO Signed -32768 : 32767 -8000 : 7fff

12 – ID_PWM_SHUTOFF_FLAG RW Unsigned 0 : 1 0 : 1

13 - ID_RTTASK_DELAY RW Unsigned 0 : 65535 0 : ffff

14 - ID_OUTER_ACTUAL_ERROR RO Signed -4095 : 4095 -0fff : 0fff

15 - RESERVED --- --- --- ---

16 - ID_OUTER_D_COEF1 RW Signed -32768 : 32767 -8000 : 7fff

17 - RESERVED --- --- --- ---

18 - ID_OUTER_EFFECTIVE_ERROR RO Signed -32768 : 32767 -8000 : 7fff

19 - ID_INNER_SENSOR_MIN RW Unsigned 0 : 4095 0 : 0fff

20 - ID_INNER_SENSOR_MAX RW Unsigned 0 : 4095 0 : 0fff

21 - ID_OUTER_INTEGRAL_CONSTANT RW Signed -32768 : 32767 -8000 : 7fff

22 - ID_OUTER_INTEGRAL_MAXIMUM RW Signed -32768 : 32767 -8000 : 7fff

Variable Index and Name Access Type Range:Decimal Range:Hex

23 - ID_OUTER_INTEGRAL_SUM RW Signed -32768 : 32767 -8000 : 7fff

24 - RESERVED --- --- --- ---

25 -ID_OUTER_PROPORTIONAL_CONSTANT RW Signed -32768 : 32767 -8000 : 7fff

26 - ID_FACTORY_MIN_INLET RW Unsigned 0 : 250 0 : fa

27 - ID_FACTORY_MIN_EXHAUST RW Unsigned 0 : 250 0 : fa

28 - ID_INNER_INTEGRAL_CONSTANT RW Signed -32768 : 32767 -8000 : 7fff

29 - ID_INNER_INTEGRAL_MAXIMUM RW Signed -32768 : 32767 -8000 : 7fff

30 - ID_INNER_INTEGRAL_SUM RW Signed -32768 : 32767 -8000 : 7fff

31 - RESERVED --- --- --- ---

32 - RESERVED --- --- --- ---

33 - RESERVED --- --- --- ---

34 - ID_OUTPUT RO Signed -32768 : 32767 -8000 : 7fff

35 - ID_INNER_PROPORTIONAL_CONSTANT RW Signed -32768 : 32767 -8000 : 7fff

36 - ID_COMP_TEMP_SENSOR RO Unsigned 0 : 65535 0 : ffff

37 - ID_SETPOINT RW Unsigned 0 : 4095 0 : 0fff

38 - ID_RAW_TEMP_SENSOR RO Unsigned 0 : 4095 0 : 0fff

39 - ID_GAIN RW Unsigned 0 : 65535 0 : ffff

40 - ID_OSET RW Unsigned 0 : 65535 0 : ffff

41 - ID_ARDG RO Unsigned 0 : 65535 0 : ffff

42 - ID_NODE RW Unsigned 1 : 250 1 : fa

43 - ID_SETPOINT_FLAG RW Signed 0 : 4 0 : 4

44 - ID_FEEDBACK RO Unsigned 0 : 4095 0 : 0fff

45 - ID_PROFILE_LOOP_COUNT RO Unsigned 0 : 30,000 0 : 7530

Table of ER5000 Internal Variables
Table 27: ER5000 Internal Variables 
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Variable Index and Name Access Type Range:Decimal Range:Hex

46 - ID_SOLENOID_DIRECTION RW Signed 0 : 1 0 : 1

47 - ID_MIN_INLET RW Unsigned 0 : 250 0 : fa

48 - ID_MIN_EXHAUST RW Unsigned 0 : 250 0 : fa

49 - ID_OUTER_INTEGRAL_MINIMUM RW Signed -32768 : 32767 -8000 : 7fff

50 - ID_INNER_INTEGRAL_MINIMUM RW Signed -32768 : 32767 -8000 : 7fff

51 - ID_RAW_AD_SETPOINT RO Unsigned 0 : 65535 0 : ffff

52 - ID_SERIAL_NUMBER RW Unsigned 0 : 65535 0 : ffff

53 - ID_VERSION_NUMBER RW Unsigned 0 : 65535 0 : ffff

54 - ID_MIN_AD_SETPOINT RW Unsigned 0 : 4095 0 : 0fff

55 - ID_MAX_AD_SETPOINT RW Unsigned 0 : 4095 0 : 0fff

56 - ID_MIN_COMPENSATED_INTERNAL_SENSOR RW Unsigned 0 : 4095 0 : 0fff

57 -ID_MAX_COMPENSATED_INTERNAL_SENSOR RW Unsigned 0 : 4095 0 : 0fff

58 - ID_MIN_COMPENSATED_EXTERNAL_SENSOR RW Unsigned 0 : 4095 0 : 0fff

59-ID_MAX_COMPENSATED_EXTERNAL_SENSOR RW Unsigned 0 : 4095 0 : 0fff

60 - ID_MIN_INNER_ACTUAL_ERROR RW Signed -32768 : 32767 -8000 : 7fff

61 - ID_MAX_INNER_ACTUAL_ERROR RW Signed -32768 : 32767 -8000 : 7fff

62 - ID_MIN_OUTER_ACTUAL_ERROR RW Signed -32768 : 32767 -8000 : 7fff

63 - ID_MAX_OUTER_ACTUAL_ERROR RW Signed -32768 : 32767 -8000 : 7fff

64 - ID_PWM_ CONTROL_LIMIT_STATE RW Signed 0 : 3 0 : 3

65 - ID_PWM_VALUE RO Signed -250 : 250 -fa : fa

66 - ID_INNER_INTEGRAL_DEADBAND RW Unsigned 0 : 4095 0 : 0fff

67 - ID_OUTER_INTEGRAL_DEADBAND RW Unsigned 0 : 4095 0 : 0fff

68 - ID_FEEDBACK_FILTER RW Unsigned 0 : 1 0 : 1

69 - ID_PROFILE_TYPE RO Unsigned 0 : 11 0 : b

Variable Index and Name Access Type Range:Decimal Range:Hex

70 - ID_PROFILE_STATE RW Unsigned 0 : 2 0 : 2

71 - ID_PROFILE_STEP RO Unsigned 0 : 31 0 : 1f

72 - ID_ESTOP_FLAG RW Unsigned 0 : 1 0 : 1

73 - ID_PULSE RW Unsigned 1798 : 2298 0706 : 08fa

74 - ID_EXTRA_AD1 RO Unsigned 0 : 65535 0 : ffff

75 - ID_EXTRA_AD2 RO Unsigned 0 : 65535 0 : ffff

76 - RESERVED --- --- --- ---

77 - ID_COMPENSATED_EXTRA_AD1 RO Unsigned 0 : 65535 0 : ffff

78 - ID_COMPENSATED_EXTRA_AD2 RO Unsigned 0 : 65535 0 : ffff

79 - ID_RANGE_MIN_INLET RW Unsigned 0 : 20 0 : 14

80 - ID_RANGE_MIN_EXHAUST RW Unsigned 0 : 20 0 : 14

81 - ID_PULSE_PERIOD RW Unsigned 0 : 200 0 : c8

82 - ID_PULSE_WIDTH RW Unsigned 0 : 250 0 : fa

83 - ID_PULSE_DEADBAND RW Unsigned 0 : 330 0 : 14a

84 - ID_PULSE_ENABLE RW Unsigned 0 : 1 0 : 1

85 - ID_AD_EXTRA1_TOGGLE RW Unsigned 0 : 4095 0 : 0fff

86 - ID_AD_EXTRA2_TOGGLE RW Unsigned 0 : 4095 0 : 0fff

87 - ID_EXT_FEEDBACK_SOURCE RW Unsigned 0 : 1 0 : 1

88 - ID_DIGITAL_OUTPUT1 RW Unsigned 0 : 1 0 : 1

89 - ID_DIGITAL_OUTPUT2 RW Unsigned 0 : 1 0 : 1

90 - ID_DIGITAL_OUT1_INIT RW Unsigned 0 : 1 0 : 1

91 - ID_DIGITAL_OUT2_INIT RW Unsigned 0 : 1 0 : 1

92 - ID_DA_ANALOG_OUT RW Unsigned 0 : 4095 0 : 0fff

93 - ID_TTL_ERR0 RW Unsigned 0 : 4095 0 : 0fff
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Variable Index and Name Access Type Range:Decimal Range:Hex

94 - ID_TTL_ERR4095 RW Unsigned 0 : 4095 0 : 0fff

95 - ID_DA_ANALOG_WRITE_FLAG RW Unsigned 0 : 1 0 : 1

96 - ID_TTL_FLAG RW Unsigned 0 : 1 0 : 1

97 - ID_DIAPHRAGM_PROTECT_ENABLE RW Unsigned 0 : 1 0 : 1

98 – ID_SENSOR_FLAG RW Unsigned 0 : 1 0 : 1

99 - ID_DIAPHRAGM_PROTECT_OFFSET RW Unsigned 0 : 4095 0 : 0fff

100 - ID_CAL_OFFSET_ANALOG_SP RW Signed -32768 : 32767 -8000 : 7fff

101 - ID_CAL_GAIN_ANALOG_SP RW Unsigned 0 : 65535 0 : ffff

102 - ID_CAL_OFFSET_EXTERNAL_FB RW Signed -32768 : 32767 -8000 : 7fff

103 - ID_CAL_GAIN_EXTERNAL_FB RW Unsigned 0 : 65535 0 : ffff

104 - ID_CAL_OFFSET_EXTRA1 RW Signed -32768 : 32767 -8000 : 7fff

105 - ID_CAL_GAIN_EXTRA1 RW Unsigned 0 : 65535 0 : ffff

106 - ID_CAL_OFFSET_EXTRA2 RW Signed -32768 : 32767 -8000 : 7fff

107 - ID_CAL_GAIN_EXTRA2 RW Unsigned 0 : 65535 0 : ffff

108 - RESERVED --- --- --- ---

109 - RESERVED --- --- --- ---

110 - RESERVED --- --- --- ---

Variable Index and Name Access Type Range:Decimal Range:Hex

111 - RESERVED --- --- --- ---

112 - ID_CAL_OFFSET_ANALOG_OUT RW Signed -32768 : 32767 -8000 : 7fff

113 - ID_CAL_GAIN_ANALOG_OUT RW Unsigned 0 : 65535 0 : ffff

114 - RESERVED --- --- --- ---

115 - RESERVED --- --- --- ---

116 - RESERVED --- --- --- ---

117 - RESERVED --- --- --- ---

118 - RESERVED --- --- --- ---

119 - ID_PROFILE_STARTRUN RW Unsigned 0 : 1 0 : 1

120 - ID_MODE_ER3000_ER5000 RO Unsigned 0 : 1 0 : 1

121 - ID_SUSPEND RO Unsigned 0 : 1 0 : 1

122 - ID_SETPOINT_RESET RW Unsigned 0 : 1 0 : 1

123 - ID_DAC_INT_SENSOR_OFFSET RW Signed 0 : 4095 0 : fff

124 - ID_DAC_INT_SENSOR_GAIN RW Unsigned 0 : 4095 0 : fff

125 - ER5000_TAG RO Unsigned 0 : 65535 0 : ffff

126 - RESERVED --- --- --- ---

127 - RESERVED --- --- --- ---
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ER5000 Internal Variables 

The ER5000 has a number of internal variables which can be 
accessed via the USB or RS485 interface. The most commonly 
used variables are listed below. The variable index number, 
name, and description are shown. The index number is the 
value selected from the drop-down list in the Variables field of 
The Read/Write Panel in the The Power User Tab of the ERTune™ 
program to access the specified variable. A complete list of 
internal variables is shown in Table 27. 

ER5000 Setpoint and Feedback Variables 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

For variable #37 (ID_SETPOINT) and variable #44 (ID_FEEDBACK), a 
value of 400 counts is 0% and 3700 counts is 100%. To convert between 
counts and percent, use the following formulas: 

• value_percent = (value_counts - 400) * 100 / 3,300

• value_counts = ( value_percent * 3,300 /100) + 400

37 ID_SETPOINT
This is the controller’s setpoint. 

43 ID_SETPOINT_FLAG
This variable determines the source of the setpoint, 
variable #37 (ID_SETPOINT).

• 0 => setpoint from A/D, analog setpoint input

• 1 => setpoint from RS485 or USB network, typically a PC

• 2 => setpoint from internal Profile

• 3=>  setpoint from A/D, analog setpoint input, while in 
Profile Mode

• 4=>  Monitor Setpoint from external device while 
running the ERTune™ program

44 ID_FEEDBACK
This is the controller’s overall feedback signal. For internal sensor 
mode it is the same as inner feedback. For external sensor 
mode or cascade mode it equals the outer loop feedback. 

87  ID_EXT_FEEDBACK_SOURCE
This variable determines the source of the external feedback.

• 0 =>  feedback from the compensated external sensor, see 
variable #5 (ID_COMPENSATED_EXTERNAL_SENSOR)

• 1 => feedback from extra analog input 1, see 
variable #77 (ID_COMPENSATED_EXTRA_AD1) 
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ER5000 Configuration Variables 

09 ID_CONTROL_MODE
This variable establishes the control mode for the controller. 
A value of four only occurs when a Control Limit has been 
exceeded. See variables #54 (ID_MIN_AD_SETPOINT) 
through #64 (CONTROL_LIMIT_STATE). A value of five only 
occurs if the controller is in ESTOP, emergency stop, mode. 

• 0 => internal feedback mode

• 1 => external feedback mode

• 2 => cascade mode

• 3 => manual mode  
setpoint = 0x08fa => inlet open 
setpoint = 0x0800 => solenoids closed 
setpoint = 0x0706 => exhaust open 

• 4 => control limit mode (read only)

• 5 => emergency stop (read only) 

42  ID_NODE
This is the unit’s network Node Address. Note that if this 
variable is changed then all future communication must be 
addressed to the new Node Address. 

52  ID_SERIAL_NUMBER
This is the serial number for the unit. It is programmed at 
the factory and should not be changed by the user. 

53  ID_VERSION_NUMBER
This is the version number of the embedded software. 

120 ID_MODE_ER3000_ER5000
This is the selected mode of operation determined by either 
installing or removing Jumper J9.

• 0 => ER5000 mode

• 1 => ER3000 mode

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

The unit must be powered down/up for the jumper change 
to be recognized

122 ID_SETPONT_RESET
This variable establishes the startup setpoint of the 
ER5000. When it is activated (value = 1) the ER5000 will 
startup at zero. 
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ER5000 Inner Loop Tuning Variables 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

Variable #6 (ID_COMPENSATED_INTERNAL_SENSOR) is 16-bit 
when the controller is in ER5000 mode (Jumper J9 = OFF, variable #120 
(ID_MODE_ER3000_ER5000) => 0). When the controller is in ER5000 
mode, a value of 6400 counts is 0% and 59200 counts is 100%. To 
convert between counts and percent, use the following formulas: 

• value_percent = (value_counts16 - 6,400) * 100 / 52,800

• value_counts16 = (value_percent * 52,800 / 100) + 6,400

Variable #6 is 12-bit when the controller is in ER3000 mode 
(Jumper J9 = ON, variable #120 (ID_MODE_ER3000_ER5000) => 1). 
When the controller is in 12-bit ER3000 mode, a value of 400 
counts is 0% and 3700 counts is 100%. To convert between counts 
and percent, use the following formulas: 

• value_percent = (value_counts - 400) * 100 / 3,300

• value_counts = ( value_percent * 3,300 /100) + 400

03  ID_INNER_D_COEF1
This is the D-term, Derivative constant, for the inner loop. 

06  ID_COMPENSATED_INTERNAL_SENSOR
This is the compensated internal sensor value, after 
temperature compensation, zero and span have been 
applied to the raw signal. A value of 6400 is 0% and 59200 is 
100%. When the controller is in ER5000 mode, this variable 
records data in 16-bit mode, which gives more accurate 
data acquisition than variable #44 (ID_FEEDBACK).

28  ID_INNER_INTEGRAL_CONSTANT
This is the I-term, Integral Constant, for the inner loop. 

29  ID_INNER_INTEGRAL_MAXIMUM
This is the maximum value allowed for the Integral sum on 
the inner loop. 

30  ID_INNER_INTEGRAL_SUM
This is the value of the Integral sum for the inner loop. It is 
formed by multiplying the Integral constant times the error 
and summing the result with the previous value for the 
Integral sum. 

35  ID_INNER_PROPORTIONAL_CONSTANT
This is the P term (Proportional Constant) for the inner loop. 

50  ID_INNER_INTEGRAL_MINIMUM
This is the minimum value allowed for the Integral sum on 
the inner loop. 

66  ID_INNER_INTEGRAL_DEADBAND
This is the inner loop minimum error required for the 
Integral sum to be changing in value. Often it is set to 
zero and has no effect. However, if it is desirable to stop 
integrating once the error is reduced below a certain value, 
for instance when using an external dome-loaded regulator 
which has hysteresis, then this parameter should be set to 
the minimum acceptable error. 
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ER5000 Outer Loop Tuning Variables 

16  ID_OUTER_D_COEF1
This is the D term (Derivative Constant) for the outer loop. 

21  ID_OUTER_INTEGRAL_CONSTANT
This is the I term (Integral Constant), for the outer loop. 

22  ID_OUTER_INTEGRAL_MAXIMUM
This is the maximum value allowed for the Integral sum on 
the outer loop. 

23  ID_OUTER_INTEGRAL_SUM
This is the value of the Integral sum for the outer loop. It is 
formed by multiplying the Integral constant times the error 
and summing the result with the previous value for the 
Integral sum. 

25  ID_OUTER_PROPORTIONAL_CONSTANT
This is the P term (Proportional Constant) for the outer 
loop. 

49  ID_OUTER_INTEGRAL_MINIMUM
This is the minimum value allowed for the Integral sum on 
the outer loop. 

67  ID_OUTER_INTEGRAL_DEADBAND
This is the outer loop minimum error required for the 
Integral sum to be changing in value. Often it is set to 
zero and has no effect. However, if it is desirable to stop 
integrating once the error is reduced below a certain value, 
for instance when using an external dome-loaded regulator 
which has hysteresis, then this parameter should be set to 
the minimum acceptable error. 
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ER5000 Analog Input Variables

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

For the following variables: 

• variable #1 (ID_AD_SETPOINT)

• variable #5 (ID_COMPENSATED_EXTERNAL_SENSOR)

• variable #77 (ID_COMPENSATED_EXTRA_AD1) 

• variable #78 (ID_COMPENSATED_EXTRA_AD2) 

These variables are 16-bit when the controller is in ER5000 mode 
(Jumper J9 = OFF, variable #120 (ID_MODE_ER3000_ER5000) => 0). 
When the controller is in ER5000 mode, a value of 6400 counts is 0% and 
59200 counts is 100%. To convert between counts and percent, use the 
following formulas: 

• value_percent = (value_counts16 - 6,400) * 100 / 52,800

• value_counts16 = (value_percent * 52,800 / 100) + 6,400

These variables are 12-bit when the controller is in ER3000 mode 
(Jumper J9 = ON, variable #120 (ID_MODE_ER3000_ER5000) => 1). 
When the controller is in 12-bit ER3000 mode, a value of 400 
counts is 0% and 3700 counts is 100%. To convert between counts 
and percent, use the following formulas: 

• value_percent = (value_counts - 400) * 100 / 3,300

• value_counts = ( value_percent * 3,300 /100) + 400

01  ID_AD_SETPOINT
This is the value of the analog setpoint. A value of 6400 
is 0% and 59200 is 100%. Note that the analog setpoint is 
not used unless the controller is programmed to use it by 
variable #43 (ID_SETPOINT_FLAG). When the controller is 
in ER5000 mode, this variable records data in 16-bit mode, 
which gives more accurate data acquisition than variable 
#37 (ID_SETPOINT).

05  ID_COMPENSATED_EXTERNAL_SENSOR
This is the compensated external sensor value, after 
linearization, zero and span have been applied to the raw 
signal. A value of 6400 is 0% and 59200 is 100%. When the 
controller is in ER5000 mode, this variable records data in 
16-bit mode, which gives more accurate data acquisition than 
variable #44 (ID_FEEDBACK).

77  ID_COMPENSATED_EXTRA_AD1
This input is available only on “F” models. This is 
the compensated external analog input value, after 
linearization has been applied to the raw signal. A value of 
6400 is 0% and 59200 is 100%. 
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78  ID_COMPENSATED_EXTRA_AD2
This input is available only on “F” models. This is 
the compensated external analog input value, after 
linearization has been applied to the raw signal. A value of 
6400 is 0% and 59200 is 100%.

85  ID_AD_EXTRA1_TOGGLE
This variable is used to adjust the level that the ER5000 
interprets variable #77 (ID_COMPENSATED_EXTRA_AD1) 
as a Logical 0 or a Logical 1. 

86  ID_AD_EXTRA2_TOGGLE
This variable is used to adjust the level that the ER5000 
interprets variable #78 (ID_COMPENSATED_EXTRA_AD2) as 
a Logical 0 or a Logical 1. 

ER5000 Pressure Profile Variables 

45 ID_PROFILE_LOOP_COUNT
This variable displays the count of times through a Profile 
loop. The counter starts at the number of loops entered 
in the Number of Loops (0=>forever) field of the Profile Builder 
when the Loop command segment is added to the Profile, 
and decrements by one at each loop of the count.

69  ID_PROFILE_TYPE
This is the type of the profile step currently active. 

• 0 => STOP 
• 1 => RAMP
• 2 => STEP
• 3 => DWELL
• 4 => DIGITAL OUTPUT
• 5 => DIGITAL INPUT
• 6 => LOOP
• 7 => CHANGE VARIABLE
• 8 => Delta
• 9 => If
• 10 => GoTo
• 11 => Soak



 

ER5000 — 

221

ER5000 — Internal Variables

70  ID_PROFILE_STATE
This is the run state of the profile. 

• 0 => STOP 

• 1 => START 

• 2 => RUN 

71  ID_PROFILE_STEP
This is the step in the profile which is currently being run. 

119  ID_UI_PROFILE_STARTRUN
This is the restarting mode of the profile. 

• 0 => Restart profile at the beginning

• 1 => Resume profile at current profile step

ER5000 Single “Puff” Solenoid Control Variable 

73  ID_PULSE
This variable allows opening the inlet or exhaust for the 
specified duration for one pulse period. After one pulse 
duration, the variable is returned to a value of 0. 

• 0x08fa => Inlet full open

• 0x0800 => Both valves closed

• 0x0706 => Exhaust full open

ER5000 Pulse Mode Variables 

81  ID_PULSE_PERIOD
This controls the rate of the pulse while pulse mode is 
active. The value represents how many passes through the 
control algorithm (25ms per pass) before sending a pulse to 
one of the solenoids. 

82  ID_PULSE_WIDTH
This controls how long the solenoid is held open while 
pulse mode is active. Part of this number compensates 
for allowed system fluctuations (or noise) so too small a 
number will not open the solenoid valve. 

83  ID_PULSE_DEADBAND
This is the error from the setpoint allowed for the pulse 
function to stop pulsing. This value is in counts read up 
from the sensor. One count of error is .03% and typically 
this number is in the range of 0–3. 

84  ID_PULSE_ENABLE
This turns the pulse function ON(1) or OFF(0). 
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ER5000 Analog and Digital Output Variables 

88  ID_DIGITAL_OUTPUT1
This variable can be written directly by a program or by the 
embedded profile using the Digital Output command. This 
variable is written to Digital Output #1, which is J4 Pin 7 
(blue wire). 

89  ID_DIGITAL_OUTPUT2
This variable can be written directly by a program, by the 
embedded Profile using the Digital Output command, or by 
the embedded code. The embedded code updates this output 
if variable #96 (ID_TTL_FLAG) enables this output as a within 
tolerance indicator. If enabled, variable #93 (ID_TTL_ERR0) and 
variable #94 (ID_TTL_ERR4095) are used to set the maximum 
error allowed, in counts, for a setpoint of 0 and 4095 counts 
respectively. The embedded code interpolates between these 
points to find the maximum error allowed for all other setpoint 
values. Reference ER5000 Setpoint and Feedback Variables to 
translate between counts and percent. This variable is written 
to Digital Output #2, which is J4 Pin 8 (white wire).

90 ID_DIGITAL_OUT1_INIT
Power-up state of variable #88 (ID_DIGITAL_OUTPUT1).

91 ID_DIGITAL_OUT2_INIT
Power-up state of variable #89 (ID_DIGITAL_OUTPUT2).

92 ID_DA_ANALOG_OUT
This is the value written to the D/A converter to generate 
the 0–10V or 4–20 mA output signal. 

93  ID_TTL_ERR0
Maximum error allowed at 0 counts. See variable #89 
(ID_DIGITAL_OUTPUT2). 

94  ID_TTL_ERR4095
Maximum error allowed at 4095 counts. See variable #89 
(ID_DIGITAL_OUTPUT2). 

96  ID_TTL_FLAG
This variable enables (1) or disables (0) the usage of variable 
#89 (ID_DIGITAL_OUTPUT2) as a within tolerance indicator. 
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ER5000 Pulse Width Modulation (PWM) Control Variables 

12  ID_PWM_SHUTOFF_FLAG
This flag is only active if variable #13 (ID_RTTASK_DELAY) 
is not a 0 or 1 and designates what the ER5000 will send to 
the PWM every 25ms while it is delaying. 

• 0 => Write the previously computed value to the PWM

• 1 => Write a 0 to the PWM 

13  ID_RTTASK_DELAY
This variable is typically set to 0, allowing the control 
algorithm to generate a new value for the PWM every 
25ms. Certain systems need a slower acting control system, 
which is allowed for using this variable. For example, 
writing a 4 to this variable will allow the control algorithm 
to compute a new PWM value every 100ms. 

19  ID_INNER_SENSOR_MIN
This variable operation is typically disabled by writing a 0 to 
it. If not disabled, it allows for a minimum internal pressure. 
If the internal pressure is below the specified value, the 
exhaust valve will not be opened to decrease the pressure. 

20  ID_INNER_SENSOR_MAX
This variable operation is typically disabled by writing a 
4095 to it. If not disabled, it allows for a maximum internal 
pressure. If the internal pressure is above the specified value, 
the inlet valve will not be opened to increase the pressure. 

34 ID_OUTPUT
This is the value of the output from the controller. It is 
this value which controls the ER5000’s valves. A positive 
number will open the inlet valve and a negative number will 
open the outlet valve. 

46  ID_SOLENOID
This variable determines which valve is open when the 
output is positive or negative. In normal mode,  
(0 => Normal) positive outputs open the inlet solenoid and 
negative outputs open the exhaust solenoid. In reversed 
mode, (1 => Reversed) positive outputs open the exhaust 
solenoid and negative outputs open the inlet solenoid. 
This is useful in reverse-acting systems (systems where 
increasing the pressure causes the process variable to 
decrease). 

47  ID_MIN_INLET
This is the minimum value for the inlet pulse width modulator. 
The pulse width modulator’s value ranges from 0 to 250. 



 

ER5000 — 

224

ER5000 — Internal Variables

This variable, along with variable #48 (ID_MIN_EXHAUST), 
sets the deadband for the system. This variable is solenoid 
dependent and typically has a value close to 10. Larger 
values can give tighter regulation, but at a cost of more gas 
being exhausted. 

48  ID_MIN_EXHAUST
This is the minimum value for the exhaust pulse width 
modulator. The pulse width modulator’s value ranges from 0 
to 250. This variable, along with variable #47 (ID_MIN_INLET), 
sets the deadband for the system. This variable is solenoid 
dependent and typically has a value close to 10. Larger values 
can give tighter regulation, but at a cost of more gas being 
exhausted. 

65  ID_PWM_VALUE
This is the value which controls the pulse width modulators 
for the solenoids. Positive values represent the inlet 
solenoid opening and negative values are for the exhaust 
solenoid. A value of +/-250 represents a 100% duty cycle 
(full on). 

121 ID_SUSPEND
This is the state of the Suspend Mode input signal. When 
suspend mode is activated (1 => Activated) the inlet and 
exhaust valves remain fully closed and the PID algorithm is 

suspended. When it is deactivated (0 => Deactivated) the 
control returns to normal operation.

ER5000 Gain/Offset Variables 

39  ID_GAIN
This is the gain value. This value, in conjunction with the 
offset stored in variable #40 (ID_OSET) is used to form the 
feedback signal. See variable #44 (ID_FEEDBACK): 

feedback = gain * compensated_reading + offset

• 0x0200 => 1/8 ( .2% adjustability)

• 0x1000 => 1 (.025% adjustability)

• 0x8000 => 8 (.003% adjustability) 

40  ID_OSET
This is the offset value. This value, in conjunction with the 
gain stored in variable #39 (ID_GAIN) is used to form the 
feedback signal. See variable #44 (ID_FEEDBACK): 

feedback = gain * compensated_reading + offset

• 0x0000 => -1/2 FS

• 0x0fff => +1/2 FS 
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ER5000 Control Limit Variables 

64  ID_PWM_CONTROL_LIMIT
This variable sets the condition of the controller if any of 
the programmed limits are exceeded. Normally, the unit 
will be set up to open the exhaust and close the inlet valve 
if a limit is exceeded. 

NOTENOTE

CAUTIONCAUTION

WARNINGWARNING

When shipped from the factory the limits are 
set to their outer boundaries (disabled). The unit will 
automatically remove itself from the control limit condition 
when the limit is no longer exceeded. 

• 0 => IN_CLOSED_EX_CLOSED

• 1 => IN_OPEN_EX_CLOSED

• 2 => IN_CLOSED_EX_OPEN

• 3 => IN_OPEN_EX_OPEN 

Control Limits for Specified Signals 

These variables are the minimum and maximum values allowed 
for a given signal that is permissible before tripping a limit and 
causing the unit to go into the specified Control Limit Condition. 

Table 28: Control Limits for Specified Signals

Minimum/Maximum Limited Signal

54 – ID_MIN_AD_SETPOINT

55 – ID_MAX_AD_SETPOINT

1 – ID_AD_SETPOINT

56 – ID_MIN_COMPENSATED_INTERNAL_SENSOR

57 – ID_MAX_COMPENSATED_INTERNAL_SENSOR

6 – ID_COMPENSATED_INTERNAL_SENSOR

58 – ID_MIN_COMPENSATED_EXTERNAL_SENSOR

59 – ID_MAX_COMPENSATED_EXTERNAL_SENSOR

7 – ID_COMPENSATED_EXTERNAL_SENSOR

60 – ID_MIN_INNER_ACTUAL_ERROR

61 – ID_MAX_INNER_ACTUAL_ERROR

0 – ID_INNER_ACTUAL_ERROR

62 – ID_MIN_OUTER_ACTUAL_ERROR

63 – ID_MAX_OUTER_ACTUAL_ERROR

14 – ID_OUTER_ACTUAL_ERROR
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Certifications Tescom
12616 Industrial Boulevard
Elk River, MN 55330-2491

T   (763) 441 6330
F   (763) 241 3224
www.tescom.com

Declaration of Conformity 
According to EMC Directive 2004/108/EC 

The Manufacturer  European Contact 
TESCOM CORPORATION  TESCOM EUROPE GMBH & CO.KG 
12616 Industrial Boulevard  Karsten Lauterbach 
Elk River, Minnesota 55330-2491 An der Trave 23-25 
United States of America 23923 Selmsdorf, Germany 

Declares that the following product 
Product Description:  Electronic Pressure Controller 

Model Number: ER5000 

is in conformity with the essential requirements of the mentioned directive. 

Applied standards and specifications: 

IEC/EN 61000-6-2 
IEC/EN 61000-6-4 

Place: Elk River, Minnesota 

Date: 02.04.2013 

…………………………………………………………….
Mark Cramer 
Vice President Engineering 
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LIMITED WARRANTY 
TESCOM Corporation (“Seller”) warrants that the licensed firmware 
embodied in the goods will execute the programming instructions 
provided by Seller, and that the goods manufactured or services 
provided by Seller will be free from defects in materials or workmanship 
under normal use and care until the expiration of the applicable 
warranty period. Goods are warranted for twelve (12) months from 
the date of initial installation or eighteen (18) months from the date 
of shipment by Seller, whichever period expires first. Consumables 
and services are warranted for a period of 90 days from the date of 
shipment or completion of the services. Products purchased by Seller 
from a third party for resale to Buyer (“Resale Products”) shall carry 
only the warranty extended by the original manufacturer. Buyer 
agrees that Seller has no liability for Resale Products beyond making 
a reasonable commercial effort to arrange for procurement and 
shipping of the Resale Products. If buyer discovers any warranty defects 
and notifies Seller thereof in writing during the applicable warranty 
period, Seller shall, at its option, correct any errors that are found by 
Seller in the firmware of services or repair or replace F.O.B. point of 
manufacture that portion of the goods or firmware found by Seller 
to be defective, or refund the purchase price of the defective portion 
of the goods/services. All replacements or repairs necessitated by 
inadequate maintenance, normal wear and usage, unsuitable power 
sources or environmental conditions, accident, misuse, improper 
installation, modification, repair, storage or handling, or any other 
cause not the fault of Seller are not covered by this limited warranty, 
and shall be at buyer’s expense. Seller shall not be obligated to pay any 
costs or charges incurred by buyer or any other party except as may be 
agreed upon in writing in advance by Seller. All costs of dismantling, 
reinstallation and freight and the time and expenses of Seller’s 

personnel and representatives for site travel and diagnosis under this 
warranty clause shall be borne by buyer unless accepted in writing by 
Seller. Goods repaired and parts replaced by Seller during the warranty 
period shall be in warranty for the remainder of the original warranty 
period or ninety (90) days, whichever is longer. This limited warranty is 
the only warranty made by Seller and can be amended only in a writing 
signed by Seller. THE WARRANTIES AND REMEDIES SET FORTH ABOVE 
ARE EXCLUSIVE. THERE ARE NO REPRESENTATIONS OR WARRANTIES OF 
ANY KIND, EXPRESSED OR IMPLIED, AS TO MERCHANTABILITY, FITNESS 
FOR PARTICULAR PURPOSE OR ANY OTHER MATTER WITH RESPECT TO 
ANY OF THE GOOD OR SERVICES. 
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Installing the .NET Framework 3.5

If you are running Windows 8 on your PC, the first time you 
open the ERTune™ program you may see this message:

 

The ERTune™ application was designed using the .NET Framework 3.5, 
to allow for compatibility with previous Windows operating 
systems. Windows 8 is built on the .NET Framework 4.5 and 
does not include .NET Framework 3.5 by default. However, the 
.NET Framework 3.5 can easily be downloaded and installed.

Note that you will need to be connected to the Internet before 
you begin. The procedure is as follows:

1. Click Download and install this feature in the message window. 
Windows will oversee the download and installation.

2. Once the .NET Framework 3.5 has been installed, you will 
need to verify the feature is turned on.

3. Open the Charms bar by moving the mouse cursor into the 
upper right or lower right corner of the screen.

4. Select Search.
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5. Type control panel into the Search box and click on the 
Control Panel icon.

   

6. Select Programs.

   

7. Select Programs and Features.

   

8. Select Turn Windows features on or off.
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9. Select the .NET Framework 3.5 check box. You do not need to 
select the child items for Windows Communication Foundation 
(WCF) HTTP activation unless you are a developer who 
requires WCF script and handler mapping functionality.

  

10. Click OK.

Installing the ER5000 Device Driver

When loading the ER5000 USB Serial Port driver onto 
Windows 8 you may encounter the following error message:

Windows found driver software for your device but encountered 
an error while attempting to install it. 

The third-party INF does not contain digital signature 
information.

 

Windows 8 has a Driver Signature Enforcement (DSE) feature. 
This feature allows the PC administrator, or the user who is 
installing the Windows-based software, to know whether a 
legitimate publisher has provided the software package. 
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This feature can be a problem for programs, like ERTune™, 
which are designed to be compatible with previous versions 
of Windows. If you get the Error Screen, you will need to 
temporarily disable the DSE. To accomplish this, do the 
following:

1. Open the Charms Bar and select Settings.

 

2. Select Change PC settings.

 

3. Select General, scroll down to Advanced startup and click 
Restart now.
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4. After Windows has restarted, the Choose an option window 
appears. Select Troubleshoot.

 

5. Select Advanced options.

 

6. Select Windows Startup Settings.

 

7. Click Restart.
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8. After the operating system has rebooted, the Startup Settings 
window appears. Press the F7 key to disable the Driver 
Signature Enforcement feature.

 

9. Windows 8 will restart. The Driver Signature Enforcement 
will be disabled until the next reboot. 
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